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Before the system can generate data it must know about the current orders on hand. Using the order 
entry option allows the user to manually enter multiple parts against a single purchase order. This 
function serves as a front-end mechanism for entering multiple parts quickly. Use this module on a daily 
basis to add, edit, and inquire about the status of open orders. 
 

Sales Order Basics 

In the most basic terms, the difference between what is on order (demand) and what is currently in 
inventory (supply) is by definition what a company must produce to meet it’s requirements. Sales orders, 
then, drive the creation of work orders needing to be filled. This comprehensive Order Entry module 
provides easy and fast access to order information. 

Requirements for Entering Orders 

Before orders can successfully be entered configurations must already exist in the system. By creating 
the configurations the items will then exist in inventory and can then be added to a sales order. It is 
important to select the correct item which may include any revision numbers your customer may have 
added to his part number. Bear in mind that any change to a customer part number must be reflected in 
the manufacturing standard, since the order will generate data for production related specifically to the 
part number. Selecting the wrong part number will cause incorrect information to be generated at the 
point of scheduling, production, reporting, and shipping. 

Note: The topic of how item numbers are maintained throughout the system is discussed in the 
Manufacturing Configurations and Inventory Management sections within the EnterpriseIQ 
Manufacturing manual. We recommend studying this critical topic for a more complete understanding of 
how EnterpriseIQ handles item numbers. 

Each order consists of header information, order detail (line items) and unlimited Order Releases per line 
item. Unlike other systems, the user does not need to create multiple line items to accommodate 
multiple delivery dates. A single order can contain one or more items, each item may contain one or 
more delivery dates. 

The user can create an order for virtually any kind of inventory item, including miscellaneous items that 
are not found in inventory. The order entry module also supports ordering by the Also Known As (AKA) 
method. 
 

Sales Orders 
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The Sales Order Screen - Overview 

The Sales Order screen is broken down into three sections; Header information, Line Item Details, and 
Total Releases/Delivery Dates. The information in these sections is discussed briefly below. For a full 
description of each field reference the topics below associated to each section. 

Header Information 

The basic order starts with an order number and date (automatically assigned by the system), who took 
the order, a customer, a bill-to designation, a ship-to designation, and contact. The customer, bill-to and 
ship-to fields can be edited by selecting the edit button next to each field. With this combination you can 
create orders for any customer, have the bill sent to a different organization, and have the products 
shipped to yet another. 
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Other header information consists of the PO #, terms, ship via designation, FOB point of origin, parts 
discount%, and currency (if enabled). If Free Form (misc items) is to be generated, click on the box 
before entering the line items. The line item details section will change to support this function and allow 
you to enter an item that is not inventory-based. The fields in this section can be sized to display all of 
the text. To change the size of a field mouse over it until the vertical cursor is displayed then drag it to 
the desired size. 

Field Color Codes - Highlighting of fields may occur to flag the user of certain conditions:  

▪ If the customer is on credit hold the Customer # field will be red. 

▪ If the Ship To is a VMI it will be yellow. 

▪ If the Division/Warehouse on the sales order does not match the one associated to the Ship To it will 
be light blue. 

▪ If the terms have the Cash in Advance option checked the customer # field will be pink. 

Note: If the sales order you are viewing was received from Marketplace, the sales order screen will 
display a blue banner at the top of the header section: "This order was received from the Dassault 
Systemes Marketplace. 

Line Item Detail 

Each order may contain an unlimited number of line items. All columns within the grid can be moved 
and/or resized to fit your needs. EnterpriseIQ remembers how the screen was resized each time the 
module is used. 
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Each line item includes a blanket quantity, notes, unit price, the quantity shipped, a tax code (if 
applicable), commission %, a salesperson designation, and more. In addition to this information, 
fundamental shipping information is included so you know how many have been shipped to date, 
invoiced, and the backlog amount. Line items may be color coded as follows: Red is On Hold, Yellow is on 
Ship Hold, Lavender is a MTO item,  the Item # field for miscellaneous items  will be aqua, and light green 
is drop ship. 

Note: If you are viewing a Marketplace sales order for which you have not yet received payment, the 
sales order screen will display a red banner at the top of the line item detail section: "Payment has not 
been received. Items on this order have been automatically placed on hold." Any user can remove the 
banner - however, only users with the appropriate security permissions are able to remove the 'on hold' 
status from these items. 

Total Releases - Delivery Dates 

The bottom portion of the Sales Order Entry screen is used for entering the total number of releases for 
each line item. 
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Each line item within the order may have an unlimited number of release dates. The delivery dates drive 
the requirements generated by the system. The more accurate and complete, the better the system can 
assist you in terms of ordering raw materials, scheduling production, and planning for shipping. 

EnterpriseIQ supports the concept of the requested date (what the customer is asking for) and a promise 
date (what you told the customer you can do in terms of delivery). There is no requirement to match the 
blanket quantity with release quantities - you can add the releases as they become known or set each 
release as forecasted. 

PLEASE NOTE: EnterpriseIQ bases material and scheduling planning on actual promise dates, not on the 
Blanket Quantity field. Therefore, enter as many known dates as possible. The user may enter dates and 
quantities BEYOND the original order. EnterpriseIQ keeps track of the original order amount and the 
releases and alerts the user if more than the quantity ordered has been released. 

Release Color Codes: 

▪ Green - Fully Shipped 

▪ Yellow - Partially shipped 

▪ Magenta - Not Shipped 

▪ Orange - Pending Inventory Verification. When a Packing Slip is posted if the 'Inventory Verification' is 
on the system will mark all releases that are covered by this shipment as Pending Verification. 

▪ Red - If the Expedite check box is checked the release color code will change to red if the release is 
not shipped in full. (Note: The Expedite box cannot be checked if the release is shipped in full). This 
information is used in Wave Management Sales Order Picking module as a filter. From the 'Expedited 
SO' field users can select from the drop down list to: 'Include Expedited Orders' (this is the default), 
'Exclude Expedited Orders', or 'Expedited Orders Only'. 

▪ Aqua - When a release is on a pick ticket the 'Requested' and 'Promised' columns will be colored 
aqua. 

Additional fields shown in this section include the details of the quantities shipped to date. Right click to 
view Work Order information, Trace, and/or the Gantt Chart. The columns in this grid may also be 
resized or relocated. 

Sales Order Total Section 

▪ Total - This is the Total value of the sales order before tax and freight. 

▪ Threshold Discount - The total discount value is based on the sum of the Discount Amounts from the 
line items on the sales order. This amount is prior to taxes and freight. 

▪ Tax - This is the total tax for the sales order. Select the Tax Breakdown button to view the totals for 
the individual tax elements. 
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▪ Freight - This is the estimated freight for the entire sales order. If a value is entered in the 'Total 
Charge' field in the Estimate BOL form it populates this field. The 'Total Charge' value can be 
manually entered with the total charge for freight for all items on the sales order, or it will be 
populated from the service selected in the Shop Rates screen, or from the information obtained from 
the web service associated to the ship via. This information will also carry over to the packing slip and 
credit card charge if applicable. (See Estimate BOL for details). Note: When the freight charge is 
carried over to the packing slip, the total charge in Estimate BOL will be reset to zero. This is reset in 
case there are multiple packing slips created. The user can fill in the total charge again and that 
amount will carry over to the next packing slip. This will happen with multiple releases being shipped 
at different times. Note: If multiple line items exist on the Sales Order, and freight is added via the 
Estimate BOL screen, the system will calculate Freight Tax by utilizing the Tax Code from the first line 
item * Freight. When the sales order is shipped and invoiced, the Tax and Total values may be 
different, as users are able to add and modify Freight on each invoice line item. 

▪ Grand Total - This is the Total - Discount + Tax + Freight 

Foreign Currency Rates 

Select the Foreign Currency Rates button in the Total Section to view the current currency and the 
corresponding total information (Total, Tax, Freight, and Grand Total) To view the total information in 
another currency, select the currency from the drop down list 
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Sales Order Header Section 
To ENTER a Sales Order, complete the following steps: 

➢ From the EIQ Launcher Bar, select the tab entitled 'Sales/Distribution'. 

➢ Click on the Orders button. The first screen to appear is the Orders pick list. 

➢ Click on the NEW button. 

➢ Select a Customer from the customer pick list. To quickly locate a customer, right click within 

the pick list and use the different sorting options available or click on the column heading 
you want the list sorted by. If the customer is not in the pick list select the New button and 

enter the information in the Customer Maintenance form. 

➢ Select a Customer and press [Select]. The Sales Order entry screen will appear. 
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The information that appears at the top of this screen is attached to the customer you selected. If some 
of the fields are blank (i.e. Contact, FOB, Terms, Ship Via, or Disc %), this information was not filled in for 
that customer in Customer Maintenance. 

Note: If the sales order you are viewing was received from Marketplace, the sales order screen will 
display a blue banner at the top of the header section: "This order was received from the Dassault 
Systemes Marketplace. 

Use the field listing below to familiarize yourself with each of the fields shown at the top portion of this 
screen. 

Header Field Listing (Alphabetical) 

Approved 

Required 

If the System Parameters ->Purchase Order and Sales Order Setup tab -> check box 'Sales Order 
Workflow is Mandatory' is checked the 'Required' checkbox on new sales orders will be 
automatically checked. This will require the sales order to go through the workflow approval 
process. 

Once the sales order is approved, the 'Approved' checkbox will be checked. 

Bill To The bill to information. This will populate with the Bill To address that is associated to the Ship 
To address in Customer Maintenance (Ship To tab), or if none it will use the default Bill To 
address. Users can search for a different address by clicking on the drop down arrow for a list 
or the Search button to bring up the pick list. You can add a new bill to address or edit the 
information by right clicking on the field and select Edit. 

When mousing over this field the full address and phone number will display until the user 
moves the mouse off the field. 

Campaign Code A Campaign can be assigned to the sales order. Select the search button to access the pick list 
of campaigns. If the Sales Order is assigned a Campaign # the system will not allow Campaigns 
to be assigned on the Line Item level as all line items will belong to that campaign. This field will 
be populated automatically when a sales order is created from Campaign Management in CRM. 

If a Campaign Code is added to the Sales Order header after line items are entered the system 
will link the line items to the selected campaign. If line items are already assigned to a 
Campaign Code a confirm message will appear with Yes and No buttons, "Detail items on this 
Sales Order will also be assigned the selected campaign code.  Do you wish to continue?". 

To clear the associated campaign, right click in the top section and select Clear Campaign #. 

Carrier Acct # This will populate with the Carrier Account number based on the following hierarchy: 

1 Customer Ship To->Carrier tab 

2 Customer Ship To->Detail tab 

3 Customer Miscellaneous tab  



Sales Orders Page 11 of 150 

 

Contact 

 

You can optionally assign customer contacts for this order in the Contact field. This list is based 
on the contacts associated to the customer on the Contacts tab, the Ship To and Bill To Contact 
lists in Customer Maintenance. The picklist will display a field for contact type.  If there is only 
one contact in Customer Maintenance the system will populate the Contact field with that 
contact, regardless of whether it's marked Default or not. If there is more than one contact and 
one is marked default the system will populate the contact field with that contact. If there is 
more than one contact and none are marked default, then no contact will populate in this field. 
This list is soft filtered for EPlant (displays contacts associated to the logged in EPlant or those 
with no EPlant assigned). 

You can add or change contact information by right clicking and selecting Edit or search for a 
different contact by clicking on the drop down arrow or on the Search button to bring up the 
pick list. 

When mousing over this field the contacts phone number will display until the user moves the 
mouse off the field. 

CRM RFQ# This will display the CRM RFQ number if the sales order was created by converting a CRM quote 
to a sales order. A right click 'Jump to CRM Quotation' is available. 

Currency If you are using Multi-Currency, this field shows the currency associated to the customer (i.e. 
USD). 

Customer # This field will display the customer number. You can change the customer by clicking on the 
eyeglass icon to bring up the customer pick list. 

If the customer has been put on credit hold this field will be highlighted red to flag the user of 
this status. 

If the selected Terms on the sales order is marked as a Cash in Advance type term the customer 
# will display in pink and the line items will be marked On Ship Hold until payment is received. 
See the Cash in Advance Invoicing section for more information. 

When mousing over this field the full address (including Address 2 and 3 fields), phone number 
from the customer/credit data tab, and Tier Type if applicable will display until the user moves 
the mouse off the field. 

When the Customer is changed on a sales order after Line Item details have been entered, and 
the customer is assigned a different tax code or salesperson(s), a message  will pop up, 
indicating that the 'Ship to Address has changed to a different tax code or salesperson. Update 
order details to new tax code or sales person?'. Select Yes to update the order details with the 
new tax code or No to not make the changes to the line items. Security can be placed on this 
warning, and it also has the 'Do not show next time' feature. Note: If the Ship To Sales Person is 
null and/or Tax is null, but not at the Customer level, the information pulls from the Customer.   

If the Customer is associated to a Price Book the 'book' button next to the field will not be 
grayed out and when moused over will indicate which Customer Price Book the customer is 
associated to. Click the button to open the Price Book. The button will be grayed out if a price 
book is not attached.   

Customer Note The note from Customer Maintenance->Miscellaneous tab will surface here. This note also 
displays as a pop up when a new sales order is created or cloned for the customer. 

Date Shows the date the order was entered into the system. This date is initially set to the current 
(system) date but can be changed to any date. 
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Discount % This field will populate with the discount information in the Customer Maintenance form. If 
blank or to change the discount, enter an amount in this field. The discount entered on the 
Sales Order will only apply to that order. 

Note:  If ‘AKA Pricing Override Tier Discount Pricing’ is checked, and an AKA Price 
exists,  the system will use that AKA price only with no further discounting applied. 

Note: If the customer has the 'Use Discount Parameters' option checked this field will 
be called 'Discount'. Refer to the SAC Discounts section for details. 

Drop Ship PO# If the customer has the 'Drop Ship Vendor' field populated (Customer Maintenance-
>Miscellaneous tab), by default all items on sales orders for that customer will be marked as 
Drop Ship items. When the sales order is created the user will be asked to select or create a 
Drop Ship PO. This field will populate with the new or selected PO. Users can right click and 
jump to the drop ship PO. 

EPlant The Enterprise Plant assigned to the sales order. 

FOB Select who will be taking care of the freight— for example, Origin, Destination, 3rd party, 
prepaid or collect. This will populate with the FOB associated to the Ship To address if 
populated, or an FOB can be selected from the drop down list. The items shown in the pick list 
come from the FOB list set up by the user. If the user selects a FOB that has the Third Party 
Billing option checked, a pick list of Third Party Billing addresses will appear to choose from. 
This information will carry over to the shipment and the BOL.  

To add additional FOB choices go to Options/FOB on the Sales Order menu and click on the Add 
(+) button. 
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Free Form If this box checked, the Line Item Details section changes to allow the user to enter items that 
are not inventory based only. To enter the item type in the description, quantity, price, and tax 
code information if it applies. The user can double click on the Description field to access a 
form to type a longer description. 

 
Prior to entering the miscellaneous item, EnterpriseIQ can issue a prompt for a request date for 
a line item. The request date box in the middle section of the form (if checked) is then assigned 
to the release record. If the wrong request date was entered, the date can be edited in the Free 
Form order detail section by right clicking on the item. 

Note: By checking Free Form in the header section the entire sales order becomes free form. As 
an alternative, the user can add miscellaneous items to a non free form sales order by clicking 
on the Miscellaneous button in the middle section. (Please see below for more details). 

Opportunity # This will display the Opportunity Central number associated to the sales order if applicable.  

If a CRM Sales Quote has an Opportunity # associated to it, when the quote is converted to a 
sales order, the system will bring over the Opportunity # to the sales order. 

An Opportunity Central record can be manually associated to the sales order from the pick list 
accessed by selecting the button next to this field. The pick list displays Opportunities 
associated to the customer (Customer Central->Opportunities tab). A new Opportunity record 
can be created by selecting the New button on the pick list. 

Order # The number that appears in this field is internally generated by the program. The user can reset 
the numbering sequence by going to System Parameters|Sequential Numbering. 

Payment type This field is only visible from the table view. This is the payment type the customer selected 
from the Shopping Cart screen in WebDirect. If the method of payment was Credit Card, the 
last four digits of the credit card will be displayed. This information can be used to determine 
the correct terms for the sales order.  
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Pallet Charge Use the 'Use Pallet Charge' checkbox to enable this setting. With the setting enabled, the 
system will apply a charge to each pallet used in the customer's shipment. The pallet charge is 
the price per pallet specified in the customer's Distribution Routing Rules within Customer 
Maintenance. 

When you hover over this field, the system displays a message indicating whether the price per 
pallet is coming from either the ship to level or the customer level. 

Note: The total pallet charge rounds up the number of pallets used to the higher whole 
number. This means that if 3.25 pallets are used for a shipment, the customer will be 
charged for 4 pallets. 

Note: Negative pallet charges are acceptable. 

Note: The 'Pallet Charge' field is currently only informational. 

PO # Purchase order number. You are allowed only one purchase order per sales order. Any items 
that use the same P.O. may be entered under the same sales order. 

If the same PO number is already associated to a sales order for the same customer, the user 
will receive a warning stating, "PO # xxx is already assigned to the selected customer. 
Proceed?" Select Yes to continue, or No to return to the sales order to enter a different PO #. A 
'Do not show next time' check box can be checked to not display the warning. Security can be 
placed on this warning. 

If the PO # is changed, a pop up message will appear asking the user, 'Sales Order PO number 
has changed. Update Order Detail PO Info?'. If Yes is selected, the system will update only 
order detail records where the backlog quantity is greater than 0. If the user answers No or X’s 
out, the PO # in the header will be changed, but the PO on the line items will not. This message 
has a 'Do not show again check box' which can be selected so the message will not display 
when the PO # is changed. 

Revision This is the revision number of the sales order. If a user answers yes to 'Is this a sales order 
revision?' the increased Revision displays the next time the sales order is opened. For more 
information please see Editing a Sales Order. 

Ship Complete This works in conjunction with Inventory Availability Mode (not Sales Order based mode) and 
Must Ship Dates when adding items to Pick Tickets. When this option is checked users will only 
be able to create a pick ticket if all items on the sales order with the same Must Ship Date are 
available. If they are not all available then items will not display on the Ready for Shipping or 
Possibly Available tabs.   

This can be enabled on a per Sales Order basis or for a customer by checking this option on the 
Miscellaneous tab in Customer Maintenance. If 'Ship Complete' is checked in customer 
maintenance the 'Ship Complete' check box will automatically be checked on new sales orders. 
Users have the ability to toggle the Ship Complete option on a Sales Order. 

Notes: 

▪ On hand is still soft allocated to the items that were available so that other orders do not show 
up to be shipped. 

▪ When deleting an item that was set to ship complete from pick ticket a warning will surface, 
'This item is part of a Ship Complete order. Are you sure you want to continue?'. Users will 
have the option to select Yes, No, or Cancel (or exit). Security can be placed on this warning. 

▪ Users will be allowed to create a packing slip directly without regard to 'Ship Complete'. This is 
because the Ship Complete feature relies on matching Must Ship Dates, and in Packing Slips a 
release or ship date is not specified, so the system has nothing to match to or determine 
'complete' from. 
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Ship To The Ship to information. The default information will appear automatically. If no active records 
exist for the EPlant the user is logged into then ship to will populate null.  

Users can search for a different address by clicking on the drop down arrow for a list or the 
Search button to bring up the pick list of ship to addresses which also includes the ship via. You 
can add a new ship to address or edit the information by right clicking on the field and select 
Edit. The edit form includes all address fields including state and country, warehouse/division, 
tax code, EPlant, and freight. If a new ship to is entered it will be automatically associated to 
the sales order. 

When the Ship To address is changed on a sales order after Line Item details have been 
entered, and that Ship To is assigned a different tax code or salesperson(s), a message will pop 
up, indicating that the 'Ship to Address has changed to a different tax code or salesperson. 
Update order details to new tax code or sales person?'. Select Yes to update the order details 
with the new tax code or No to not make the changes to the line items. Security can be placed 
on this warning, and it also has the 'Do not show next time' feature. Note: If the Ship To Sales 
Person is null and/or Tax is null, but not at the Customer level, the information pulls from the 
Customer.   

If a user attempts to change the Ship To when the quantity shipped against the sales order is 
greater than zero a status exception message will appear. Only users with security rights will be 
able to continue by selecting OK. 

 
If a pick ticket has been created for the sales order, if the user attempts to changed the Ship To, 
a warning similar to the one above will display stating, 'Pick ticket exists for this sales order'. 
Select OK to continue with the change or Cancel to return to the sales order without making 
the change. Only users with security rights will be able to select OK. 

If the Ship To is for a VMI location it will be highlighted in yellow. 

When mousing over this field the full address, phone # and Ship To ID will display until the user 
moves the mouse off the field. 

If the Customer's Ship To address is associated to a Price Book the 'book' button next to the 
field will not be grayed out and when moused over will indicate which Customer Price Book the 
Ship To address is associated to. Click the button to open the Price Book. The button will be 
grayed out if a price book is not attached.   

Ship To Note The Sales Order Note from the Customer Maintenance->Ship To tab for the selected Ship To 
address will surface here. This note will also display from the Add To Ticket list when adding 
items to a pick ticket. 
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Ship Via This is the preferred method of shipment (i.e. Federal Express, UPS, Roadway, etc.). This 
information is attached to the customer and resides in Customer Maintenance. If the field is 
blank or to change the Ship Via, click on the arrow down key within this field or select the pick 
list button. 

Note: If the Ship Via contains a Local Pickup Address, this address will be used by 
Avalara Tax Web Service to calculate sales tax.  (See the Avalara Tax Web Service 
TechNote https://my.iqms.com/cfs-file.ashx/__key/Technote/Avalara-Tax-Web-
Service.pdf for details). 

SO Contact You can manually assign customer contacts using the drop down or picklist in the SO Contact 
field on the Sales Order. This list is based on the contacts associated to the customer on the 
Contacts Tab, the Ship To and Bill To Contact lists in Customer Maintenance. The drop down 
and picklist will display a field for contact source type.   

You can add or change contact information by right clicking and selecting Edit or search for a 
different contact by clicking on the drop down arrow or on the Search button to bring up the 
pick list. 

When mousing over this field the contacts phone number will display until the user moves the 
mouse off the field. 

Note: Order Acknowledgment Auto-EForms are sent to the person in the 'Contact' 
field on the sales order, not the 'SO Contact' field. 

SO Note A note field associated to the entire sales order. This note will display in the Open Orders grid 
of an un-posted packing slip to provide notes to shipping personnel at the time a packing slip is 
created. It can also be used for reporting purposes, the field is Orders.Comment1. This note will 
also display from the Add To Ticket list when adding items to a pick ticket. 

Status This is the status of the sales order. When a Sales Order is initially created, it auto populates 
with a status of ‘New.’ After the sales order is created, users with appropriate security, can 
manually change the Status by selecting one from the hard-coded drop down list: New, 
Unconfirmed, Confirmed, Acknowledged. This field is available in the sales order pick list so 
users may search orders by Status. 

This field is used in IQAlert for the 'Order Acknowledgement' action. When this Action is run, 
the system will look for sales orders where the Status is set to ‘Confirmed’. If sales order(s) are 
found with the Status of ‘Confirmed’, and the customer has Auto-EForm for Order 
Acknowledgment set up, an Order Acknowledgement Auto EForm record is created for all 
applicable sales orders. The system will also update the Status of the sales order(s) from 
‘Confirmed’ to ‘Acknowledged'. If the Alert has the ‘Mark Release ‘Acknowledged' when 
Printed’ check box checked, the system will update applicable sales order releases to 
Acknowledged. 

Note: When a new release is added to sales order, the system will evaluate the Status field and 
if it is set to anything other than ‘New,’ when releases are added the Status will change to 
‘Unconfirmed’. 

Taken By This field shows the login name of the person entering or cloning the order. This field is 
available in the pick list. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Avalara-Tax-Web-Service.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Avalara-Tax-Web-Service.pdf
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Terms The system will populate this field with the terms associated to the Bill To address, if null then 
it will use the default terms setup for the customer in Customer Maintenance on the Credit 
Status tab. The Terms on the Sales Order will update if the Bill To changes in response to the 
Ship To changing. 

To manually change the Terms, click on the arrow down key within this field. To add additional 
Terms go to Options/Terms on the Sales Order menu and click on the Add (+) button. 

If the selected Term is marked as a Cash in Advance type term the customer # will display in 
pink and the line items will be marked On Ship Hold until payment is received. See the Cash in 
Advance Invoicing section for more information. 

Threshold Disc % The discount % will be based on the total amount associated to the sales order (prior to taxes 
and freight) for the appropriate discount % based on the Threshold Discount tiers that have 
been setup.  

Threshold Type This field will populate based on the ‘Threshold Type’ associated to the customer record 
(Customer Maintenance->Customer / Credit Data tab) if one exists. 

Warehouse/ Division For Warehouse/Division users only. This information will fill in automatically based on the 
customer ship to information but it can be edited by selecting from the drop down list. If the 
Division/Warehouse does not match the one associated to the Ship To address it will be 
highlighted in aqua as a flag to the user. 

Note: If the warehouse/division is changed on the sales order then that warehouse/division will 
populate on the pick ticket.  

Note: This does not apply to ICT Ship Orders as the Division on the Ship Order header will never 
match the Ship To Division on a Ship Order. 
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Note: Not all fields are available in both views.  

The following fields are not displayed when in the table view: 

▪ Contact 

▪ SO Contact 

▪ Division 

▪ Drop Ship PO# 

▪ Free Form 

▪ Ship Complete 

▪ FOB 

▪ Terms 

▪ Ship Via 

▪ CRM RFQ# 

▪ Revision 

▪ Opportunity # 

▪ Campaign Code 

▪ EPlant 

▪ Discount % 

▪ Threshold Type 

▪ Threshold Disc% 

▪ Status 

▪ Carrier Account # 

▪ Approval Required 

▪ Approval Approved 

▪ SO Note 

▪ Customer Note 

▪ Ship To Note 

The Following fields are only visible in the table view, and are not displayed in the form view: 

▪ Company 

▪ Payment Type 

▪ Web Ref# 

➢ Prior to adding line items to the order, verify all of the fields are correct in the Header 
section. 

➢ Click on the Post/Edit function key (check mark) located on the Navigator bar to save all 

entries prior to entering the line items. 

 
 



Sales Orders Page 19 of 150 

 

Sales Order Line Item Details 
Selecting the Item and Entering the Details 

The next step is to begin adding the line items to the sales order. Begin entering the items using the 
steps below. 

Click on one of the speed buttons within the line items section, to find and select the line item. The 
system will remember the 'Add or Edit from Inventory', 'Add miscellaneous item', and 'Add or Edit from 
AKA Items' in the registry so when the user returns to a sales order the option that was last selected is 
remembered.  

Below is a list of the functions that are available when adding items to the sales order: 

Filter Customer’s Items - Only lists items where the customer in the header section is the default 
customer for the item (Inventory->Additional tab).  

 Add/Edit from Inventory - When selected, a pick list appears that allows you to select any item found 
in the master inventory. The pick list can be sorted based on the available columns which include the 
item information, default customer, user fields 1 and 2, and on hand and non committed quantities.   
 
Once the item is selected, you can change the item number selected by clicking on the browser button 
within the item # field to select a different item from the Inventory pick list. Click on the arrow down 
button, or type in the first few digits of the item number to hyperbrowse to it. 

If a user attempts to add an item that has multiple AKA Selling records with different AKA Kinds, a second 
pick list will surface in order to pick the correct corresponding AKA Selling inventory item for that 
customer. 

If a user attempts to add an inactive item a Status Exception pop up will appear stating the status of the 
item is inactive. Only users with security for the OK button will be able to proceed in adding the inactive 
item to the line item details of the sales order. 

If the blanket quantity entered is less then the minimum quantity price break a confirm message will 
appear stating, 'Item # xxx: The selected quantity (x EACH) is less than the minimum quantity (y EACH) in 
the Quantity/Price breaks table (ARINVT_BREAKS).  Do you want to continue?' Select Yes to continue 
adding the item for the entered quantity, or No to return to the sales order to make changes. Security 
can be placed on the Yes button. 

If the tool associated to the item's default BOM is currently out of service, a pop up message will display 
stating, "The tool is currently out of service.  Continue? Reason: xxxx". Users can select Yes to continue 
adding the item to the sales order, or No to not add the item. There is also a 'Do not show next time' 
check box which can be checked so that this message will not appear. Security can be placed on this 
form.  

If the item has a Proprietary customer set and if 'today' is in the Effective Date range, when a user 
attempts to add the item to a sales order for a non default customer an error will appear stating, 
'Inventory item # xxx is proprietary to customer xxx - operation aborted.' If the effective and inactive 
dates are not populated, or are in the past or the future, the field will not be green and the item can be 
sold to any customer. Note this check is only on adding the item to the order.  If the customer is then 
changed it will not be enforced.  
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 Add/Edit Miscellaneous Items - This options allows the user to enter miscellaneous items (items that 
are not maintained in master inventory) to the order. A pick list of Miscellaneous Items will appear for 
the user to choose from. The list is soft filtered for EPlant so users will see items associated to the EPlant 
logged into as well as items without an EPlant designation. Select the New button on the list to create a 
new miscellaneous item. Enter the item #, description of the item, a quantity, unit price, unit of measure, 
and optionally a miscellaneous GL account number. If a GL account number is assigned it will follow the 
item through the packing slip/pick ticket modules and show up on the A/R invoice. The Sales Order 
Miscellaneous Items List can be accessed from the Options menu in Sales Orders or from System 
Parameters->Lists menu. See the Sales Order Miscellaneous Items List section for details.  To edit a 
miscellaneous item, right click and select 'Edit Miscellaneous Item'. The Miscellaneous Item Entry form 
will appear for the user to edit the fields (i.e. item # and description). When the 'Include edit on 
Miscellaneous Item record' option is checked, both the line item and the Miscellaneous Item record will 
be updated.  When this is not selected, only the line item on the sales order will be updated. 

 Add/Edit from AKA - The AKA method of order entry provides a cross reference of customer item 
numbers to internal item numbers. When this option is selected the pick list will be comprised of only 
items associated to the sales order customer on an items AKA Selling tab in Inventory. This pick list also 
includes the On Hand quantity for a quick reference of the item's possible availability. 

Note: Ordering an item number in this manner will create an work order based on the internal item 
number, not the customer’s item number. However, EnterpriseIQ references the AKA item number on 
the packing slip and invoice. 

➢ Next, click on the [+] function key within the line item section. 

➢ If Add/Edit from Inventory or Add/Edit from AKA is selected, a pick list will appear. Locate the 

item within pick list and click on [Select]. You will be returned to the main entry screen. All 

information about the item (i.e. item #, description, pricing, AKA Kind, etc.) will transfer with 
the item into the Items Detail grid. 

➢ If Add/Edit Misc. Item was selected, enter the item information when prompted. If a 

description is not entered a warning will appear and the user must enter a description to 
save the record. 

➢ Alternately users can select the 'Multiselect Inventory Items to Add' button  to add multiple 

items at one time. A multiselect pick list will display based on the selection (AKA or 
Inventory). If the Miscellaneous button is select users will receive a message stating, 
'Multiselect is unavailable for miscellaneous items.  Please use the "insert" button'. From the 

multiselect pick list use the toggle buttons or the Shift/Ctrl keyboard buttons to select 
multiple items. Once the items are selected, click the OK button to add them to the sales 
order. Note: Both active and inactive items are included in the multiselect lists. If an inactive 

item is selected a Status Exception warning will appear stating the status of the item is 
inactive. The warning includes OK and Cancel buttons. Security can be placed on the OK 
button to prevent users from adding inactive items to a sales order. The multiselect pick list 
includes an Inactive column. 

➢ Enter a Blanket Quantity amount. This amount is the total amount the customer wishes to 

order. 
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➢ If the item has the 'Use Lot Charge' option checked, the price break field will be zero. When a 

lot charge item is added to a sales order the system will pop up a field to allow the user to 
edit or enter the lot charge.  Once the lot charge is entered, a separate line will be created 

automatically for a miscellaneous item, with an item description of Lot Charge, a blanket 
quantity of 1, and the lot charge populated in the price field. 

➢ For items that do not have the 'Use Lot Charge' option checked, the price that automatically 

is associated to an item on a sales order is based on a hierarchy system (see the flowchart 
below).  

➢ If the customer has a discount percent and the option in System Parameters on the 
Purchase Order and Sales Order Setup tab ‘Customer discount % comparison’ is checked, the 

system will compare the selling price on the Buy/Sell pricing tab in inventory for the quantity 
on the order to the Standard Item Price multiplied by the customer discount %, and will use 

the lowest price. If an AKA price is populated the system will use that price. If the customer 
does not have a discount % the system will use the standard pricing hierarchy. 

Pricing Flowchart 

The flowchart below shows this hierarchy when no discounting methods (such as Tiers, Volume, and 
Waterfall), and no Price Books are being utilized. If Tier, Volume, or other discounting is being used 
please reference the information in the Discount Pricing topic and it's sub topics in the Inventory section. 

If Price Books are being used reference the flowchart in the Price Book Maintenance section. 
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If the blanket quantity entered is less than the minimum price break a warning will appear stating this. 
Select OK to continue. The system price can be overridden by the user. Keep in mind that the price 
shown is the price that will later be invoiced and will appear on this order only. The price may be set to 
zero to accommodate NO CHARGE orders. 

The system will also evaluate the Effective and Inactive dates associated to AKA pricing records. If the 
AKA pricing Effective date is in the future it will use the Buy/Sell Pricing, if not available, it will use Std 
Price. If the AKA pricing Inactive date occurs in the past, the system will use the Buy/Sell Pricing, if that is 
also inactive a pop up warning will appear stating, 'Sales order pricing has expired. Inventory Default 
Standard Item Price will be used instead. Continue?' If Yes is selected it will use Standard Item Price. If No 
is selected the price will be zero. This pop up includes a 'Do not show next time' check box. Security can 
be placed on the Yes button and the check box. 

Note: If the selling pricing in inventory is not set for the currency associated with the customer, the unit 
price on the sales order will default to zero. 

Note: If an AKA Selling Item’s Price is set to $0.00 and effective, the system will use the zero price (it will 
not move to the Standard Item Price in the hierarchy). 

Note: If an order detail item has a unit of measure (UOM) that is not the default from inventory, the 
system will convert it to the default (native) UOM before looking to Selling, AKA, or Tier tables for 
pricing. 

Over Credit Limit 

If the Auto-calculate during Order entry option is checked in Customer Status->Check Credit Limit and 
the order quantity will put the customer over credit limit a warning will appear with three choices. 
Security is available on all three buttons. When calculating the credit limit during sales order entry, the 
credit limit calculation is looking at the order detail row to determine how much is left to ship times the 
unit cost, then it includes how much is outstanding already and how much is in un-posted AR invoices.  
Note: It does not look only at sales order releases out X number of days as it does when calculating from 
AR customer status. If the customer's credit limit is null this warning will not appear. 

 



Sales Orders Page 24 of 150 

 

▪ Credit hold/Continue -This selection changes the customer status to 'Cr Hold' in customer 
maintenance and allows the user to complete the sales order entry. 

▪ Continue -This selection does not change the customer’s status but does continue with the sales 
order. 

▪ Cancel- This selection cancels the sales order entry process 

Quality Module Status Exception 

For users with the Quality module the system will check to see if the item added to the sales order is 
associated with a CAR/CAPA, ECO, Deviation, PPAP/Product PQ, or MRB. If it is, a Status Exception form 
stating "Open Quality Modules Found" will appear listing the number of relevant records. The user can 
select the ‘View Details’ button to display a form with the specific records and Jump to capability. 
Depending on the users security they may or may not be able to add the item to a new sales order. This 
status box also includes a 'Do not show next time' check box that when checked, the status exception 
will not pop up. Security can be placed on this check box. 

 

➢ Address the other fields on the line item as required. (Editable fields are white, fields that 
are gray cannot be changed).  

Below are all of the field descriptions for the line item details: 

AKA 
Description 

AKA Ext 
Description 

The AKA description and AKA extended description if applicable. 

AKA Item # The AKA item number if applicable. 

AKA Kind The AKA Kind associated to the item if applicable.  

This field can be populated on the AKA Selling tab in Inventory to describe the specific AKA Kind 
related to the AKA item. This field enables users to create multiple AKA records for the same 
customer, item number, and ship to address. The records are unique based on the combination 
of Customer+Item#+Ship To Address+AKA Kind.  

The 'AKA Kind' column is visible in the Sales Order AKA pick list so users will be able to pick the 
correct AKA item #. 
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Auto Invoice This box can be checked on a miscellaneous item in order for an AR invoice to automatically be 
created during Auto Invoicing (for customers with an Auto Invoicing technique setup). This 
enables an AR invoice to be created for a miscellaneous item without having to create a 
packing slip. (This box cannot be checked for inventory items). 

Backlog The quantity left to ship. This field is populated by the system. 

Blanket Qty Enter in the total amount the customer wants to order. 

BOGO 
Exception 

This is relevant to the BOGO Discount Tier type (see BOGO Discounts for more information). 
This field will display any validation errors that may occur when a parent item is updated to a 
state where the child item no longer qualifies for the BOGO discount in its current state.  At 
that time the child item will display one of the following BOGO Exceptions: 

▪ Max Qty Exceeded 

▪ BOGO Disqualified 

▪ BOGO Expired 

Campaign Code A CRM Campaign Management record can be associated to a line item on a sales order. Select 
the Campaign to link to the item from the drop down list in this field. If a Campaign has been 
associated to the line item, the user can jump to the Campaign from the right click option 
‘Jump to Campaign’. The sales order will be listed on the Sales Orders tab in Campaign 
Management. 

Note: If the sales order is assigned to a campaign in the header section this field will 
not be visible. The rule is that if a Sales Order is assigned a Campaign # on the header, 
all line items belong to that campaign. 

If a Campaign Code is added to the Sales Order header after line items are entered the system 
will link the line items to the selected campaign. If line items are already assigned to a 
Campaign Code a confirm message will appear with Yes and No buttons, "Detail items on this 
Sales Order will also be assigned the selected campaign code.  Do you wish to continue?". 

Campaigns can be removed by selecting the 'Clear Campaign #' right click option. 

Class The item's inventory class. 

Commission % The commission % based on the commission hierarchy. (Security can be placed on this field). 

Config Code This will populate with the Config Code from the Sales Quotation if the item came from a sales 
configuration template. The Config Code will consist of the Sales Configuration Item description 
+ all non-default choice codes + attribute values. (This field is included in the Sales Order pick 
list). 

Containers Users can enter sales order quantities based on number of containers ordered or number of 
items (Blanket Qty). If the user enters the blanket quantity the system will calculate the 
number of containers automatically. The system will take the Blanket quantity and divide by 
the Multiples Of value for the inventory item and fill in the Containers field with the full 
container quantity ordered. (Multiples Of is entered in the Inventory module, General tab). 

If entered based on the number of containers the system will calculate the blanket quantity 
(Container quantity * Multiples Of). 

Pricing on the sales order will remain in the native UOM found on the inventory item. If 
entered based on the number of containers the system will use the inventory item Multiples Of 
value to calculate the blanket quantity. There will be no change made to the releases section. 
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Cost Source A cost source is a link to a Project Manager or Preventative Maintenance work order, a JobShop 
project, or a Fixed Asset. To assign a cost source to a line item, right click and choose one of the 
available options. A pick list will appear to choose the desired project, work order, or asset you 
would like to associate to the line item. Once attached the SO information will be visible in the 
account summary section of the Project, JobShop, or PM equipment. Sales Order information 
does not display in Fixed Assets. 

Note: For a Project Manager cost source link, the line item can be cost sourced to the Project or 
a specific Task. If Cost Source->Project Manager->Project is selected, a pick list of projects 
displays. If Cost Source->Project Manager->Task is selected the user can choose a specific task 
from the pick list. 

Once a record is assigned users can right click to jump from the cost source pop up to the 
specific record. 

To change an assigned Cost Source, select 'Unassign Cost Source' from the list and then re-
assign the correct item. 

Note: If the GL Account specified has the Cost Source Required option checked in 
Chart of Accounts, then a cost source must be entered or the user will get a warning 
message stating, ‘GL Account requires entry of a Cost Source’. 

Cust Cum Start EDI Field or can be an extra field for labels or other user defined uses. 

Discount This field applies to line items associated to a Discount Group for Customers with the 'Use 
Discount Parameters' option checked. 

Refer to the SAC Discounts section for details. 

Discount % This field shows the discount percentage the customer is to receive, if any, for the line item. 
The discount is set up as a default in Customer Maintenance.When placing any order, the item 
discount will automatically populate if the item meets the discount requirements, as 
determined by the pricing flowchart above. If the discount is entered directly on the Sales 
Order, the discount only applies to the order being entered. 

Note: If the price is manually updated the system will calculate the Discount % 
automatically as: (List Price - Price) / List Price 

Dock ID # EDI Field or can be an extra field for labels or other user defined uses. 
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Drop Ship A drop ship item is one that is shipped directly to the customer from a vendor. If the item 
added to the sales order was marked as a Drop Ship item in Inventory->AKA Selling, or if the 
customer has a Drop Ship Vendor associated to them (Customer Maintenance->Miscellaneous 
tab), this box will automatically be checked. This option can also be manually checked. Once 
checked the line item will be light green. 

When the drop ship option is checked the system will prompt the user to create a new 
purchase order or add to an existing one for the default vendor that produces the item 
(established in Inventory->AKA Buying). 

 
A pop up form will appear listing the default vendor if one has been designated. If not, a vendor 
can be selected from the pick list that automatically appears. Once a vendor is selected any 
existing PO’s for the vendor will be listed. The user can highlight a PO and select Add To PO to 
add the item to an existing PO, or select the New PO button to create a new purchase order. 
The detail section of the PO will populate with the item information. As releases are added to 
the sales order a corresponding PO release is added to the PO for the line item. No changes can 
be made to the PO line item or releases except pricing. All changes must be made from the 
sales order. 

When the 'Drop Ship Vendor' field is populated (Customer Maintenance->Miscellaneous tab) 
the system will know to create a purchase order automatically for the designated vendor when 
a sales order is created. Once the Sales Order header is posted the drop ship PO assignment 
form will display for the user to choose an existing PO or create a new one.  

(Note: PO approval works as usual). 

If the Drop Ship box is unchecked a pop up form will appear with two choices: 

▪ Delete Drop Ship PO - This will remove the item from the PO. The PO will not be deleted even 
if there are no items on it. The SO line will no longer be green, the right click Jump to Drop Ship 
PO is grayed out, and the Drop Ship PO# in the header is removed. 

▪ Cancel Drop Ship, Keep PO - The PO is not deleted and the original line remains on the PO but 
is not linked to SO, and is no longer marked as drop ship (green). The SO line will no longer be 
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green, the right click Jump to Drop Ship PO is grayed out, and the Drop Ship PO# in the header 
is removed. 

Different release Ship To addresses are not allowed for Drop Ship orders. If the user attempts 
to change the release ship to address they will receive a message stating, "Order detail line is 
marked 'Drop-Ship' - operation is not supported." 

The system will maintain the link (DROP_SHIP_ORD_DETAIL_ID) to the purchase order when 
archived or un-archived. 

See Drop Ship PO’s for more information. 

EPlant The EPlant associated with the line item. 

Extended 
Description 

The item's extended description. 

GL Account The GL account number associated to the line item on the sales order. The GL Natural Account 
displayed is based on the following hierarchy: 

▪ SO detail GL Account if changed  

▪ Sales GL Account assigned to the item 

▪ Sales Acct # assigned to the inventory group 

▪ Default sales account assigned in System Parameters > GL Setup 

The GL account is plugged for the relevant segments based on the following: 

▪ EPlant Segment – EPlant assigned in header 

The GL that is assigned on the sales order will follow the item through the packing slip/pick 
ticket modules and show up on the A/R invoice.  

Hard Allocated 
Via 

This field will populate with the pick ticket number when the pick ticket parameter ‘Hard 
allocate inventory during picking process’ is checked, and inventory has been added to the 
Relieve Inventory Locations section of the pick ticket. 

Hide 
Check this box to hide a line item when the 'Hide records marked 'Hide' button  is selected. 

If the item has releases that have not been shipped in full a message, with a Yes and No button, 
will appear stating, "Are you sure you want to hide this line item with existing backlog?". 

ICT Ship From The ship from location for ICT sales orders. 

Item # The item number. This is filled in automatically after choosing an item from the pick list 
(inventory or miscellaneous). The item can be changed by selecting the ellipsis button in the 
field and selecting another item from the pick list. However, if the item is on a pick ticket 
(regardless of whether inventory has been assigned yet or not) the user will not be able to 
change the item. A message will appear: 'The order line is linked to a pick ticket (PT# XXXX) – 
operation aborted.'   

Item Description The item description. This is filled in automatically after choosing an item from the pick list. 

For miscellaneous item users can double click this field to open a pop up to view the full 
description display, and make edits. If the user makes changes to this field it will update the 
packing slips and invoices. 

Item Rev The revision level for the item. This is filled in automatically after choosing an item from the 
pick list. 

KB Trigger EDI Field or can be an extra field for labels or other user defined uses. 
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Last Receipt 
Date 

EDI Field or can be an extra field for labels or other user defined uses. 

Last Receipt Qty EDI Field or can be an extra field for labels or other user defined uses. 

Line Feed EDI Field or can be an extra field for labels or other user defined uses. 

List Unit Price The price shown is the list selling price per piece for the item. This is the price before any 
discounts, if any, and is determined based on the blanket quantity and pricing hierarchy. This is 
filled in by the system and cannot be edited. 

Note: Prices manually entered on a sales order for items where no other price exists 
(no price indicated in master inventory as AKA sell or selling price per the buy/sell 
tab), will populate on the back-end in Data Dictionary as the 
Ord_Detail.List_Unit_Price. The back-end field will not update if the user goes back 
into the sales order and changes the price. If the user needs to change the price after 
initial entry and have the newest price be used to calculate discounts on the AR 
Invoice, they will need to delete the line item from the sales order and add it back 
with the correct price. This method will work as long as shipments have not been 
processed. 
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Make To Order When checked this indicates to the system that the line item is a Make To Order item where 
inventory is hard allocated to the item on the sales order. The line item will display in lavender. 

This option will automatically be checked if the customer on the sales order has been set to a 
Make to Order customer (Customer Maintenance->Miscellaneous tab). This can be manually 
overridden by checking or un-checking the box before transactions are started. However, if 
there are any transactions done against that MTO line item on the sales order, it is 
recommended that the user not un-check the MTO box as the MTO ID will be null which could 
cause issues in other areas. 

If inventory exists for the item the user can allocate the inventory to the sales order by right 
clicking and selecting ‘Allocate Make To Order Inventory’. A list of available locations will 
appear to choose from. This form displays both native and unit of measure conversion 
information and takes into consideration unit of measure conversions for inventory 
adjustments. The allocate form also displays Expired items in red, Hard Allocated displays aqua 
blue, and MTO lavender, so users can differentiate the locations. Once inventory is allocated 
the location in the Transactions screen will display in lavender and the Make To Order field will 
populate with the sales order number and line item number, and the location will be marked as 
a dispo designator. 

Note: If the serialized item (SIC) has labels associated to a pallet, the MTO allocated 
serials retain the pallet association when de-allocating, the multi-select list is limited 
to individual serials previously allocated. 

Note: For SIC items, an exception will surface if the serial number being selected to be 
allocated is already on a Pick Ticket.  The exception will state which pick ticket the 
serial number is linked to, and the inventory will not be allocated. If there are other 
serial numbers in the same location that are not on a pick ticket, they can be 
allocated.   

When update schedule is run, make to order demand will only look at on hand inventory 
allocated to that order detail. BY default the system will not combine demand from MTO sales 
orders and dynamic allocation demand on a single work order. It will also not combine releases 
from multiple MTO sales orders on a single work order. For a family tool with both parts on the 
same sales order, and both lines set to MTO, the system will create two work orders. However, 
if the ‘Use SN Labels to Control MTO Dispositions’ is checked (System Parameters->Purchase 
Order and Sales Order Setup tab), MTO releases will be combined on work orders rather than 
getting a work order for each release (including multiple customers/orders). (This is designed 
for use with the Slitting MFG Type). 

During dispositioning, parts will be added to a new location associated to the make to order 
detail. When adding items to the pick ticket, only make to order inventory for the particular 
order detail will be available to be picked. 

Note: When dispositioning MTO Items into inventory or allocating MTO inventory 
from SOs, the quantity is immediately not included in the Non-Committed value 
(before running update schedule).  Releasing the MTO allocation adds the released 
quantity to Non-Committed. 

Note:  In the attempt to uncheck a MTO Sales Order line item detail, when a matching 
Firm Work Order exists, a ‘Cannot Modify Make to Order’ warning will surface.  If user 
still wishes to uncheck MTO, then user will need to delete the associated Work Order 
prior to unchecking MTO on that line item detail.  
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For a complete discussion on this feature, please see the  Make To Order 
https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf 
TechNote. 

Manufacturing 
BOM Info 

There are three field in this section: 

▪ Default Mfg # - The default Mfg#  from the Manufacturing tab in Master Inventory. 

▪ Use Mfg # - This will display the Mfg # associated to the AKA item if applicable. This can be 
added or edited by selecting the MFG # that produces the Item from the drop down list. The 
drop down will only show Mfg#s that produce the item on order. During Update Schedule the 
system will use the MFG# tied to the order detail line if populated. 

▪ Mfg Division - This displays the division of the cell associated to the BOM. 

If the item is deleted from the associated BOM (Default or the Use Mfg #) the field will be 
cleared out. 

Non-Committed The Non-Committed quantity on hand for the line item. If there is a division on the sales order, 
the system will only show the non-committed quantity for that division. The system will first 
look at the division on the line item, if there is not one it will use the division on the sales order 
header. 

Note The Note field may be used to enter notes for the line item. Double click on this field to begin 
entering a note. The notes will appear in the following areas: 

▪ The Order Acknowledgment beneath the line item.  

▪ On the packing slip screen under Sales Order Comments. 

▪ In the Miscellaneous Description field on the AR Invoice. 

▪ In the Scheduling module the user can right click and select ‘Sales Order Line Note.’ 

▪ For Drop Ship line items this note will appear on the line item for the Drop Ship PO. 
(However, changes to the SO note after creation of the drop ship PO do not carry over 
to the PO). 

On Hand The On Hand quantity on hand for the line item. If there is a division on the sales order, the 
system will only show the on hand quantity for that division. The system will first look at the 
division on the line item, if there is not one it will use the division on the sales order header. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf
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On Hold The item may be placed on hold by clicking on the box. The line will display in red. The item 
that is placed on hold will not be added to the work order when generated by the system. 

If work orders were created they will be removed after update schedule is run as long as the 
work order was not marked Firm. 

On hold orders will not be added to a pick ticket. 

There are also three features in the Options menu to mark/unmark items on hold. 

▪ Mark All New Line Items on Hold - When this option is checked all newly added items will be 
marked on hold. An 'Unmark All Items On Hold' speed button will become visible in the sales 
order header toolbar which can be clicked on to unmark the on hold check box for all the item 
on the sales order. 

▪ Mark All Items On Hold - Select this option to mark all of the line items on the sales order ' On 
Hold'. 

▪ UnMark All Items On Hold - Select this option to un-mark all of the line items on the sales 
order from being On Hold. 

When sales order approval is mandatory and the System Parameter 'Sales Orders Pending 
Approval are on Hold' is checked line items will automatically be placed on hold. When the 
Sales Order Workflow is approved all line items will be taken off hold. 

Note: If you are viewing a Marketplace sales order for which you have not yet received 
payment, the sales order screen will display a red banner at the top of the line item 
detail section: "Payment has not been received. Items on this order have been 
automatically placed on hold."  Any user can remove the banner - however, only users 
with the appropriate security permissions are able to remove the 'on hold' status from 
these items. 

PO Info This is a 60 character, informational only field. This will populate with the header purchase 
order number but can be edited by typing in the field. 

If the PO # in the top section s changed, a pop up message will appear asking the user, 'Sales 
Order PO number has changed. Update Order Detail PO Info?'. If Yes is selected, the system will 
update only order detail records where the backlog quantity is greater than 0. If the user 
answers No or X’s out, the PO # in the header will be changed, but the PO on the line items will 
not. This message has a 'Do not show again check box' which can be selected so the message 
will not display when the PO # is changed. 

Price The unit price for the item. The price that automatically is associated to an item on a sales 
order is based on the blanket quantity and uses a hierarchy system. (See the flowchart above 
for details). The price may be manually overridden.  

If the item has a Lot Charge entered instead of price breaks this field will be zero. A separate 
line will be created automatically for a misc item, with an item description of Lot Charge, a 
blanket Qty of 1, and the lot charge populated in the price field. 

Note: The sales order header discount does not apply to Lot Charges. If the sales order 
has a Discount % entered in the top section, it will not be applied to the lot charge. A 
discount percent can be manually entered in the Discount % field on the line item and 
it will discount the lot charge. 

Price/1000 Calculated price per thousand based on the unit price. 

Price Book This field will display the Price Book associated to the item if applicable. Select the right click 
option 'Jump to Price Book' to open the associated Price Book. 
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Price Book 
Price Type 

This field displays the Price Type associated to the price book associated to the customer or 
ship to.  The Price Type per item can be overridden by selecting the ellipses button in the 'Price 
Book Price Type' field. The Price Type pick list will display only those price types associated to 
the item; not including the null price type.  If the user would like to use the null price type, the 
existing Price Type must be deleted from the field in the order detail first.  

When the price type is overridden and there are active price breaks then the line item price will 
be updated to use the appropriate pricing based on the quantity breaks. 

When the price book changes on the customer header record due to changing the customer or 
ship to, the price type will reset to override at the item detail level based on the price book 
hierarchy flow chart. 

If the Price Type assigned to an item only has inactive or no price breaks, a warning will surface 
stating the item is assigned to a price book but has no pricing. This warning will also surface if 
the user overrides the Price Type where there is no pricing or only inactive pricing for the item. 

 

If no price book is assigned to the customer or ship to, the system will follow the default pricing 
hierarchy and the Price Type field will be read only.   

Security is available on this field. 

See Price Book Maintenance for more information, including the Price Book pricing flowchart. 

Qty Invoiced This field will show the quantity that has been invoiced to date. The program automatically fills 
in this field. The system will deduct any RMA/Credit Memo quantities.  

Note: The 'Shipped Qty Invoiced' field does not deduct RMA/Credit Memo quantities.  

Qty Shipped The quantity shipped for the line item. This field is populated by the system. 

Quality Issues This column will display a 'Y' if the item is associated with a CAR/CAPA, ECO, Deviation, 
PPAP/Product PQ, or MRB. 

Raw MT Qty EDI Field or can be an extra field for labels or other user defined uses. 

Rebate 
Parameter 

This field will populate automatically with the rebate parameter associated to the item or 
customer. The system will use the following hierarchy when determining which rebate 
parameter if any to associate to the line item: AKA Item, Inventory Item, Customer Ship To, 
Customer. 

This field can also be manually entered by selecting the ellipsis button to access the pick list of 
rebate parameters. This information will carry over to the Rebate Manager form when the AR 
Invoice is paid in full. 

To remove a parameter, right click and select Clear Rebate Parameter. 

Reference Code This is the reference code associated with the line item selected from the alphabetized drop 
down list in the Reference Code Description field. 
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Reference Code 
Description 

This is the description of the reference code. The user may associate the sales order with a 
reference code by selecting from the alphabetized drop down list. Reference codes are used to 
provide additional descriptive information about the GL entry. The reference code will be 
carried over to the Pre-Post AR invoice. 

A reference code can be removed by highlighting the field and pressing the delete button on 
the keyboard. 

Note: A default reference code can be associated to a customer in Customer 
Maintenance->Miscellaneous tab. If a default it set for a customer it will automatically 
populate this field. 

Reserve 
Location 

EDI Field or can be an extra field for labels or other user defined uses. 

Salesperson(s) The salesperson(s) and commission percent are determined based on the commission 
hierarchy established in the system. Please see the Commissions Flowchart in the Assigning 
Sales people to a Sales Order section for more information). 

To add or edit the salesperson select the ellipsis button and the Commission Split form will 
appear. Select the Salesperson(s) from the pick list if commissions are to be paid. 

 
The Commission Amount and and Commission % will update accordingly. 

Sample When this box is checked for an item the sales order GL account (ORD_DETAIL.GL_ACCT) will 
populate with the 'Sample Sales' GL account from System Parameters->GL Setup.  When the 
item is invoiced the system will use the 'Sample Cost of Goods' account from GL Setup as the 
offset to the inventory GL Account. All cost elements will go to the Sample COGS account 
instead of the cost element COGS GL account. 

Seq # The line item sequence number assigned by the system. 

Ship Division This is the Division/Warehouse associated to the Ship To address if applicable. 
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Ship Hold Check this box to prevent the item from being added to a Pick Ticket or Packing Slip. The item 
will not display in the add to pick ticket list. If the user attempts to add it to a packing slip a 
Status Exception will appear stating it is on hold. Security can be placed on the exception to 
prevent users from selecting the OK button. Line items marked on hold will display in yellow on 
the sales order.  

Note: If the On Hold box is also checked the line item will only show the red color. 

Note: If the selected Terms on the sales order is marked as a Cash in Advance type 
term the customer # will display in pink and the line items will be marked On Ship 
Hold until payment is received. See the Cash in Advance Invoicing section for more 
information. 

Note: The Current tab in Inventory Availability will not show demand for an item 
marked as 'Ship Hold' on a Sales Order. 

Shipped Qty 
Invoiced 

This is the quantity of items shipped that have been invoiced. The system does not deduct any 
RMA/Credit Memo quantities.  

Tax Code If a tax code is associated to the Customer's Ship To address the code will fill in automatically. 
To add or edit the tax Code, click on the ellipsis button in the field and choose a code from the 
pick list. 

Note: The system will populate the tax code on a sales order based on the tax code 
associated to the 'Ship To' address (Ship To tab - Details section) and not the tax code 
assigned to the customer.  

For users shipping to different Ship To's with different tax rates it is recommended to create a 
separate sales order detail line item for each shipment that requires a different sales tax rate, 
one for each rate (entering the Tax Code on the detail line), so tax may be calculated on the AR 
Invoice.   

Total 
Commissions 

The total amount the salesperson will receive. If the price or blanket quantity is changed the 
total commissions will be updated. (Security can be placed on this field). 

Total Price The blanket quantity multiplied by the unit price. The program automatically fills in this field. 

Note: The system uses standard rounding rules and not bankers rounding rules. 

Total Release The total quantity of the releases in the bottom section for the item. 
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UOM The UOM field is used to designate the unit of measure the item will be sold in. The hierarchy 
for assigning a UOM to the sales order line item is as follows: 

▪ AKA UOM 

▪ Master Inventory UD UOM marked or 'OE Default' 

▪ Master Inventory Native UOM 

To change the UOM click on the drop down arrow and choose the correct UOM. This allows an 
item to be stored in inventory as an each but sold in another UOM such as case. For this to 
work properly you must first set up the UOM conversion using the conversion tool in inventory. 
If the conversion information is not set up properly the UOM will revert back to what it was 
before attempting to convert. 

This field can only be changed using the UOM drop down list, manual edits are not allowed. 

Users can select the 'Show Native UOM Sales Order Qty Conversion' button  to open a pop 
up window displaying the Blanket Qty, Total releases, Qty Shipped, and Backlog Qty in the 
Native UOM and all of the user defined UOMs. 

 
This data is only as good as the last time the order details were refreshed. 

Note: When you first convert the UOM the price will not change until a blanket 
quantity is entered. Then the pricing will reflect the new UOM. 

Note: The 'Show Native UOM Sales Order Qty Conversion' speed button is disabled 
when you are highlighted on a Miscellaneous item and the mouse-over hint will 
display 'Not Applicable for Misc Items'. 

User Fields There are three alpha-numeric user fields to enter additional information relevant to the line 
item. The captions can be changed by double clicking on the column heading and entering a 
new value in the pop up form. 
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Note: Security can be place on the price fields: Unit Price, Price per 1000, List Unit Price, and Total Price. 
If security item for the Unit Price is disabled in Security Inspector, in addition to the Price column not 
displaying on the Sales Order, the column is also hidden from the Sales Order pick list and the Archived 
Orders pick list. 

Inventory Availability 

Select the Inventory Availability button  in the middle section to access Inventory Availability for the 
highlighted item. See Inventory Availability for more information. 

Line Item Color Codes 

Line items may be color coded as follows:  

▪ Red - Indicates the line item has been placed On Hold. The item that is placed on hold will not be 
added to the work order when generated by the system. If work orders were created they will be 
removed after update schedule is run as long as the work order was not marked Firm. On hold orders 
will not be added to a pick ticket. 

▪ Yellow - The line item is on Ship Hold which prevents the item from being added to a Pick Ticket or 
Packing Slip. 

▪ Lavender - This indicates the item has been marked as a Make To Order item where inventory is hard 
allocated to the item on the sales order. 

▪ Light Green - The item has been marked as Drop ship. A drop ship item is one that is shipped directly 
to the customer from a vendor. 

▪ Aqua - For miscellaneous items the Item # field will be aqua. 
 

Sales Order Releases and Delivery Dates 
Entering Release Dates & Quantities 

After entering the item(s) on the order, you can now enter release and delivery dates. Delivery dates 
drive the requirements generated by the system, so the more accurate and complete, the better the 
system can assist in terms of ordering raw materials, scheduling production, and planning for shipping. 
There are several methods for entering release information 

Generate Releases 

If your customer has numerous release dates with the same quantity you can right click in the middle 
section and choose Generate Releases and the following form will appear: 
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Enter information in the following fields: 

Number of 
Releases 

This is the number of releases for the line item on this sales order. 

Quantity per 
Release 

This is the quantity the customer wants per release date. 

If the Use Blanket Qty is selected this field will be grayed out. 

Start Date The first release date. 

Date Type Optionally select the Date Type from the drop down menu (Dock or Ship). If left blank the date 
type will default to null which is the same as Dock date. Please see Date Type below for more 
information. 

Interval (in days) A value can be entered in this field for the number of days between release dates.  

Or users can select the button next to this field  to access the 'Advanced Interval Options' 
form. This form allows users to select more specific release interval types (daily, weekly, 
monthly, and yearly).  

 

Select the Recurrence Pattern. The system will use the information entered in the Generate 
Releases form such as the number of releases and quantity per release to create the releases. 

▪ Daily - Users can enter a value in day(s) to specify the release recurrence. This will populate 
the Interval  (in days) field and functions the same. Or select the Every weekday option to 
create a release for each week day, i.e. if the number of releases is 10, a release will be made 
for each week day (M-F) for two weeks. 

▪ Weekly - When this option is selected users will enter a value in the Recur every 'x' week(s) 
field and then choose the days of the week for the releases to recur. 

▪ Monthly - With this option users will enter the Recur every 'x' month(s), the day of the month 
or choose which weekday (i.e. On the second Tuesday). 

▪ Yearly - With this option users will enter the Recur every 'x' year(s), then either the specific 
month and day or choose which day of the year (i.e. On the second Tuesday of February). 

Intervals will start on or after the assigned start date on the Generate Releases form.  

Use Blanket Qty If this box is checked the system will use the blanket quantity from the order detail and divide 
by the number of releases to determine the release quantity. 

Forecast If this box is checked the generated releases will be marked as Forecast. 

Apply to all 
items on order 

If this box is checked the releases will be generated for all of the items on the sales order not 
just the highlighted item. 
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➢ Once the fields are filled in choose append or overwrite to create the releases. Append will 

add the releases to the sales order, overwrite will replace any existing releases the sales 
order may have had. 

➢ If the inventory item has the 'Selling Multiples Of' field filled in, the system will check to see 

if the release quantity entered conforms to the standard container amount. If custom unit of 
measures are used the system will convert those as well when performing this check. For 
example, if the item is sold in cases of 1200 and the selling multiples of is set to 3600 

eaches, the system will take the number of cases ordered times the UOM factor and then 
determine if it conforms to the multiples of value. If the user enters 3 cases, no warning 
would appear since 3 * 1200 = 3600 which is divisible by 3600. If the users enters 5 cases, 

the warning will appear: 

 

The user can choose to change it to the suggested quantity by selecting Yes or they can choose No to 
keep it as entered. Check the ‘Do not show next time’ box if you do not want this confirm message to 
appear again for any item.  

If the item has a 'Minimum Sell Qty' value entered in Master Inventory, then if a release is less than the 
Minimum Selling Qty, a confirmation message will pop up stating, ‘The release quantity, <qty>, is less 
than the Minimum Selling quantity, <qty>, for Inventory Item, <itemno>.  Would you like to change it to 
the Minimum Selling quantity of, <qty>?’  This pop up has a ‘Do not show next time’ option and Yes/No 
buttons.  
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The system will use the Lead Days associated to an AKA item, or if null the inventory lead days on the 
General tab, and if the Lead Days + the Must Ship Date is equal to or greater than Promise Date a 
warning will appear stating, "The Must Ship Date + Std Lead Days is equal to or greater than the Promise 
Date". This will enable users to determine if an order is being placed within the agreed to lead time. This 
confirm pop up includes a 'Do not show next time' option that can be checked so the warning will not 
appear. 

Manually Add Releases 

To manually enter releases and delivery dates, complete the following: 

➢ From within the Total Releases section, select the ADD [+] function key. 

➢ Enter in the first release quantity. This is the quantity requested by the customer. As with 
the Generated Release function the system will check to see if the quantity conforms to the 

standard box quantity set in inventory in the Multiples Of field. 

➢ Enter the Requested and Promise Dates (see below for details). 

Note: As mentioned before, the user is not required to enter in quantities that total the amount of the 
order, but remember the system uses the release quantity to determine production requirements. 
Quantities can be broken out into different delivery dates depending on what the customer has 
requested. The user may even enter dates and quantities beyond the original order. EnterpriseIQ keeps 
track of the original order amount and the releases and alerts the user if more than the blanket quantity 
is entered. 

Acknowledged The user can check this box to indicate the release has been acknowledged. This is 
informational only.  

When printing the Order Acknowledgement report there is an option on the Print form called 
'Mark Releases 'Acknowledged' When Printed'. When this is checked and the order 
acknowledgement is printed, the 'Acknowledged' check boxes on the releases will be checked.  

Note:  For Drop Ship orders - if this is checked on the sales order it will also be checked on the 
PO. 

Batch # This is an EDI field that supports shipment sequencing. 

Comment Comments can be attached to each release. These comments print out on the Sales Order 
report and the Order Acknowledgment report next to the release information for that item. 
They can be seen on an un-posted packing slip by right clicking and selecting releases and in 
the middle section of a Pick Ticket in the Release Comment field. The caption can be changed 
by clicking on the field header. A pop up form will appear to enter a user defined caption. 

Comment2 This is an additional release line comment field (up to 255 characters) used for reporting 
purposes. The caption can be changed by clicking on the field header. A pop up form will 
appear to enter a user defined caption. 

Comment 3-5 These are 60 character user fields for additional comments. A user defined drop down list can 
be created for these fields by right clicking and selecting ‘Edit User Defined List’. 

The captions can be changed by clicking on the field header. A pop up form will appear to 
enter a user defined caption. 

Cumulative Qty The Cumulative Qty field shows the accumulated order amount. The quantity changes with 
each release amount and request date entered. 
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Date Type The Date Type of the Promise Date can be changed to Dock or Ship. This defaults to null which 
is the same as Dock date. The date type is considered in the calculation of must ship date 
during update schedule. 

Please see Ship Days and Shipment Days in the Ship To Information section 

Pick tickets will also use the same logic to calculate must ship date. 

This field is also used when converting EDI orders to Sales Orders. The system populates 
releases.date_type with edi_ship.date_type. 

ECode The ECode associated with the item. 

Exclude from 
Schedule 

When this is checked Update Schedule will not process the release. There will be no allocation 
and no work order. 

If an EDI order comes in with EDI_SHIP.EXCLUDE_SCHED populated, then the system will also 
populate this box.  

Expedite Check this box to mark the release "Expedite'. If the Expedite check box is checked the release 
color code will change to red if the release is not shipped in full. (Note: The Expedite box 
cannot be checked if the release is shipped in full). This information is used in Wave 
Management Sales Order Picking module as a filter. From the 'Expedited SO' field users can 
select from the drop down list to: 'Include Expedited Orders' (this is the default), 'Exclude 
Expedited Orders', or 'Expedited Orders Only'. 

Forecast When the Forecast field is set to N, the release is considered to be a valid release. When the 
field is set to Y, the release is considered as forecasted only. This field does not restrict MRP 
(work orders will still be generated) or the ability to ship these releases. A warning will appear 
at the time of shipping stating that the release about to be shipped is a forecast and the 
release line will be blue.  

Note: The forecast field here is not related to the forecast module. 

Inventory 
Verified Date 

 

If the pick ticket parameter 'Verify Inventory before relieving' is checked, this field will 
populate with the date and time the packing slip is verified. 

Job Sequence This is an EDI field that supports shipment sequencing. 

A value can be manually typed in this field. This field can be used to inform the operators what 
parts they need to build and in what order they are needed. This field is visible on the work 
order, Assembly Track Dispatch List form and the Unscheduled Process grid, the Assembly 
Track Dispatch List Priority, and in the Assembly Track Sales Orders grid. 

Left to Ship The amount left to ship for the highlighted release.  
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Must Ship Date This displays the must ship date for the highlighted release based on the promise date and ship 
days information (setup on the Ship To tab in Customer Maintenance). The system will also 
consider Shipping Hours setup for the company or EPlant when calculating the Must Ship Date. 
If the calculated date is not valid based on the Shipping Hours it will back it up to a valid 
Shipping Hour. If the Promise Date has a time associated with it the must ship date will also 
display the time. (See Calculating the  Must Ship Date for more information). 

The user can override the Must Ship Date by selecting a different date from the drop down 
calendar.  Check the Lock check box so the Must Ship Date will not be recalculated. Note: The 
new date must be posted before the lock box is checked or it will revert to the previous date. 

Note that the lock option cannot be used with EDI maintained Sales orders.  When EDI 
updates sales orders, the replacement logic removes and recreates the releases based on 
the inbound data and there is no way to preserve the state of the lock check box. 

Original Qty The original quantity of the release line. The release quantity may be edited, however this field 
will always show the original release line quantity. 

Promise Date The promise date will default to the request date, or enter a date that you can deliver the 
shipment to the customer.  

The system uses the Promise Date to determine the Must Start Date for a work order. (See the 
information on Must Start Dates in the Work Order section). 

EnterpriseIQ also uses the Promise Date to calculate the Must Ship date. (See Date Type below 
for more information). 

If a date in the past is entered, a confirmation box pops up asking, 'The requested date and/or 
promised date occurs in the past. Continue?'. There is a 'Do not show next time' check box that 
when checked the pop up box will not appear. 

IMPORTANT NOTE: If the Promise date is manually edited and the user hits the space bar or 
arrow key a time stamp will be associated with the date. This time stamp will prevent the 
release from appearing on the Shipping Pick list reports (Available, Possibly Available, and 
Unavailable for Shipment). Users should not put a time stamp on the Promise date for this 
reason. To remove the time stamp, place the cursor on any part of the time and select the 
delete key. The date field should then only display the date (no time). 

If these reports are not used and you would like to have a time associated with the Promise 
date, the calculated must ship date and time will both be carried over the Pick Tickets. 

Qty The amount of the release. 

If the release has been assigned to a pick ticket and the user attempts to change the quantity, 
they will  receive an authorization required message: "Pick Ticket exists for this release." Select 
the OK button to continue or cancel to not change the release. 

If the total release quantity for the item is greater than the blanket quantity a warning will 
appear. Select ‘Update’ on the warning message to change the Blanket Qty to match the 
release quantity, or select ‘Continue’ to not change the Blanket Qty.     

Quantity 
Shipped 

Based on the packing slip, the Quantity Shipped field will display how many parts have been 
shipped to date. For more information on shipments, go to the item in Item Details, right click 
and select Shipments. A form appears that displays the shipment history for this item. 
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R.A.N. / Kanban Release Authorization Number from EDI for reporting purposes only. 

If this field is edited after a release has been shipped the user will receive a warning: "The 
release you are editing has been shipped in full. Shipment History information will NOT be 
updated with your changes. To affect shipment information, changes must be made to the 
release prior to packing slip generation. Do you want to cancel the changes?" 

If 'No' is selected essentially the user is ignoring the warning and the changes will not be 
cancelled. The system will change the RELEASES table with the new R.A.N./Kanban value, but it 
will not change the  SHIPMENTS_DTL and C_SHIP_HIST tables. 

If 'Yes' is selected the change is cancelled. This warning message includes a 'Do not show next 
time' check box. 

Requested Date The requested delivery date the customer wants this shipment to arrive. 

If a date in the past is entered, a confirmation box pops up asking, 'The requested date and/or 
promised date occurs in the past. Continue?'.  There is a 'Do not show next time' check box 
that when checked the pop up box will not appear. 

If the release is associated to a pick ticket the system will raise a warning if a user tries to 
change the Requested or Promised dates. 

Note: This date is used when calculating a customers credit limit if the ‘Include SO 
releases not yet shipped’ is checked. The system will look at the sales order release's 
'Requested Date' out that far into future from today and calculate how much each 
release is worth based on quantity * order detail unit price. 

Ship Date The date of the last shipment that fulfilled this release line. Partial shipments will not populate 
the field until the release is shipped completely.  

Note:  This date can be changed on the packing slip. When changing the ship date on a packing 
slip a prompt will appear stating: 'Would you like to update the ship date on the sales order 
release?' If yes is selected, the ship date will be updated on the release. If no is selected, the 
system will not update the ship date. 
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Ship To A different Ship To address may be added per release. To add a different Ship To than the one 
in the sales order header section click on the drop down arrow to access the Ship To pick list 
for the customer. Then select the ship to address for the release. When mousing over this field 
the full address, phone # and Ship To ID will display until the user moves the mouse off the 
field. 

Notes:  

▪ When the packing slip is created the Ship To in the Customer section will default to the Ship 
To on the Header of the Sales Order. To use the ship to address associated to releases on the 
sales order, select the option 'Sales Order Selection based on Release Ship To' in the Packing 
Slip Options menu. When this is checked, the Release Ship To will flow to the Packing Slip 
instead of the SO header ship to. If the Release Ship To is blank, the system will use the sales 
order header Ship To for the Packing Slip. The Ship To can be changed on the Packing Slip to a 
different location and the Sales Order release will link correctly as long as the ‘Evaluate 
Overshipment’ pick ticket parameter is checked.  If it is not checked the shipment will not be 
applied to the sales order releases correctly. This applies when the packing Slip is created 
from Sales Order or from Packing Slip Module. 

▪ If there are multiple ship to addresses on the same sales order the user will not be able to 
create a pick ticket from the sales order. An error will appear stating: "This order contains 
ship-to addresses on the release level. A single pickticket cannot be created for multiple ship-
to addresses". 

▪ If the Ship to in the header section has the’ Match RAN releases to shipments’ option checked 
in Customer Maintenance->Ship To->EDI tab then the system will only display ship to 
addresses with the ‘Match RAN’ option also checked.  

▪ Different release Ship To addresses are not allowed for Drop Ship orders. If the user attempts 
to change the release ship to address they will receive a message stating, "Order detail line is 
marked 'Drop-Ship' - operation is not supported." 

▪ When converting a Packing Slip from a Pick Ticket that has different Ship To addresses in the 
Pick Ticket release section, the system generates separate Packing Slips based on the 
individual Ship To addresses. 

▪ If the release has been assigned to a pick ticket and the user attempts to change the ship to 
address, they will  receive an authorization required message: "Pick Ticket exists for this 
release." Select the OK button to continue or cancel to not change the release. 

Please see 'Multiple Ship To Addresses' below for more information. 

Ship Via A specific Ship Via can be selected for a release. Select the ellipsis button and choose one from 
the pick list. 

Note: When creating a Pick Ticket the system will look at all sales orders for the 
customer and determine the number of unique Ship Via's (this is the number of pick 
tickets to create). Releases added to pick ticket will be based on the Ship Via if 
assigned to a release. If the release Ship Via is null the release will populate on the 
pick ticket with the sales order header ship via. If the sales order header Ship Via is 
null then the Ship Via on the pick ticket will be null. (See Create Pick Ticket from Sales 
Orders for additional information). 

Note:  If the Ship Via contains a Local Pickup Address, this address will be used by 
Avalara Tax Web Service to calculate sales tax.  (See the Avalara Tax Web Service 
TechNote https://my.iqms.com/cfs-file.ashx/__key/Technote/Avalara-Tax-Web-
Service.pdf for details). 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Avalara-Tax-Web-Service.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Avalara-Tax-Web-Service.pdf
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User Date fields There are three user defined date fields for reporting purposes only. The caption of these 
fields can be changed by clicking on the field header. A pop up form will appear to enter a user 
defined caption. 

WO Note Select the ellipsis button to add a note that will be visible from the release section on a work 
order, and from the release section of the Finite Schedule in both the grid and GVS views. Up 
to 255 characters can be entered. 

 

Multiple Ship To addresses 

Although it is possible to link a different ship to address to a specific release it may be better to add the 
item a second time to the detail area (center) of the sales order screen with the blanket quantity for that 
location, or create a separate sales order for the other ship to location. Orders created from inbound EDI 
create a different sales order for each ship to location by default. 

If a one-time shipment will go to a different location, you can create the packing slip for the regular 
location but use a BOL for the actual ship to it physically goes to. Please see the section on Effects on 
Releases when changing Ship To addresses on the Packing Slip in the Editing the Packing Slip Before 
Posting section for examples of situations that may arise when changing the ship to address. 

 About Delivery Dates & Quantities 

Because manufacturing data is date driven, all dates entered are used to compute manufacturing 
requirements (assuming they fall within the schedule scope). It is recommended that only valid delivery 
dates with firm commitments be entered. You do not need to enter the dates in date order. This 
becomes important when adding a date that falls in the middle of the existing delivery dates. Enter the 
new request date at the end of the list, press the refresh key, and all dates are rearranged in order by 
date. 

If a date that falls in the middle of existing dates is deleted, the program re-sorts the list and rearranges 
it by date. 

To automatically generate work orders from the sales orders entered, you must run Update Schedule. 
For more information on this topic, please refer to Generated Work Orders. 

Release Section Speed Buttons: 

Following is a description of the speed buttons in the Release section of the Sales Order. 

 Cumulative Quantities 

To turn ON this function, click on the Cumulative quantities speed button. 

With this option on, the Cumulative Quantity field can be edited and the quantity field will not be 
editable. With this option off, the Cumulative Quantity field is not editable and the Quantity field can be 
edited. 
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Recalculate Release Ship Dates 

This option recalculates the release ship dates if manual adjustments have been made to be the current 
system date/time of when the button is pressed. 

Note: A ‘Model Year Cumulative Reset’ is a manual adjustment and should not be used in conjunction 
with the ‘Recalculate Release Ship Dates’ as shipped release Ship Dates will recalculate to be the current 
System Date/Time.  

Note: If cumulative shipments are being manually adjusted they should be treated like prior shipments 
and should be reflected in the first release of the sales order. For example, if the cumulative shipment 
was 100,000, the first release should be for 100,000 and show shipped as green (in full). Cumulative prior 
shipments should not be partials. 

Hide Releases with known Ship Date 

With this button depressed the releases with a known ship date will be hidden from the screen. For 
orders with a lot of release dates this will help the user not have to search through all releases but just 
the ones that have not been shipped. 

Color Codes on Releases 

The release dates are color-coded to show the following: 

▪ Green - Fully Shipped 

▪ Yellow - Partially shipped 

▪ Magenta - Not Shipped 

▪ Orange - Pending Inventory Verification. When a Packing Slip is posted if the 'Inventory Verification' is 
on the system will mark all releases that are covered by this shipment as Pending Verification. Once 
they are verified they will display as fully or partially shipped. 

▪ Red - If the Expedite check box is checked the release color code will change to red if the release is 
not shipped in full. (Note: The Expedite box cannot be checked if the release is shipped in full). This 
information is used in Wave Management Sales Order Picking module as a filter. From the 'Expedited 
SO' field users can select from the drop down list to: 'Include Expedited Orders' (this is the default), 
'Exclude Expedited Orders', or 'Expedited Orders Only'. 

▪ Aqua - When a release is on a pick ticket the 'Requested' and 'Promised' columns will be colored 
aqua. 
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Sales Order User Fields Tab 
This tab contains six user defined fields. These are the same user fields found on the CRM Quote. This 
information can be entered from the Sales Order or can be converted from CRM quote. 

The Label Text for each user defined field can be changed by right clicking and selecting 'Define Label 
Text'. . 

Each user field can have a user defined list associated to it. The list is created from the 'Edit User Defined 
List' right click option. 

Note: Because these fields are not in the same database table the change made in one module will not 
effect the other. If it is desired that the fields are the same in both modules enter the label text in each 
module identically.  
 

Sales Order Documents Tab 
Each order can have documents attached. These documents may be Internal or External documents 
which can be set to print automatically with the sales order, sales order acknowledgement, packing slip, 
certificate of conformance, or all. Additionally emails can be added by dragging and dropping them to 
the Email Correspondence tab. Both attached documents and emails will remain attached to the sales 
order after it has been archived.  
 



Sales Orders Page 48 of 150 

 

Quick Order Entry 

The Sales Order form can be toggled to the Quick Order Entry method. This method allows users to 
quickly enter a sales order for a customer with one delivery date (not multiple releases) for several 
items. To change the sales order form to be in Quick Entry mode, select the 'Quick Order Entry (No 

Releases)' toggle from the Options menu. When the Quick Order Entry option is selected, an additional 
option becomes available called, 'Pick On Hand Inventory to Ship'. If this is selected when entering 
quantities in the detail section, users will be prompted to select the locations to be used to fill the order. 
These settings are remembered in the registry so they will not have to be selected each time. 

The Sales Order form will look as follows: 
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The fields in the header section are basically the same as described above with one exception, Delivery 

Date. This field is used to enter the delivery date for all of the items on the sales order. If this date is 
changed a message stating, 'Do you wish to update the Date for every sales order line item with the 
Delivery Date?' If ‘Yes’ is selected, the line item(s) dates will change. If ‘No’ is selected, the line item(s) 
dates stay as is. Security can be set on this confirmation message.  

Adding Items 

Items can be added one at a time by first selecting one of the Add/Edit option buttons (Inventory, 
Miscellaneous, or AKA), then selecting the insert (+) button, or multiple items can be added at one time 
by using the Fast Order Entry Tool. When selecting add from AKA, both the single item pick list and the 
fast order entry list will only display the customers AKA items. When selecting add miscellaneous items, 
the miscellaneous list will only display when adding a miscellaneous item one at a time. The fast order 
entry list will not display miscellaneous items (only all inventory items). 

Fast Order Entry Tool 

Select the Fast Order Entry Tool speed button in the line item detail section of the sales order . A 
form will appear listing inventory items to select from. 
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The current system date will populate in the Default Promise Date field but can be changed by selecting 
a date from the drop down calendar. This date will be used for the selected items when added to the 
sales order by default. Specific promise dates can be added to individual items in the Promise Date field 
which will override the default date. 

This form can be sorted by the various columns by clicking the desired column header. The columns 
include: Qty, Promise Date, Item #, Description, Rev, Class, Ext Description, UOM, On Hand, and Non-
Committed. Users can enter a value in the white box to search for specific records. Once the item is 
located, enter the quantity to add to the order in the Qty field. The Promise Date will populate with the 
default date entered on the form but can be changed by selecting a different date from the drop down 
calendar in the Promise Date field. Once the quantities and dates have been entered for all the items to 
be added to the Quick Sales Order, select the OK button. A confirm message will appear, 'Selected items 
count: #. Append selected items to the sales order?'. Select Yes to continue or No to return to the form 
to make changes. Once Yes is selected, all items will be added to the order. 

Note: This option is not available if the 'Pick On Hand Inventory to Ship' option is checked. 

Adding Items Individually 

To add items individually to the sales order select one of the Add/Edit option buttons (Inventory, 
Miscellaneous, or AKA), then select the insert (+) button. For inventory items select the item using the 
hyperbrowse drop down menu which includes Item #, Description, Rev, EPlant ID and Class.  

For AKA items select the ellipsis button in the Item # field to access the pick list. If an AKA selling record 
exists for the customer, and the item is selected through the main inventory drop down instead of the 
AKA drop down, a warning will surface directing the user to select from AKA items.  The line item detail 
record cannot be posted until the item is selected from the AKA list.   

For miscellaneous items select the ellipsis button in the Item # field and enter the data (description, 
quantity, price, UOM and GL account) in the pop up form. The fields will populate with the item 
information such as description, revision, etc, and the date field will fill in with the Delivery Date entered 
in the top section. Users can double click the Description field bring up the note pad pop up and see the 
full display. 

For Inventory and AKA items, enter the quantity. The price will populate based on the hierarchy 
described in the Sales Order Line Item Details section. If the inventory item has the Selling Multiples Of 
field filled in, the system will check to see if the release quantity entered conforms to the standard box 
amount. If it does not a warning will appear stating, "The quantity, xx.xx, does not conform to the 
container (multiples of) quantity, xxx.xx, for Inventory item, [Item#]. Would you like to change it to the 
suggested quantity of, xxx.xx?" The user can choose to change it to the suggested quantity by selecting 
Yes or they can choose No to keep it as entered. Check the ‘Do not show next time’ box if you do not 
want this confirm message to appear again for any item. 

Pick On Hand Inventory to Ship 

When this option is checked (Options menu), instead of just entering the quantity in the field, users will 
select the location(s) to be used to fill the order. The user will select the ellipsis in the Quantity field to 
bring up the ‘Assign Quantity and Locations’ form and select which location(s) to use to fulfill the order. 
After selecting an item, the 'Assign Quantity and Locations' form will display for the user to enter the Pick 
Quantity in the desired locations. Users can select the Filter button to exclude: In Transit, Hard Allocated, 
Expired, Non-Allocate, Non-Conform, VMI, and Make To Order locations. 
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The system sums the user picks by the warehouse/division associated to the selected locations. The first 
warehouse/division is populated in the Warehouse/Division field for the Line item along with the Pick 
Qty. If more than one warehouse/division is selected, an additional line will be created to sum the pick 
quantity for that division. For example, if the user made two picks from inventory from two different 
warehouse/divisions, there would be two line items for the same Item#. 

 

When this option is used, when the user selects the 'Multiple Pack Slips by Division' from the drop down 
on the Create Packing Slip speed button, the system will create a Packing Slip for each 
Warehouse/Division represented in the sales order detail line items. A Generated Shipments form will 
appear listing the packing slips. Users can right click to jump to a packing slip from this form. (See 
Creating a Packing Slip From a Sales Order for more information). 

Continue this process until all of the items have been added to the sales order. The lines will display in 
white and blue alternately for ease in viewing. 

Note: Not all of the line item fields that are available in the standard sales order form are available in the 
Quick Order Entry form, as it is designed to be used for quick data entry. 

Alphabetical Field Listing: 

AKA Description The AKA description if applicable. 

AKA Item # The AKA item number if applicable. 

CUSER 1 An alpha-numeric user field to enter additional information relevant to the line item. The 
caption can be changed by double clicking on the column heading and entering a new value in 
the pop up form. 
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Date Select a date from the drop down calendar. If the Quick Order Entry option is turned off the 
system will use this date for the requested and promise date on the release. 

Division/Wareho
use 

This will populate with the Division/Warehouse associated to the selected locations when using 
the 'Pick On Hand Inventory to Ship' option. 

Note: The name of this field depends on the selection in System Parameters->Company File 
Maintenance->Application tab->Division toggle. If 'Warehouse Division' is selected it will be 
Warehouse, if 'Manufacturing Division' is selected it will be Division. 

Drop Ship A drop ship item is one that is shipped directly to the customer from a vendor. If the item 
added to the sales order was marked as a Drop Ship item in Inventory->AKA Selling, or if the 
customer has a Drop Ship Vendor associated to them (Customer Maintenance->Miscellaneous 
tab), this box will automatically be checked. This option can also be manually checked. Once 
checked the line item will be light green. 

Refer to the Drop Ship portion in the 'Sales Order Line Item Details' section for more 
information. 

Extended 
Description 

The item's extended description. 

Item # The item number. This is filled in automatically after choosing an item from the list.  

Item Description The item description. This is filled in automatically after choosing an item from the pick list. 

This will be the manually entered description for miscellaneous items.  

Item Rev The revision level for the item. This is filled in automatically after choosing an item from the 
pick list. 

Line # The line item sequence number assigned by the system. 

Make To Order When checked this indicates to the system that the line item is a Make To Order item where 
inventory is hard allocated to the item on the sales order. The line item will display in lavender. 

This option will automatically be checked if the customer on the sales order has been set to a 
Make to Order customer (Customer Maintenance->Miscellaneous tab). This can be manually 
overridden by checking or un-checking the box before transactions are started. However, if 
there are any transactions done against that MTO line item on the sales order, it is 
recommended that the user not un-check the MTO box as the MTO ID will be null which could 
cause issues in other areas. 

For a complete discussion on this feature, please see the  Make To Order 
https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf 
TechNote. 

Note The Note field may be used to enter notes for the line item. Double click on this field to begin 
entering a note. The notes will appear in the following areas: 

The Order Acknowledgment beneath the line item.  

▪ On the packing slip screen under Sales Order Comments. 

▪ In the Miscellaneous Description field on the AR Invoice. 

▪ In the Scheduling module the user can right click and select ‘Sales Order Line Note.’ 

▪ For Drop Ship line items this note will appear on the line item for the Drop Ship PO. (However, 
changes to the SO note after creation of the drop ship PO do not carry over to the PO). 

PO Info This is a 60 character, informational only field. This will populate with the header purchase 
order number but can be edited by typing in the field. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf
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Price The unit price for the item. The price that automatically is associated to an item on a sales 
order is based on the blanket quantity and uses a hierarchy system. (See the flowchart for 
details). The price may be manually overridden.  

If the item has a Lot Charge entered instead of price breaks this field will be zero. A separate 
line will be created automatically for a misc item, with an item description of Lot Charge, a 
blanket Qty of 1, and the lot charge populated in the price field. 

Note: The sales order header discount does not apply to Lot Charges. If the sales order has a 
Discount % entered in the top section, it will not be applied to the lot charge. A discount 
percent can be manually entered in the Discount % field on the line item and it will discount 
the lot charge. 

Quick Data Entry 
Qty 

 Enter in the total amount the customer wants to order.  

Salesperson(s) The salesperson(s) and commission percent are determined based on the commission 
hierarchy established in the system. Please see the Commissions Flowchart for more 
information). 

To add or edit the salesperson select the ellipsis button and the Commission Split form will 
appear. Select the Salesperson from the pick list if commissions are to be paid. 

Tax Code If a tax code is associated to the Customer's Ship To address the code will fill in automatically. 
To add or edit the tax Code, click on the ellipsis button in the field and choose a code from the 
pick list. 

Note: The system will populate the tax code on a sales order based on the tax code associated 
to the 'Ship To' address (Ship To tab - Details section) and not the tax code assigned to the 
customer.  

For users shipping to different Ship To's with different tax rates it is recommended to create a 
separate sales order detail line item for each shipment that requires a different sales tax rate, 
one for each rate (entering the Tax Code on the detail line), so tax may be calculated on the AR 
Invoice.  

UOM The UOM field is used to designate the unit of measure the item will be sold in. To change the 
UOM click on the drop down arrow and choose the correct UOM. This allows an item to be 
stored in inventory as an each but sold in another UOM such as case. For this to work properly 
you must first set up the UOM conversion using the conversion tool in inventory. If the 
conversion information is not set up properly the UOM will revert back to what it was before 
attempting to convert. 

When an item on a Sales Order is in a different UOM as the item's native UOM the 'Show 
Native UOM Sales Order Qty Conversion' button _ will be visible. This option will open a pop up 
window displaying the Blanket Qty, Total releases, Qty Shipped, and Backlog Qty in SO UOM 
and Native UOM. 

This data is only as good as the last time the order details were refreshed. 

Note: When you first convert the UOM the price will not change until a blanket quantity is 
entered. Then the pricing will reflect the new UOM. 
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Additional Options 

Search - Select the search button to bring up the pick list of items on the sales order. 

Capable to Promise (CTP) - Select the Capable to Promise button  to access the Quick Order Entry CTP 
form. When this is opened the system will ask: "Would you like to recalculate CTP?" Select 'Yes' to 
calculate the capable to promise dates for the items on the sales order. The form will display the items 
and the capable to promise dates.  

Parameters 

The CTP Parameters can be accessed from the File menu. 
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▪ Response Time - The response time is added into the overall calculation for items (purchased and 
manufactured). It is the number of days it takes to respond to the order in house. For instance, how 
long does it take to get PO’s created, orders entered, etc. The calculation for required items is system 
date + lead time + response time (weekends are included). 

▪ Include ship time in CTP calculation - Check this option to add the ship time in days from the Ship To 
address to the calculated CTP date. 

▪ Include Allocated to Auto MRP WO - By default, for Auto MRP items, when on hand inventory is below 
its MFG Order Point, when update schedule runs the system will FG Allocate the current on hand 
towards the internal stock order. This throws off the CTP Date because it expects to satisfy the 
internal order instead of notifying the user they could technically promise that item the same day to 
the customer. This parameter enables the system to ignore the FG Allocation and display the current 
date as long as the current on hand for the item does not exceed the requested quantity. If the 
requested quantity exceeds the on hand value, it will calculate the difference in demand and display 
the CTP Date for which the difference will be completed by.  
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If the CTP date conflicts with the delivery date (is after the entered date) the date field will display in red. 
If the CTP date does not conflict with the delivery date (is before the entered date) it will be green. 

The lower section of this form displays the status of the CTP dates. The CTP Conflicts box displays the 
number of items where the CTP date is after the delivery date. The Ship in Full CTP box displays the last 
CTP date for all items. 

There are two options available to select from: 

▪ Assign Ship In Full CTP to the SO  - This check box allows the user to assign the ship in full CTP date to 
all of the items on the sales order. Check the box and select OK. A confirm box will appear, select Yes 
to continue or No to return to the form with no changes. When Yes is selected the promise date for 
each line on the sales order will be changed to the ship in full CTP date. 

▪ Assign Line Item CTP to the SO - If this is checked, the system will use the CTP dates for each line for 
the promise date of each line. This allows users to apply the date on a line item basis, rather than use 
the Ship in Full CTP date for all items. 

Note: These two options are mutually exclusive. Only one or the other can be checked. 

CTP Routing Diagram 

From the Quick Order Entry CTP form the user can right click on an item and select Show CTP...  to view 
the CTP Routing Diagram for the item. 
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For more information on the CTP Routing Diagram please see Capable To Promise. 

Right Click Options: 

The right click options from a Quick Order entry screen are basically the same as a release type sales 
order. However, the quick order does not have the release options as they do not apply. Also, a quick 
order has one option not available on the other type of order called, Show Packaging / Pallet Quantities. 
This option opens a window with the packaging details (e.g. parts/Package, parts/pallet) for all items on 
the order. 

 

Note: It is okay to toggle back and forth from the Quick Order Entry view for different sales orders but it 
is not recommended to edit the same order in both views. If an order was created in the standard view 
with multiple releases, when the Quick Order Entry switch is selected, the blanket quantity and only the 
first promise date will display. The system is still aware of all the releases and work orders are not 
affected. However, changing the quantity or promise date in Quick Order Entry view will change the first 
release originally entered in the standard view. 

Note: Users will receive the over credit limit warning when using the Quick Order Entry tool like the when 
using the standard order entry method. 
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Sales Order Workflow Approval 

Workflow functionality can be used to approve Sales Orders. Emails are sent through a workflow process 
evaluation to the individuals responsible for the tasks, allowing for an emailed response back into the 
system. All of this information is maintained in a single form for reference. There are two relevant 
settings in System Parameters on the Purchase Order and Sales Order Setup tab: 

▪ Sales Order Workflow is Mandatory - If this option is checked all sales orders will be required to go 
through the workflow approval process. The Required box in the header of the sales order form will 
automatically be checked. It cannot be manually un-checked. If this is not checked users can 
manually check the Required check box in a sales order to have it go through the workflow process 
for approval. 

▪ Sales Order Pending Approval are on Hold - If this option is checked, and the Required checkbox on 
the sales order is checked, all line items will automatically be placed on hold. When the Sales Order 
Workflow is approved all line items will be taken off hold. After a sales order is approved, if it is 
reverted back to not approved, the item(s) on sales order will be marked back to 'On Hold' again. 

Note: When additional items are added to the sales order after the sales order is approved, and the 
option ‘Sales Order Pending Approval are on Hold' is checked, the items will remain on hold until the 
user manually rewinds the elements and re-evaluates the workflow. From the header section of the sales 
order there is a right click option 'Rewind Approval Workflow' which provides an easier method to 
rewind the approval workflow for these situations. When selected a Confirm message will appear with 
Yes and No buttons stating, "This options resets the completion date for all elements along with all 
Workflow approval records so it can be evaluated again. Are you sure you wish to proceed?" 

To utilize workflows in sales orders the Approvers Team must be established and workflow template(s) 
must be created. 

Approvers Team 

After selecting this option from the File menu on a Sales Order, the Approvers Team form will appear. 
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Select the insert button to add team members. Click on the ellipsis button in the User ID field and select 
the team member from the list (this picklist is filtered for Approval Team members that have the OE 
checkbox selected in Team Members). Their name, title, Type, Out of Office, and email address will fill in 
automatically. 

Creating Approval Templates 

Create template(s) with tasks for the Sales Order approval functionality. 

From the File menu select Approval Templates, then select New and the following form will appear: 
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The Template form is divided into three sections: 

▪ Name - The Name and Description of the template 

▪ Elements - The elements (or steps) used when performing a Workflow that utilizes this template. 

▪ Response - Includes the Lookup List, CheckList, and Team Members. 

Top Section: 

To create a template, input a Name and Description in the top section.  

The Kind will be OE since it is used in the Sales Order (Order Entry) module. 

Select a Workflow type from the drop down. The options are Sequential or Broadcast. The workflow type 
selected in the header section refers to the Elements. The information will be sent either for one 
element at a time Sequential or for all elements Broadcast. 

A template can be marked Inactive which hides it from pick lists. 

When the Exclude Weekends option is checked the calculation for Required Date will exclude weekend 
days. If it is not checked it will include all days when calculating the Required Date. For example, if the 
Duration of an element is 7 days and the workflow is marked active on a Wednesday, with this option 
checked the Required Date will be the following Friday. If it is not checked the Required Date will be the 
following Wednesday. Note: If this option is not checked but weekends have been marked off in the 
Workflow Calendar then the system will exclude weekends (see the Workflow Calendar in Team 
Members for information on setting days off for workflows). 

The EPlant is assigned based on the plant logged into when the template is created, or it will be null if 
logged into View All. To manually assign an EPlant select the ellipsis button in the field and select an 
EPlant from the pick list. The template pick list is soft filtered on EPlant so when creating new records 
users will see templates associated to the EPlant they are logged into or those with out an EPlant 
assigned. 

Elements: 

The middle section is where the elements are entered. The elements are the steps that will be taken for 
the Workflow. To create the elements, click on the ADD (+) button in the Elements section and type in 
the description of the element.   

The amount of time in days the Element is expected to take can be entered in the Duration field. This 
value will be used to calculate the Required Dates for each element.  Continue this process until all 
elements have been entered. Note: The Required Date is calculated based off of midnight of the 
activation date. If, for example, a user had a Duration of 1.25 (1 day, 6 hours) set up on the template and 
the workflow is activated on December 11th, the Required Date will calculate December 12th at 6 AM. If 
a user wishes to have the element calculated from a different start time, the Required Date time stamp 
can be overridden when the ‘Active’ checkbox is unchecked. After the time is modified, users can right 
click within the Elements section and ‘Update Subsequent Required Dates’. 

The Sequence number information will fill in automatically with the next number as you add elements, or 
can be overridden by the user. Duplicate sequence numbers are allowed which will indicate in the 
workflow that the elements can be done simultaneously (emails will be sent for all elements with the 
same sequence number at the same time). The required dates for elements with the same sequence 
number will calculated for each element’s duration. Elements having subsequent sequence numbers will 
have their required dates calculated from the longest duration required date from the previous element 
sequence group. 
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A Workflow Type can be associated with each Element. This workflow type refers to the Team Members. 
The information will be sent either for one team member at a time (Sequential) or for all team members 
associated to the element (Broadcast). 

Moving Elements - Once Elements are entered, the order they are in can be changed using the up and 
down arrow buttons. The element number will automatically change as it is moved. 

Copy and Paste Elements - Elements can be copied and pasted from one template to another template or 
to the same template as a time saving feature. When copying from one template to another the 
template must be of the same type, i.e. CAR to CAR, PO to PO, etc. Highlight the element to copy and 
select 'Copy Element'. Go to the template where it is to be pasted to, right click and select 'Paste 
Element'. All of the Element information will copy over. The Description will be the same, but a new 
sequence number will be generated. 

Response: 

The bottom section is where the Response (Lookup List, Checklist, and Team Member) information 
associated with a specific element is entered. 

The Response Lookup List is a list of user-defined responses that correspond to the Element in the 
middle section. During the Workflow process each step can have response information associated with 
it. These responses can be added from the Response Lookup List created on the template or be added 
manually. This list of responses will be available from the web based approval page. Enter a descriptive 
Code and enter the corresponding response by double clicking in the Text field. 

The Checklist is the list of steps involved in completing the corresponding element. To create checklist 
items click on the ADD (+) button on the Checklist tab and type in the text. This information will appear 
on the Workflow form in the Problem Report section, and on the web based approval page. The checklist 
items can also be marked Critical by placing a check in the Critical box.  A 'Y' will appear for the 
corresponding checklist item(s) on the Workflow form, and signifies that the checklist item(s) is a critical 
step in the Workflow process. An element cannot be marked as completed unless team members affirm 
and respond to a critical checklist item. If a user attempts to approve an element without affirming the 
critical checklist item(s) an error will occur stating “All critical checklist items must be affirmed in order to 
approve this element”. User defined Notes can be associated to a checklist item. The notes can be typed 
manually or selected from a user defined list. To create the list, right click on the field and select 'Edit 
User Defined List'. The notes will appear on the Checklist tab of web approval page and in the Checklist 
section on the main module. 

The Team Members is the list of personnel responsible for the specific element.  The Approvers Team 
(Team Member) list can be accessed from the Sales Order File menu. 

When a new Workflow is created using the template, the team members added at the template level will 
automatically be added for the new Workflow. This is a time saving feature if the same team members 
typically perform a specific element for all Workflow's that utilize the template. To add team members to 
the template element select the ADD (+) button and select the team members from the pick list. 

Set the Type to authorize or review. 

▪ Authorize team members are required to sign off on the approval process. 

▪ Review team members will receive an email notification through the workflow process, but are not 
required to sign off. 
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If the Type is not selected at the template level it will default to Authorize on the Workflow form. If all 
team members are set to Review the element will not be completed. Team members set to review will 
appear in italics to distinguish them from authorize members.  Enter notes if desired.  The notes will 
display on the responsible tab of the Workflow form and on the web based approval page. 

Delegate To - A Delegate can be associated to a team member with a Days Threshold value.  The delegate 
days threshold will control when a second email is sent to the delegate if the original team member did 
not respond within that time. This will help prevent a workflow from stalling because someone is too 
busy or out of the office for an extended period of time without the initiators knowledge. Once the ‘Days 
Threshold’ has passed and the workflow is evaluated, the Delegate is sent an email and can log in to 
approve/deny the workflow. Both the delegate and the days threshold can be edited for a specific 
workflow on the Responsible tab. 

Note: There is also the "Pending Authorization Expired" number of days feature that can be setup on the 
IQAlert that processes workflows.  The number of days should be greater than the delegate days 
threshold. 

Copy and Paste Team Members - Team Members can also be copied and pasted from one element to 
another as a time saving feature. Highlight the element whose team members you want to copy, right 
click and select 'Copy Team Members'. Highlight the element the team members are to be pasted to, 
right click and select 'Paste Team Members'. All of the team members, their Type, and Notes will copy 
over. This same feature is available from the Elements section on the main form. 

External Documents 

External documents can be associated to a template. This can be used to provide documentation for 
requirements for the specific template and the quality records it is associated to. Any external 
documents attached to a template will carry over to the Ext Docs tab for new records that utilize the 
template. 

Create Additional Templates 

To create additional templates click on the ADD (+) button on the Template form and complete the 
above steps. 

Templates may be cloned by selecting the Clone Template speed button  at the top of the Template 
form. Select the template to be cloned then select the Clone Template speed button. A pop up box will 
appear for the user to enter in a new template Name and Description.  Make edits to the elements and 
responses if desired. 

Creating a Workflow 

Once the Workflow Approval is activated and templates have been created, a new Workflow can be 

started by clicking on the Workflow speed button  at the top of the Sales Order form. A pick list of 
Templates will appear (if there is only one template the pick list will not appear).  Select a template from 
the list and the Workflow form will appear for the selected template.  



Sales Orders Page 63 of 150 

 

 

The list below describes the fields in the top left section: 

Workflow # This is the Workflow # for reference purposes. This number is assigned by the system 
in sequential order. If you are using EPlant this number will have the EPlant suffix 
after the number. This field can be overridden by typing over the existing number. 

Kind This will display OE. 

Initiator The Initiator field displays the user login for the person who created the associated 
Sales Order. When the Sales Order is approved the initiator will receive an email. 

Active This marks the Workflow as active. If Durations are entered for the elements the 
Required Dates will automatically be calculated based on the date the Workflow is 
marked Active. 

This field can be expanded to view the Start Date. This is the date the workflow was 
marked Active. 

Note: The evaluate workflow process cannot be used until this is checked. 

Open Date This date defaults to the date and time the Workflow was created but can be 
changed using the drop down calendar. 

This field can be expanded by clicking on the + next to the field name to display two 
additional date fields, Completed Date and Close Date. The Completed date will 
automatically populate when all of the Elements have been completed. 

The Close date can be edited using the drop down calendar and selecting a date. 
Once a close date is added to the Workflow the status of the Workflow will be closed. 
The status is used for filtering purposes. 
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Customer # 

Customer Name 

This is the Customer associated with the Workflow. This will automatically populate 
with the customer from the sales order. Click the + button to expand the field to see 
the Customer Name. 

Sales Order  # This is the Sales Order # associated to the workflow. 

Workflow Type This information will fill in automatically if a workflow type is associated to the 
selected template. It can be changed by selecting the workflow type from the drop 
down menu. There are two options: 

▪ Sequential Workflow - When using IQAlert to evaluate workflow an email will be sent 
to all team members in the first element. Workflow cannot continue until the team 
members have responded to the element.  

▪ Broadcast - This option will send an email notification to all team members for all 
elements when using IQAlert to evaluate workflow. 

Template Type This displays the Template Name associated with the Workflow. 

EPlant ID This is the ID for the EPlant associated with the Workflow. This field will automatically 
populate with the ID based on the EPlant the user is logged into. 

Archived  This box will be checked if the workflow is archived. 

To archive a workflow record select Archive from the File menu. Select Yes to confirm 
the status change. The Archived box will be checked. 

Archived records can be restored by selecting Restore from Archive from the File 
menu. The box will be un-checked. 

From the Options menu users can choose to view workflow records based on 
whether they are open or archived. Select View All, Open Only, or Archived Only to 
filter what is displayed based on this status. 
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Elements 

This section contains the elements associated with the template that was chosen when the Workflow 
was created. Elements can be added, deleted, and the order rearranged as long as the active box is not 
checked and the element does not have a complete date. Use the +, - and up and down arrow buttons to 
perform these functions.  

If a duration was entered for the elements on the template the Required Date and Baseline Date will 
automatically populate once the Active box is checked. If no duration was entered for the elements, the 
Required Date and Baseline Date will populate with the date the record was marked active. The Required 
Dates cannot be changed once an element is completed. If the Required Dates for non-complete 
elements need to be changed, un-check the Active box and select a new date from the drop down 
calendar. To change the Required Date on the subsequent elements, right click and select 'Update 
Subsequent Required Dates'. This will update the subsequent Elements' Required Dates based on the last 
Required Date plus the Duration. 

The Baseline Date does not change with edits to Required Dates unless the 'Populate Baseline Date(s)' 

button  is pressed, in which case the Baseline Date column is populated with the current Required 
Date for elements that have not been completed.  Security can be applied to the 'Populate Baseline 
Date(s)' button to restrict access. 

Once an element has been approved by all Authorize type team members, the completion date will fill in 
automatically after the workflow is evaluated again.  

Workflow Gantt Chart - This button will bring up a Gantt chart for the Elements. 
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 Rewind/Reset Element workflow approval process - This process resets an element's complete date as 
well as its workflow approval records so it can be re-evaluated again. This option is also available from 
the right click menu in the sales order header section. 

Once selected a confirm box will appear to select Yes or No. If Yes is selected, the system will reset the 
element and a box will display stating the number of processed workflow records that were reset. The 
line item(s) in the Responsible section will revert to black allowing the workflow for the element to be 
reevaluated. 

User Defined Form 

A User Defined Form with additional fields can be created for workflows. These fields can then be used in 
customized reports. The User Defined Form can be accessed from the speed button, the User Defined 
Form tab or from the Options menu. See the User Defined Forms portion in the Using EnterpriseIQ' 
section of the help files for more information on creating a user defined form. 

Summary 

The Summary tab displays summary information for each element. It includes the Element Description, 
Complete Date, Duration, Required Date, Workflow Type, and Response information. The user can select 
the number of panels to view (up to 15) from the # Panels drop down. This defaults to 'Auto' which will 
display a panel for each Element associated to the workflow. 

History 

From the History tab users can view the history related to the workflow. This tab includes the following 
information: 

▪ Event Date and Time 

▪ Event - This will describe the event, such as Signoff, Checklist, or Reset One 

▪ Name - The name of the team member associated to the workflow event 

▪ Quality record number - i.e. CAR # '#-EPLANT' 

▪ Signoff - Y or N 

▪ Signoff Date and Time - The date and time the element was signed off 

▪ Response  - Response notes. Double click this field to access the response text at the time of the 
history record. 

▪ Notes - Notes entered in the note field on the workflow. Double click this field to access the notes 
text at the time of the history record 

▪ Checklist Text - The description of the Checklist item 

▪ Checklist Status Old - The old Checklist status (Y, N, N/A) 

▪ Checklist Status New- The new Checklist status (Y, N, N/A) 

▪ Username - The Username that reset the rejected record 

▪ Element Description 

▪ Responsible Name - The name of the Team Member responsible for the entry 

▪ Responsible Type - Review or Authorize based on the responsible type associated to the responsible 
team member within the responsible tab 

Documents 

In this section the user can attach internal or external documents, or Email Correspondence associated 
with the workflow.   
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Internal Documents 

The screen acts like a word processor. The user can add, edit, delete, or print documents from here. 
Graphic images may also be imported into the document or text area. EnterpriseIQ supports .BMP or 
.WMF graphic files only. 

External Documents 

To attach a document, click on the (+) button and select the Document Library and document from the 
screens that appear. To OPEN the document double-click on the file name, or select the document and 
right click. Select [Execute] from the submenu. The program will open both the application the document 
was created in as well as the document itself.  

Color Coding for External Documents: 

Each document will display in a color to indicate it's status. 

▪ Yellow - The document is checked out or new. 

▪ Blue - The document is pending authorization and/or review. 

▪ Green - The document is released. 

▪ Olive Green - The document has expired. If a document is expired when a user attempts to open it or 
print it from a module a warning will appear stating, “The document is not available - it is expired 
and requires review.” 

Search - The External Documents tab in all modules includes the Search button to access the pick list for 
easier navigation through multiple documents. 

Show Revisions - Select this option from the right click menu to view all the revisions of a document. 
Double clicking (or right click and select Execute) on the revision will allow the user to view the 
highlighted revision. 

Print With Work order - When the print with work order option is selected, when a work order for the 
item(s) attached to the workflow is printed, the document(s) set to print with Work Order will also print. 

Other External Document Options: 

▪ Jump to Document Control - The user can jump to the Document Control module by clicking on the 

Launch Document Control speed button . 

▪ Print - Select the Print speed button to print the highlighted document. 

▪ Scan - Select the Scan button to scan a document into a library and associate to the element. 

▪ Filter - Select the Filter Dataset button to filter the documents section. 

Email Correspondence 

This section allows the user to attach Email correspondence related to the CAR or CAPA. To add an Email 
simply drag and drop it from Outlook or other email programs into the form. 

The Received Date will fill in based on the email’s received date and time. A Received Date box surfaces 
if the system is unable to determine the date (such as: the Received and Sent dates differ, unclear binary 
data, or older data, etc.). Users are asked to provide the Received Date by selecting the correct date 
from the calendar. 

The From and Subject fields will also automatically populate with the information from the email. The 
date, from, and subject fields cannot be edited. 
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Comment - A comment can be entered by double clicking the field. Enter the comment in the pop up box 
to further describe the email correspondence. 

There are three ways to access the Email once associated to the CAR or CAPA: 

▪ Double click on either the Received, From, or Subject fields. 

▪ Right click and select View email. 

▪ Or select the View email button. 

Note: If the email has attachments, or multiple attachments, the total attachment size cannot be more 
than 4GB. The size allowance might further be limited by the chosen email program used. In order to 
view emails that have attachments, special formatting (e.g. stationary), or images embedded in the body 
of the email, the user must go into BDE Administrator and set the BLOB SIZE to 1000 for the database 
they are using (i.e. IQORA). 

Note 

To add notes, type directly in the notes field, or click on the Edit Memo button and type conclusion notes 
in the screen that appears. This field can contain up to 2000 characters. 

 

Selecting the Print button at the bottom of the form will print notes. 

Images 

Multiple images can be added to the workflow record on the Images tab. The images will be visible in the 
module only (not the web approval page). 
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Select the insert record button and select the image from the open form. An image can be marked as the 
default by checking the Default box, this will make that image the first to display. A description can be 
added to be displayed below the image. Select the Edit Description button, or right click and select 'Edit 
Description'. A note editing screen will appear to enter up to 255 characters. In cases where the text is 
longer than the display area below the image, the user will need to open the editing window. The image 

can be viewed in full screen mode by selecting the  button, or select Full Screen from the right click 
menu. To exit the full screen mode press the Esc key. Images can be deleted by clicking on the delete 
record button or from the right click menu. Select Replace from the right click menu to replace the 
current image with another one. An image can also be Saved to a File by selecting that option from the 
right click menu. Use the search button to access a pick list of images associated to the workflow record. 

Problem Report tab 
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This section displays the Checklist information associated with the highlighted Element.  If the checklist 
item has been marked critical on the template, a Y will be displayed in the Critical field.  Each checklist 
item is given a status by clicking on the drop down arrow and selecting No, Yes, or N/A.  Yes indicates the 
checklist item is done, No indicates it is not done, and N/A indicates it is not applicable to this specific 
Workflow.  The status can also be filled in from the web approval page.  Checklist items can be added on 
the fly to any element. 

The Response information also appears on this tab. This information is input based on lists created at the 
template level or typed in manually. To select a response from the pick list created on the template click 
on the Lookup Response List button, and a pick list of responses associated with the Element will display. 

Responsible tab 

 

The responsible tab contains the team members responsible for authorization/review of the selected 
element of the Workflow.  To add team members responsible for the element, click on the ADD (+) 
button and select them from the Team Member list.  All team members will be in the pick list. Multiple 
team members can be selected at once using the toggle buttons on the pick list or the Shift and Ctrl 
keyboard buttons. Team Members can also be copied from one element and pasted into another by 
right clicking in the Element section and selecting Copy Responsible and Paste Responsible. There is no 
specific check box in the Team Member module for Workflow. Continue this process until all required 
team members have been added.  New team members can be added to the Team Member pick list by 
clicking on Team Members under Options on the tool bar. 

The fields in the Responsible section of the form are described below: 

# This is the sequential number the team members were added in.  If the sequence 
needs to be adjusted, this number can be changed manually. 

Name This is the Name of the team member. 

Email sent This field populates with the date and time the email was sent notifying the team 
member a workflow needs reviewed/authorized. 
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Type If the type was set up on the template it will fill in automatically. If the type is not 
specified on the template it defaults to Authorize on the Workflow form. If no Type 
is specified on the Workflow form, a message will display stating it is a required 
field. To change it, select from the drop down list and choose either Authorize or 
Review. 

▪ Authorize team members are required to sign off on the approval process. 

▪ Review team members will receive an email notification through the workflow 
process, but are not required to sign off. Note: If all team members are Review, the 
element will not be completed 

Plan Date This is the plan date associated with the Workflow Element and team member, and 
can be used as a due date for the element. Select the date from the drop down 
calendar. 

Sign Off If the team member approves the element and selects Authorize on the web based 
approval page, a Y will automatically be put in this box.  If the team member rejects 
the element, an N will be displayed.  This cannot be filled in manually. 

Sign Off Date This field will automatically fill in with the date the team member accepted or 
rejected the element. 

Email The email address for the team member.  This information comes from the Team 
Member module. 

Title The title of the team member. This information comes from the Team Member 
module. 

Note Users can enter notes in this field under the Responsible tab, or on the web approval 
page.  The notes entered in this field can be unique to each team member. 

Delegate To A Delegate can be associated to a team member with a Days Threshold value.  The 
delegate days threshold will control when a second email is sent to the delegate if 
the original team member did not respond within that time. This will help prevent a 
workflow from stalling because someone is too busy or out of the office for an 
extended period of time without the initiators knowledge. Once the ‘Days 
Threshold’ has passed and the workflow is evaluated, the Delegate is sent an email 
and can log in to approve/deny the workflow. 

Pending 
Authorization Expired 

This will populate with the date/time the pending authorization/review expired 
based on the 'Expire Pending' days set in the Contingency Plan section of the Alert 
action. 

This function will also send an email to the 'Email To' address established on the 
Alert action indicating the pending authorization/review has expired. 

Once the responsible team member approves their element; the line turns green to 
go forward with the next element. The Pending Authorization Expired field remains 
populated. 

Receive Notification If this option is checked, the team member will receive an email when the element is 
completed.  
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Ext Docs Element 

 

In this section the user can attach external documents associated with a specific element.  To attach a 
document, click on the ADD (+) button and select the Document Library and document from the screens 
that appear. If the document is released it will be accessible in read only format from the web based 
approval screen. This tab also includes the options to print and scan as described above. 

Workflow Filter  

To change the filter, click on the Filter button at the top of the Workflow form . A box will appear from 
which the user can select All Customers or One Customer, as well as Open Sales Orders Workflows, 
Closed Sales Orders Workflows, or both. The Filter feature can also be used to filter the pick list when 
searching for a specific Workflow. 
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Access Workflows 

Select the Workflow speed button  to access your pending approvals relevant to the module 
currently opened.The user will be asked to log in and their pending Sales Order Workflow approvals will 
display. Select the record number to access the specific approval summary. 

Evaluate Workflows 

Evaluate Workflow automatically analyzes the status of the element in relation to each team member, 
and determines the action to take.  This is the process that will send email notifications to team 
members that a Workflow element needs to be reviewed/authorized, and through which the element is 
approved or rejected based on the responses of the team members. 

To start the workflow process: 

1 Assign responsible team members.  Be sure to post after adding team members, or workflow will not 
function properly. 

2 Ensure that the Active Box in the Workflow main section is checked. 

3 Evaluate workflows using IQAlert.  

4 The team member(s) will be marked in pending status and email(s) will be sent, according to the 
Workflow type selected, notifying the members that a Workflow Element needs to be 
reviewed/authorized. 
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Note: The Evaluate Workflow and Re-Evaluate Workflow functionality should be set up in IQAlert to 
occur automatically based on a defined schedule. (See the IQAlert documentation for details). Evaluating 
workflow through IQAlert ensures workflow emails are sent to the correct team members in the correct 
order. If the 'Evaluate Workflow' button on the Workflow Approver tab is used instead, workflow emails 
may not be sent to the correct team members and potentially in non-sequential order. 

When using IQAlert to evaluate the workflows, the emails that are sent depends on whether the 
workflow and elements are set to Broadcast or Sequential. The workflow type selected in the main 
section of a module refers to the Elements. The information will be sent either for one element at a time 
(Sequential) or for all elements (Broadcast). A Workflow Type can be associated with each Element. This 
workflow type refers to the Team Members. The information will be sent either for one team member at 
a time (Sequential) or for all team members associated to the element (Broadcast). If the Workflow Type 
field is left blank it will default to Broadcast. 
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Additional Options: 

A Contingency Plan can be set up on the Alert action to indicate the number of days when a pending 
authorization/review is considered expired. The Pending Authorization Expired field in the Responsible 
section of the module will populate with the date and time it was marked expired. An email will be sent 
to the email address set up on the Alert action indicating the workflow authorization is expired and the 
responsible team member. 

Delegate To - A Delegate can be associated to a team member on a template with a Days Threshold 
value. The delegate days threshold will control when a second email is sent to the delegate if the original 
team member did not respond within that time. This will help prevent a workflow from stalling because 
someone is too busy or out of the office for an extended period of time without the initiators knowledge. 
Once the 'Days Threshold' has passed and the workflow is evaluated, the Delegate is sent an email and 
can log in to approve/deny the workflow.  

Both the delegate and the days threshold can be edited for a specific workflow on the Responsible tab. 

Note: If both the Contingency Plan and Delegate options are used, the number of days on the 
Contingency Plan should be greater than the delegate days threshold. 
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Another Alert option is to create an SQL to re-evaluate workflow through an SQL statement which can 
specify the number of days after which team members with pending workflows will be reset.  Then 
subsequent SQL statements to evaluate workflow will send new emails.  The combination of these SQL's 
for Reset and Evaluate Workflow is the equivalent of doing 'Reset for Re-Evaluation' and 'Evaluate 
Workflow' under the Responsible tab in modules that have workflow.  After the Reset SQL statement is 
processed, and before the Evaluate Workflow SQL, if a team member attempts to get to the web 
approval page from an older email, they will receive a message that the approval link is no longer valid. 
Users may pick up the new SQL statement  from MyDELMIAworks in the IQMS Alerts section in Support-
>Files. The file is 'Reset Workflow.zip'. For more information on setting up these alerts please refer to the 
Alert help file. 

Notes:  

Invalid emails (for employees where they no longer are active email addresses in the system) will be 
passed over and the workflow process will continue to the next responsible person or if no responsible 
person is indicated for the remainder of the elements, it will add a completed date to those elements. 
The system records any exceptions in the Event Log under the WORKFLOW ERROR class. 

Evaluating workflow through IQAlert ensures workflow emails are sent to the correct team members in 
the correct order. If the 'Evaluate Workflow' button on the Workflow Approver tab is used instead, 
workflow emails may not be sent to the correct team members and potentially in non-sequential order. 

Duplicate sequence numbers on Elements are allowed which will indicate in the workflow that the 
elements can be done simultaneously (emails will be sent for all elements with the same sequence 
number at the same time). 

If any email is not being sent as expected for evaluate workflow and no error occurs, check to see 
whether the spam filter may be preventing the email from being sent. 

Workflow Emails 

The subject line of the email states the Sales Order number, the Workflow Element description, and the 
team member type (Authorize or Review). 

The email provides a link to the browser.  The browser form is where the Workflow Element is reviewed 
and either accepted or rejected by the team member.  After clicking on the link, the user will be required 
to log into the network in order to access the Workflow review form. 

Once logged in, the user will see the Workflow Summary form: 
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Note: Password Expiration Warning - If the users password will expire within 30 days or less a message 
will appear stating, 'Warning Your password expires in x day(s). You need to change the password before 
the expire date. Would you like to change your password now?' Select ‘Continue’ to go to the workflow 
without changing the password, or select the ‘Change Password’ option to change the password. Users 
do have the option to change their password at any time via the 'Change Password' button at the bottom 
of the workflow web page.  

Workflow Page 

The left side of the Workflow Summary form displays the general information from the Workflow form in 
EnterpriseIQ including the SO #, SO Total, SO Note, and customer. The Details section will display the line 
item information from the SO. This form shows the Notes entered in the Notes field on the main 
workflow form.  If the notes are larger than the display field, they can be viewed in their entirety by 
clicking on the + button. The Response notes entered on the response tab of the Workflow form will also 
display in the lower Note field.  

Team members can jump to the workflow or the Sales Order by selecting the EIQ jump icon  next to 
the corresponding field. Note: This option is only available when using Internet Explorer (IE) with proper 
security levels set. When using another browser or if IE security is not established a message will appear 
stating, 'Unable to continue. Please check Internet Explorer security level. Error message = ActiveX object 
not defined. Note: Other browsers do not support this feature'. The settings for IE require that the server 
URL is added to Internet Explorer Trusted Sites, security must also be set to Low for Trusted Sites to 
enable ActiveX controls, and set security to Low for local intranet, and medium-high for Internet security. 

User Defined Form - Select the User Defined Form button to access the User Defined Form associated 
to the record. A pop up screen will display the information from the form. The information in the fields 
can be edited and changes will be reflected in EIQ.  
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The right side of the summary form has seven tabs: 

▪ Response - Users can input a response by manually typing in the response section or select a 
predefined response from the response lookup list. To select from the Response Lookup list, select 

the  button and the Select Response form will appear.  Enter the response information in the 
'Search for' field, or leave it blank to return all responses, and select the Search button. The results 
will display. Select the desired response by clicking on the Code. The Response text is submitted by 
either clicking on Submit button, saying ‘yes’ the confirmation message, when clicking on another tab 
within the web approval page, or when logging out of the web approval page.  All responses are 
available to other team members from their respective approval pages. The responses entered here 
will also transfer to the main form in EnterpriseIQ. 

▪ Checklist - Select the Checklist tab to view the checklist information along with the status of each 
checklist item in the Value column. To change the status of a checklist item, the user can select a 
value (Y, N, N/A) from the drop down list. If changes are made to the status the user must select the 
Submit Checklist Items button in the Checklist section to process the changes. 

▪ Responsible - Select the Responsible tab to view the list of team members that are also responsible 
for the element. Users can send email to a team member directly from this tab by clicking on the 
team member's email address. 

▪ Documents - Select this tab to view any attached external documents associated with the Workflow, 
attached external documents associated to the specific element, or reports. The reports available are 
those in the reports menu for the specific module. If a team member is a customer or vendor, they 
are limited to viewing the current record only on a report. If the team member is not a customer or 
vendor, the selection criteria form will appear allowing the team member to enter the criteria 
desired for the report. 

▪ Email Correspondence - If Email Correspondence is associated to the record it can be viewed from 
this tab. The tab will list all linked emails with the date received, who it's from, the subject, and the 
comment entered on the Email Correspondence tab in the module. The team member can click on 
the subject and the email will open in a separate pop up window. 

▪ Summary - The Summary tab displays the Element summary information including checklist items 
and responses. 

▪ User Fields - This will display the user field information from the Sales Order. 

Authorize, Reject, or Review: 

Once the team member reviews/edits the checklist and responses, if they are an Authorize type team 
member, they will choose to authorize or reject the Workflow element. If they are a Review type they 
will be able to only select Submit review.  If the team member rejects the element, a note must be 
entered in the Note field. Notes may also be added if the element is accepted. These notes will display 
on the Workflow form in the Note field on the line item associated with the team member. 

Note: If the user hits the back button on the browser and attempts to resubmit a workflow that has 
already been denied or approved, the user will receive an error: "There was an error processing your 
request. This element was already denied/approved on mm/dd/yy". 
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Once a team member has authorized/reviewed the Workflow element and submitted their response, the 
fields in the Response section of the Workflow form will populate with the new information such as 
Signoff (Y or N), Signoff Date, and Notes. The team member ID that approved the element is stored in 
the WF_RESPONSIBILITY table (in SIGNOFF_TEAM_MEMBER_ID). This will populate with the team 
member ID of the user actually approving or rejecting the workflow element, including a delegate team 
member. If an element is re-wound and approved or rejected again, the value is re-written in the new 
column.  

The text will also be color coded to visually show the status of the team member.  The color codes are as 
follows: 

▪ Green - The team member has approved the element. 

▪ Red - The team member has rejected the element. 

▪ Blue - A response is pending. The team member has been notified that an element needs to be 
reviewed, but has not yet replied. 

▪ Black - The workflow has not been processed for the team member. 

If the Electronic Signature option is selected when the team member clicks on the Submit button, the 
team member will be asked to enter their user name and password for the electronic signature. 
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To enable this feature, check the 'Enable electronic signature sign off' in Sys Setup->System Parameters-
>Company File Information->Application tab. This is a global setting. 

Completing a Workflow 

Once an element has been approved by all Authorize type team members, the completion date will fill in 
automatically after the workflow is evaluated again. The team member ID that approved the element is 
stored in the WF_RESPONSIBILITY table (in SIGNOFF_TEAM_MEMBER_ID). This will populate with the 
team member ID of the user actually approving or rejecting the workflow element, including a delegate 
team member. If an element is re-wound and approved or rejected again, the value is re-written in the 
new column. An email will be sent to the Initiator and to team members that have the Receive 
Notification option checked when an element is completed. This check box is on the Responsible tab of 
each module. 

Note: Review type team members can still access the workflow and submit their review after the 
element has been approved. The workflow will display this message "This element is closed, but has not 
been reviewed". 

Rejected Elements 

When an element is rejected, all users on the Responsible tab for the element set as 'Authorizer' will 
receive notification of the rejection, in addition to the user in the Initiator field. The email will include the 
record, element information, reason for rejection, and the authorizer that rejected the element.  

 My Pending Approvals - This button will appear in the blue bar at the top of the web approval page. 
When the user mouses over the button, the hint will display the number of pending approvals they have. 
Click on the button to view the Pending Approval List. 
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From this screen the user can select an item to review by clicking on the link. 

Completing the Workflow 

Once all team members have approved the element select the Evaluate Workflow button again and the 
Complete Date field will fill in automatically for the element. Once an Element has been completed the 
Required Date cannot be changed. When the sales order workflow is approved the Workflow Initiator 
will get an email sent to them letting them know the sales order is approved, and the 'Approved' 
checkbox on the sales order will be checked. 

Access Workflow from Responsible tab - The Responsible tab will have an Approve Workflow speed 
button which enables team members to access the web based approval page for that specific record. 
Once the evaluate workflow process has begun this button will be enabled. Highlight your team member 

name and select the Approve speed button . The web based approval page for the specific element 
will appear to authorize/review or reject. 

Reset Element for Re-Evaluation 

If an element has been rejected, the user can select the Reset for Re-Evaluation option  to reset the 
workflow for the element.  Once reset, the element can be evaluated again using the Workflow function.  
The email notification that the team members receive has a submission counter to indicate the number 
of times an element has been evaluated. 

Clicking directly on the Reset for Re-Evaluation button will reset the workflow only for the selected team 
member that rejected the element.  This can also be done by clicking on the drop down arrow next to 
the Reset for Re-Evaluation speed button, and choosing Reset This Rejected for Re-Evaluation. 

To reset the workflow for all team members for the element, click on the drop down arrow next to the 
Reset for Re-Evaluation speed button, and choose Reset All Records for Re-Evaluation. 
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Editing a Sales Order 

Orders can be edited to reflect any changes or corrections to the original order, including changes or 
additions to delivery dates and associated quantities. Be sure not to delete dates for shipments that have 
already been made. If a user attempts to delete a release that has been shipped in full, a warning 
message will appear. EnterpriseIQ needs to know past delivery dates and quantities to determine which 
delivery needs to be shipped next. Because EnterpriseIQ tracks this order via the PO and item number, 
complete shipment history must be maintained. 

 

Please keep in mind changes to quantities and dates will adjust generated work orders. If using the Firm 
work order technology please see the Date and Quantity Change section in the Firm Work Orders section 
for more information. 

Selecting an order for editing is similar to adding an order. Any field may be altered to match changes to 
the original order except the item number. 

Version Control 

If a change is made and posted to a Sales Order, upon exiting the user will be prompted “Is this a Sales 
Order revision?” Security is available on the Yes and No buttons, and there is a 'Do not show next time' 
check box option. If No is selected, the Rev field will not increment. If Yes is selected, a pop up box will 
appear where the user can enter a Reason and Note about the revision change. To enter the reason, 
select from the user defined list or manually type in the reason field. If desired, type a Note to further 
describe the reason for the revision. 
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This information can be viewed by selecting Version Control from the Options menu. The Version Control 
form displays the revision number, along with who made the change, and the date and time that the 
order was changed. If the 'Enable Revision History' option is checked users can select the 'Revision 
History' button to access the revision history. 

 

From the Sales Order Revision History form users can select a date range to view the history for. Enter a 
From and To Date using the drop down calendars in the fields and then select the 'Apply Filter' button. 
The results will appear on the right. Click on the 'Clear Filter' button to clear the date range filter and 
view the history for all dates. 
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The right click 'Trace' option can also be used to review what has been changed on a sales order. 

Notes:  

When attempting to change a release quantity or a release ship to address on a sales order after the 
release has been assigned to a pick ticket, the user will  receive an authorization required message: “Pick 
Ticket exists for this release.” Select the OK button to continue or cancel to not change the release.  
Note, this warning will only appear if the release quantity is changed not if any other fields associated to 
the release are changed. The pick ticket associated to the release can be accessed from the 
Authorization Required message form by right clicking and selecting Jump to Pick Ticket. 

When attempting to delete a release on a sales order that has been partially shipped, the user will  
receive an authorization required message: “Release partially shipped, Continue?” Select the Yes button 
to continue or No to not delete the release. There is also a 'Do not show next time' option that can be 
selected so that the warning does not show. 

For users licensed for 'Advanced WMS': If a sales order release that is associated to a Sales Order Picking 
Wave is changed a Status Exception stating that a wave exists for the release will display. If the user 
selects OK, the release on the wave is updated (including those on a ‘locked’ group). If the release was 
deleted and the user selects OK, the release will be removed from the wave and any associated groups 
(including ‘locked’ groups). If the user selects Cancel, the system will display ‘Status exception has not 
been authorized – unable to proceed.’ and the it will not update the SO release quantity.   

When the Ship To address is changed on a sales order, and that Ship To is assigned a different tax code 
or salesperson(s), a message  will pop up, indicating that the 'Ship to Address has changed to a different 
tax code or salesperson(s). Update order details to new tax code?'. Select Yes to update the order details 
with the new tax code or No to not make the changes to the line items. It also has the 'Do not show next 
time' feature. If the Ship To Salesperson(s) is null and/or Tax is null, but not at the Customer level, the 
information will pull from the Customer.   

If a sales order has a pick ticket created for it, if a user attempts to change the Ship To address a status 
exception will display stating, 'Pick ticket exists for this sales order'. If the user clicks on ‘OK’ the change 
of the ship to address proceeds. If the user clicks on ‘Cancel’ another message states not authorized 
unable to proceed and the ship to address does not change. 

When attempting to delete a line item that has been shipped the system surfaces a warning 'Cannot 
delete a shipped item.' 

When changing the Blanket Quantity a confirm message will appear stating, "The blanket quantity has 
changed. Update the unit price?" Users can select Yes to update the unit price based on the new blanket 
quantity, or No to not change it. There is also a 'Do not show next time' check box that when checked 
the confirm message will no longer display. 
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Editing 'Cash in Advance' Sales Orders - Once the AR invoice associated to the sales order is posted, edits 
are not allowed to any fields except the Release Request and Promise Dates. If a user attempts to modify 
any other field on the sales order a message is surfaced, 'Invoice exists against this CIA order, cannot 
modify or delete.' The user can only select OK to exit out of message and cannot proceed with any 
changes. To make changes to the sales order the invoice must be voided first. Voiding the Invoice creates 
the reverse GL entry. Once the Cash Receipt for the quick invoice created from the Sales Order is 
received and posted, the item(s) on the sales order can be shipped. The sales order is not completely 
locked down at this point as it is prior to the cash receipt being posted. Users may not add or delete 
additional lines, or edit the blanket quantity, but they are able to modify releases. Releases can only be 
generated if the Blanket Qty >= Release Quantity. If the release quantity exceeds the blanket quantity 
the user will receive an error. (See Cash in Advance Invoicing for details). 

If a change is made to a sales order and the user attempts to close the form prior to posting the edit a 
confirm message will appear stating: "Save changes?".  
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Deleting / Archiving a Sales Order 

Archiving an order is normally done when the order’s delivery requirements have been met. This can be 
done from the sales order module or if enabled, the system will prompt the user to archive the sales 
order from the packing slip module if the blanket quantity of each line item has been shipped in full or is 
within the designated “Short Within%” (System Parameters->Purchase Order and Sales Order Setup). To 
enable the packing slip feature go to Options on the main menu bar in the Packing Slip module and be 
sure the ‘Do not allow sales order archive during creation of packing slip’ option is not checked. 

➢ Deleting / Archiving a single Sales Order from the sales order module: 

A single sales order may be deleted by selecting the Delete [-] function key or by selecting File->Delete or 

Archive-> Delete or Archive This Sales Order. You are given three options: 

▪ Delete - Selecting this function will delete the record entirely. This option is not available if the order 
has shipments associated to it, or if there are any other links made to the sales order such as CRM 
Service Labor. If the sales order is deleted the action is then written to the Event Log (OE Class) which 
shows the order number that was deleted, who deleted it, along with the date and time it was 
deleted. 

▪ Delete & Archive - This closes the order and places it in a history file. Orders may not be reopened 
once this feature has been selected (however, they can be cloned). When archiving a sales order any 
associated Internal and External documents will remain attached. 

▪ Cancel - Will not delete the order. Takes the user back to the main entry screen. 

Attempting to delete a sales order that has a MTO link to an open work order will display a ‘Status 
Exception - Authorization Required’ warning. If the user selects OK to delete/archive the sales order, the 
link to the MTO work order will be broken 

➢ Archiving multiple Sales Orders from the sales order module: 

Sales Orders can be archived in batches by selecting File->Delete or Archive-> Archive Batch of Sales 

Orders... from the sales order module, or from the IQArchiver module on the System Setup tab. A pop up 
form will appear where the user can select the 'Exclude Orders Shipped After' option and enter a date in 
the Last Ship Date field (manually type the date or select it from the drop down calendar). This will 
exclude any orders shipped after the entered date. Select cancel to return to the archive batch screen 
with no records marked.  Select OK to continue and the system will evaluate which sales orders can be 
archived. This is based on the shipped after date if applicable, and if the blanket quantity of each line 
item has been shipped in full or is within the designated “Short Within%” set in System Parameters-
>Purchase order and Sales Order Setup. A message will appear: ‘Finished marking orders that are fully 
shipped or short within x.xx%. Number of orders marked: xx’. A screen will also appear with the sales 
orders to be archived marked in blue: 
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The sales order(s) the system has marked will also have the ‘Can Be Archived’ box checked. This box is 
read only and cannot be manually checked. The user can de-select orders or select other orders by 
manually highlighting the desired orders using the toggle buttons or keyboard. Once the user manually 
makes a change to this form all of the orders the system automatically marked will no longer be marked 
blue. To have the system re-evaluate the sales orders the user can select the ‘Mark orders shipped in full 

or short within x%’ button  to automatically remark the orders that can be archived. Selecting this 
option will also bring up the 'Exclude Orders Shipped After' date option. Once the desired orders are 
marked select OK. A warning will appear: ‘About to archive and delete xx sales orders. Please confirm to 
continue’. Select Yes to continue and all of the selected orders will be archived and the form will close. 

Authorization Required Status Exceptions: 

If a work order associated to the sales order is scheduled to run on a work center an ‘Authorization 
Required’ box will appear requiring the user to select OK to continue or Cancel to not archive the sales 
order. Depending on the user’s security they may not be able to select OK to continue archiving the 
order. 

If the order is shipped in full but the work order is still on the schedule the user will continue to get this 
exception until update schedule is run, which removes the work order's association to the sales order. 

If the sales order item is on a pick ticket the user will receive a status exception stating, 'Order line is on 
the pick ticket',  The user can select OK to continue or Cancel to not archive the sales order. Depending 
on the user’s security they may not be able to select OK to continue archiving the order. 

The user can right click from this form and select ‘Jump to Sales Order’ to view the sales order prior to 
making a decision to archive it. 

Note: When data is archived it is moved from one table to another such as orders to hist orders. The 
data is moved but it does not free up any space in the table it was moved from (there is still a high 
watermark). So the tables must be compressed which removes the watermark. In order to compress the 
files an IQAlert should be set up to perform this compression during low traffic times. To compress Order 
Entry (OE) tables please use: 

begin iqcompress.do_execute_ex('RELEASES;ORD_DETAIL;ORDERS'); end; 
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Archived Sales Orders 

View Archived Sales Orders 

Archived Sales Orders can be viewed by selecting the speed button  or from the File|View Archived 

Orders menu option. The form displays the information from the original open sales order including user 
fields, blanket and release quantities, pricing and UOM. 

 

Note: The Unit Price field in the Total Releases section is a read only field that displays the price of the 
item at the time the release was added to the Sales Order. This field only displays on the archived sales 
order.    

Archived Sales Orders Options: 

Quick Order Entry (No Releases) - Select this toggle option from the Options menu to change the 
archived sales order form to the quick order entry format.  
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Clone Order - Closed orders can be cloned, essentially allowing closed orders to be re-opened. All of 
the basic information from the original order is transferred to a new order, including documents. This 
includes customer bill and ship to, PO, line items, etc. The only information not cloned is the release 
dates and quantities, or for Quick Order Entry orders, the delivery date is not cloned.  When a sales 
order is cloned, the Taken By field is populated with the user that is doing the cloning and not the 
original user. A new order number is assigned to the cloned order. If the archived sales order 
included drop ship items, the user will be prompted to select an existing PO or create a new one just 
like when creating a new Drop Ship sales order. 

Sales Order Extended Note - Select the Sales Order Extended Note speed button to view the extended 
note. 

View Order Notes - Select the View Order Notes speed button to view the internal and external 
documents and email correspondence associated to the archived sales order. When in this screen, 
select the Order Information button to return to viewing the archived order. 

Enable Customer Filter - Select the 'Enable Customer Filter' box to allow filtering based on a specific 
customer. If the Enable box is checked the user can select the Filter speed button to choose a specific 
customer. Once the customer is selected when the navigation buttons are used only archived sales 
orders associated to that customer will display. This setting also affects the archived sales orders pick 
list. When checked the pick list will be filtered based on the customer selected when opening the 
module. If is is not checked, all archived sales orders will display in the pick list. This setting is 
remembered in the registry. This setting does not affect the 'Search Archived Orders' pick list 
accessed from the drop down search menu in Sales Orders. Note: When selecting 'View Archived 
Order' from the Sales Order File menu and selecting a customer from the pick list, if 'Enable 
Customer Filter' within Archived Orders form is not checked, the archived sales order that opens is 
not for the customer selected (it is the first record in the database). If 'Enable Customer Filter' is 
checked, the selected customer/order displays.  

UnArchive SOs - Select this option from the File menu to restore SOs to an open state. Select this 
option and then enter a date range to view SOs by. Highlight the SOs to be un-archived using the 
toggle buttons or the Ctrl and Shift buttons on the key board. Select the UnArchive button. The 
selected SOs will return to the open SO pick list exactly as they were when they were archived. Note: 
If the Ship To listed on the Archived Sales Order has been deleted and the Sales Order is then 
unarchived, the Ship To section will be blank. 
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Note: When using Price Books, if the price books have not changed the system will populate the original 
price book and price type, and the actual sales order price will come over as is, with no update. If the 
price book or price type is not the same a warning will display stating: "Order # xxx has one or more price 
book or price type mismatches in its order details, please investigate to ensure correct pricing". The 
system will  assign the same price from the archived order and set the book/type to null.  For example, 
the warning will appear if the price type is manually changed before archiving, a price book assigned to 
the customer or ship to is deleted after archiving, or a price type assigned to the customer or ship to is 
deleted after archiving. The system will not attempt to grab current price book/type or pricing on 
unarchive. 

 

 
Trace - Right click in any section to view the Trace information for that section. 

Middle Section Right Click options: 

Shipments - Right click and select Shipments to view the shipment detail for the archived sales order. 

Jump to Inventory - Jumps the user to the highlighted inventory item. 

Cost Source - Right click and select Cost Source to view the cost source information if any. The cost 
source information can be added, changed, or unassigned. 

Campaign Code - This enables users to associate or un-associate an item on an archived sales order to 
a CRM Campaign. Click on Select and select the campaign from the pick list.  Click on Clear to remove 
the campaign link from the item. 

Jump to Campaign - If an item is linked to a Campaign this option will be visible. Select this option to 
jump to the Campaign Management record. 

Commissions - Right click and select Commissions to view the commission information for the 
archived sales order. This information cannot be changed. 

View Captured EDI Segments - Right click to view the EDI Segments. 

Tax - Right click and select Show Detail Taxes to view the tax breakdown for the highlighted item. 
Select Show All Taxes to view the tax breakdown for the entire order. 

Trace - This allows users to trace changes. This option is also available in the lower releases section. 
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Sales Order Main Menu Bar Functions 

Under File, the following functions are available: 

▪ New - Creates a new order. Orders can also be created using the ADD [+] function key located on the 
Navigator bar. 

▪ Delete or Archive - Selecting Delete deletes the record entirely. This action is written to the event log. 
Selecting Delete/Archive closes the order and places it in a history file. Archived orders can be 
unarchived or cloned. Selecting Archive Batch of Sales Orders... allows the user to archive multiple 
sales orders at once. 

▪ Clone Sales Order - This option will clone an open sales order. See Clone Sales Order for details. 

▪ Add Line Item or Delete Line Item - This feature will add or delete a line item in the middle section of 
the form. 

▪ Approval  Templates and Team - Access to the workflow team and templates. See Sales Order 
Workflow Approval for more information. 

▪ Toggle Grid/Form - Toggles to Grid or Form View. 

▪ Search - Displays the Sales Order pick list. (Note: If a user is assigned CRM Customer Access in 
security inspector, when accessing the Sales Orders pick list, the customer name field will be blank 
for records that have customers that are NOT assigned to the user). 

▪ Credit Card Charge - This will open the Credit Card Charge screen to charge this sales order. 

▪ View Archived Orders - EnterpriseIQ maintains closed sales orders in the Archived orders table. You 
can view these orders from the File|View Archived Orders menu option. 

Under Options on the main sales order form, the following functions are available: 

▪ Quick Order Entry (No Releases)  - Select this to enable the Quick Order Entry functionality. See Quick 
Order Entry. 

▪ Pick On Hand Inventory to Ship - If the Quick Order Entry option is selected, this option will 
become available. When this option is checked, instead of just entering the quantity in the field, 
users will select the location(s) to be used to fill the order.  
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▪ Create Quick Invoice for this Order - Invoices the entire sales order. (Note: When creating a quick 
invoice the user will be prompted to archive the sales order, or if it is scheduled to run a Status 
Exception will appear. Select OK to archive the sales order or select Cancel to not archive it). 

▪ Create Packing Slip - Creates a packing slip for this order without having to leave the order entry 
module. 

▪ Create Pick Ticket - Creates a Pick Ticket for the order without having to leave the order entry 
module. 

▪ Customer Status - View the status of the customer by selecting this function. Find out their credit 
limit, if they’re on hold, etc. 

▪ Mark All New Line Items on Hold - When this option is checked all newly added items will be marked 
on hold. An 'Unmark All Items On Hold' speed button will become visible in the sales order header 
toolbar which can be clicked on to unmark the on hold check box for all the item on the sales order. 

▪ Mark All Items On Hold - Select this option to mark all of the line items on the sales order ' On Hold'. 

▪ UnMark All Items On Hold - Select this option to un-mark all of the line items on the sales order from 
being On Hold. 

▪ Multi-Currency - If you are using Multi-Currency, this feature will bring a form to view the line item’s 
Unit Price and Total Price in the different currencies you are using. 

▪ Tax Codes - Set up Tax Codes and Tax Code Elements from this screen. 

▪ Salespeople - The Salesperson(s) list is used to assign commissions. Commissions are paid to both 
employees and non-employees (consultants, manufacturers reps, etc.). This form determines how 
the person is to be paid - either through the Payroll module or via the Vendor Accounts Payable 
system. 

▪ Terms - Select this option to add, edit, or view existing terms. 

▪ FOB - Select this option to add, edit, or view existing FOB methods. 

▪ Rebate Parameters - Accesses the Rebate Parameters pick list, see Rebate Parameters for details. 

▪ Sales Order Miscellaneous List - Opens the sales Order Miscellaneous Item pick list. See Sales Order 
Miscellaneous Items List. 

▪ Pending EDI’s & Create EDI file (855) & (865) - If you are using the electronic data interchange module 
these features are available from this menu. 

▪ Enable quick invoice option for shipped orders - This is a toggle on or off to allow quick invoices to be 
created for shipped orders. 

▪ Manual Shipped Quantity Adjustment - See Manual shipped qty adjustment for more information. 

▪ Version Control - If a change is made to the sales order, select this function to view how many times 
the order has changed, the date and time the order was changed, and who made the change. The 
form will not show what was changed on the order. See Editing a Sales Order for more information. 
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▪ Calculate Aggregate Discount - This function is used to calculate the discount price for items that 
use the aggregate tier pricing structure or the Product Code volume discounts. This option is also 
available by clicking on the calculator speed button in the Sales Order->Item Details section. 
Aggregate pricing looks at all releases and combines like items together based on the first release 
date. If the first release date on several items is the same date, the aggregate pricing calculation will 
sum the quantity and then look into the tier pricing table and apply discount into the price column. 
The list price column will remain as the list price. The Product Code volume discounts option 
combines items with the same product code and adjusts the price based on the volume of like 
products ordered. The method of discounting is set up on the 'Purchase Order and Sales Order Setup' 
tab in System Parameters. Users can select: 'Tiers Discount', 'Product Code', or 'Product Code/AKA 
Pricing/Price Book' in the 'Calculate aggregate pricing method based on' field. (Please see the 
Discount Pricing section in the Inventory section for more information).  

▪ Model Year Cumulative Reset  - See the Model Year Cumulative Reset section below for details. 
 

Model Year Cumulative Reset 

This function allows users to automatically reset the cumulative quantity for all or specific orders 
for a customer. This option can also be selected from the button on the Sales/Dist tab. 
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▪ The top grid (Customers) displays a list of Customers. 

▪ The middle grid (Ship To’s) displays the ship to addresses of the Customer highlighted in the grid 
above. 

▪ The bottom grid (Orders) displays the sales orders for the corresponding Ship to for the Customer. 

You may select multiple customers and select/unselect specific ship to's and sales orders for that 
customer. Once you have selected the customer(s), drag your selection to the grid to the right. This will 
display a tree to show what is selected for cumulative reset processing. 

When you right click from the Available to Process grid, you can delete a node from the tree. The node 
you delete will not be processed during the cumulative reset process. 

Resetting the Cumulative Quantity 

➢ Select the customer to reset the cumulative quantity for and drag this selection to the 

Available to Process grid. 

➢ Choose a 'Cumulative Reset date' by using the drop down and choosing a date from the 
calendar. 

➢ Click on File and choose Process. You can also use the speed button at the top of the form. 

The system will do the following: 

1 Calculate the quantity shipped since (and including) the cumulative reset date. 

2 Create a manual cumulative shipped adjustment to the original order for this amount. 

3 Create a new order with the next sequential order number. 

4 Transfer the releases with the delivery date >= the cumulative reset date to the new order. 

5 Create a manual ship adjustment for the new order equal to the quantity in step 1. 

6 Archive the old order. 

Note: If the Order selected for processing has an open pending Pick Ticket, when the order is moved to 
“Available to Process” node, an Authorization Required exception dialog will pop-up showing the Ticket 
#, Line #, and Status indicating the Order # is on the pick ticket. If OK is selected on the exception, once 
all the selected orders are added to the list, it will be processed and the pick ticket detail(s) will be 
deleted. Pressing Cancel brings user back to the Cumulative Reset form.  
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Clone Sales Order 
This option will clone an open sales order. All header fields will be cloned including the PO # and date, 
however the Taken By field will be populated with the user that cloned the order, and not the user from 
the original order. The Date (Date_Taken) field will be populated with the system date. All items will be 
added to the middle section. Note: The Revision field in Version Control will also be cloned but the 
Version Control field will not. 

Clone Releases - Check this option to clone the releases. If it is not checked no releases are added to the 
new sales order. 

Clone Documents - Internal, External or Email Correspondence can be cloned by checking the boxes next 
to the options on the pop up form. 

Use Current Terms  - If this is checked the system will use the terms associated to the customer. If it is not 
checked, the terms will be cloned from the original sales order. 

 

Note: An open sales order with Drop Ship items on it cannot be cloned. The user will receive an error. 
 

Manual Shipped Quantity Adjustment 
This is used to adjust the cumulative ship quantity for a new Sales Order. Enter the quantity that has 
already been shipped and a comment if desired. (The Comment field is Shipments.Ship_To_Note). 
Complete the Sales Order (i.e. total blanket quantity and the individual releases). The Left To Ship and 
the Quantity Shipped amounts will be reflected by the amount entered here. 

Note: If the ‘Match RAN releases to shipments’ option in Customer Maintenance->Ship To->EDI tab is 
checked for the ship to address this option cannot be used. If attempted the user will receive an error 
stating, "General SQL error. ORA-20500: Shipments are matched to sales order releases based on RAN. 
Unknown sales order release ID - unable to update packslip." 

Note: This type of shipment adjustment is not included in the RMA shipments pick list . 
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Sales Order Speed Button Functions 

Orders Pick list 

 Search for a particular order or create a new order from this screen. The pick list incorporates the 
ability to sort information on the screen in over a dozen different ways including the six sales order user 
text fields. Select the drop down arrow next to the search button to search archived sales orders. (Note: 
Users will not see the system generated 'INTERNAL STOCK' Auto MRP sales order in the pick list. This is to 
prevent users from accidentally deleting records. Jumps to the Sales Order and navigation to the sales 
order within the module are still available). Note: The Archived Orders pick list, accessed via the 
binocular speed button on the Archived Order screen, will display all Archived Orders which contain line 
item details. If a sales order without line item details was archived, users will need to toggle the Archived 
Sales Orders screen to table/grid view and select the empty order here, rather than via the pick list. 

Toggle Grid/Form 

The Form view / Table view function allows the user to toggle between two different screens as 
discussed below. Not all fields are available in both views. Refer to the bottom of the Sales Order Header 
Section for details. 

▪ Form view shows all fields for a single customer record and limits viewing to only one entry at a time 
along with all related data. 

▪ Table view on the other hand, allows the user to see all orders on file at a glance. Notice that as you 
scroll down through this list or highlight a particular order, item and delivery information pertaining 
to that order is displayed in the lower window. 

Create a “Quick Invoice” From Sales Order 

 This function allows the user to immediately create an invoice for items needing to ship that day or 
for special orders. If a quick invoice was already created and/or posted from the sales order the user will 
receive a warning message, "One or more items have already been posted or added to the prepost table 
and could not be transferred." After selecting the OK button on the message, a new invoice will be 
created bringing in any line item(s) from the order that were not already on an AR Invoice. If all line 
items on the order were on one or multiple invoices, a new invoice will still be created but no items will 
appear on the invoice.  See Creating A Quick Invoice from a Sales Order for more information. 

View Archived Sales Orders 

 Use this function to access archived sales orders.  

Check Customer Status 

 The customer’s account status can be quickly accessed by selecting this function. The status shows 
the customer’s credit limit, outstanding balance, open invoices, as well as an account aging. 

Create Packing Slip 
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 The Create Packing Slip function allows the user to create a packing slip right from the sales order 
without having to exit the screen and open the Packing Slip module. If the Quick Order Entry and Pick On 
Hand Inventory to Ship options are selected, users can select 'Multiple Pack Slips by Division' from the 
drop down on the Create Packing Slip speed button, and the system will create a Packing Slip for each 
Division represented in the sales order detail line items. A Generated Shipments form will appear listing 
the packing slips. Users can right click to jump to a packing slip from this form. (See Creating a Packing 
Slip From a Sales Order for more information). 

Create Pick Ticket(s) 

 Select this button to create pick ticket(s). See Create Pick Ticket from Sales Orders below for 
details. 

Create/Jump Sales Order Picking Wave  

 This option is available for users with the Advanced WMS license. This will create or jump to the Sales 
Order Picking Wave module. Please refer to the Advanced WMS https://my.iqms.com/cfs-
file.ashx/__key/Technote/advanced_2D00_wms.pdf documentation for details. 

Create EDI File 

 This button is available for EDI Users to create an 855 or 865 from the sales order. This will be 
available if the customer or the ship to is set up in the Trading Partner Profile. 

Print Sales Order Report or Order Acknowledgment Report 

 Select this button to print the Sales Order or a range of sales orders. Select the arrow next to this 
button and choose from 'Print Order Acknowledgment Report', or 'Print Sales Order and 
Acknowledgment'. When printing the Order Acknowledgement report there is an option on the Print 
form called 'Mark Releases 'Acknowledged' When Printed'. When this is checked and the order 
acknowledgement is printed, the 'Acknowledged' check boxes on the releases will be checked. The 
EPlant the user is logged into will populate the EPlant field and will be used as report criteria.  If the user 
is logged in as View All, the EPlant can be specified by clicking on the button in the field and choosing a 
specific EPlant from the pop up form. For non-EPlant users this field will not display. Note: When no 
printing options are selected while printing order acknowledgments, the order acknowledgments will be 
printed and records will be written to the Auto Eform table and folder. 

Extended Comment 

 Select this button to access the extended comment associated to the sales order. This is the 
orders.EXT_COMMENT1 field. 

Scan 

https://my.iqms.com/cfs-file.ashx/__key/Technote/advanced_2D00_wms.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/advanced_2D00_wms.pdf
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 Select this button to access the Scan Document module. The scanned document is added to the 
External Documents tab on the sales order with the Print With option defaulting to 'None'. From the 
Scan Document module verify the file name and enter the desired color information using the drop 
down list in the 'Scan As' field. Indicate whether it is a single scan or multiple pages. When Multiple 
Pages is checked either select the User Page Count option and specify the correct number of pages that 
are going to be scanned; or for large projects where the user does not want to count all of the pages, 
select the Use Time Out (Sec) and enter the number of seconds the scanning function will time out. The 
Scan Mode feature is used to tell the system to scan both sides of a document. After the document is 
scanned a pop up form will appear to enter an Extended Comment if desired. This populates the 
ORDERS.EXT_COMMENT1 field and can be viewed by clicking the Extended Comment button or added to 
reports. (Note: Users must have a TWAIN compatible scanner, they must have the twain_32.dll installed 
on the local workstation and/or in the user profile\windows folder).  

Attached Credit Card 

 This button will display the Attached Credit Card form from which the user can select a card to 
associate with the sales order, add a new card associated to the customer, or clear an associated card. 
This information will be carried over to the AR Invoice. 

Charge Credit Card 

 This option will bring up the Charge form to process the credit card transaction for the specific sales 
order. 

(Please see the Credit Card documentation for more information).  

CRM Activities 

 - This allows users licensed for CRM to create a CRM activity from a sales order. Select the drop 
down arrow and choose Schedule a Call, Meeting, or Task. Select the button to the right to create a CRM 
Note activity. When one of the options are selected, the system will bring up the appropriate form and 
under Attached Source Documents, it will automatically add the Sales Order. The Principal and Contact 
will populate based on the Customer and Contact associated to the sales order. 
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Workflow 

 Select this button to create a Sales Order approval workflow. See Sales Order Workflow Approval for 
more information. 

Validate Address  

 Addresses associated to sales orders can be verified to ensure they are valid for use with the Avalara 
Tax Web Services when calculating taxes. If the address is valid a confirm message will appear stating,' 
Address Validated'. If the address is validated but there are suggested formatting changes a form will 
appear and users may make the suggested changes. If the address is incomplete a form will appear 
highlighting in red the field(s) that needs to be corrected.  If the selected address validation service 
cannot find a close enough match, it may return the originally entered address (depending on the 
service), but the field(s) will be highlighted in red to inform the user that changes may need to be made.  
(UPS and USPS will return the original address where FedEx will return a Null value.) Please see Address 
Validation for more information. See the Address Validation section for more information. 

EIQ Bookmark for Sales Orders 

This option allows the user to drag and drop the icon onto the desktop or a folder in order to open the 

exact Sales Order up again with one click. Select the  EIQ Bookmark button then drag it to the 
desktop or folder and drop it. The shortcut will be named SALESORDER_id#.eiq by default. 
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Create Pick Ticket from Sales Orders 

 The Create Pick Ticket function allows the user to create Pick Tickets from the sales order. There 
are two options available from the speed button: 'Create Pick Ticket' or 'Create Pick Ticket This Sales 
Order Only'. When the latter option is selected this will create a pick ticket for only those items on the 
sales order the user is on. It will not create a pick ticket for items that are on ship hold. An error will 
appear if the system cannot create a pick ticket for one of the following reasons: Either there are no 
outstanding releases available for the shipment, Ship To address is not assigned, the item is on ship hold, 
or a pick ticket already exists for these releases. 

If the 'Create Pick Ticket' option is selected the system will create pick tickets for all sales orders 
associated to the customer on the current order based on the parameter settings in the pick ticket 
module. If pick ticket creation is based on inventory availability pick tickets will be created for just the 
items that are available to ship from all orders associated to the customer. (Items that are not available 
to ship will not be added to a pick ticket).  

The system will create a separate pick ticket based on the customer's Packing Slip setting (Customer 
Maintenance->Miscellaneous tab) for each sales order unless the 'One pick ticket per customer' pick 
ticket parameter is checked. If the customer does not have either packing slip option selected then only 
one pick ticket will be created even if the 'One pick ticket per customer' pick ticket parameter is not 
checked.  

The system also considers Ship Via's: When the 'Create Pick Ticket' option is selected, the system will 
look at all sales orders for the customer and determine the number of unique Ship Via's. One pick ticket 
is created per unique SO/PO (if applicable) and per unique Ship Via. If a release Ship Via is null then the 
release will populate on the pick ticket with the header ship via. If a Ship Via is assigned to a release a 
separate pick ticket will be created for the release with that ship via. If the sales order header Ship Via is 
null  and the releases do not have a ship via then the pick ticket is created with a null Ship Via.  

Example Scenarios: 

The customer has ‘One SO per packing slip’ or ‘One PO per packing slip’ checked. 

▪ Scenario 1: 'One pick ticket per customer' option IS checked; three sales orders all with the same ship 
via in the sales order header: Result - one pick ticket, all the same ship via. 

▪ Scenario 2: 'One pick ticket per customer' option NOT checked; three sales orders (different POs) all 
with the same ship via in the sales order header: Result - three pick tickets, all the same ship via. 

▪ Scenario 3: 'One pick ticket per customer' option IS checked; Four sales orders, three with the same 
header ship via, but one has a specific release ship via for the one item on the sales order, and one 
sales order with a different header ship via: Result - three pick tickets, one for the sales orders with 
the same header ship via, one for the sales order with the unique ship via, and one for the unique 
release ship via. 

▪ Scenario 4: 'One pick ticket per customer' option NOT checked; Four sales orders, three with the 
same header ship via, but one has a specific release ship via for the one item on the sales order, and 
one sales order with a different header ship via: Result - four pick tickets, one for each unique SO/PO 
based on their header ship via, and one for the specific release ship via.  

Note: When the 'Create Pick Ticket This Sales Order Only' option is selected, the system will only create 
pick tickets for the current sales order based on unique Ship Via's. 
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Note: The user can control the items assigned to a pick ticket by utilizing the Dock ID field in the middle 
section of the sales order. If the 'Use Dock ID' on the customer ship to address is checked, this ship to 
address will automatically create a pick ticket for each different Dock ID from the sales order. Only like 
Dock ID's will be combined on one pick ticket. 

Note: The system cannot create pick ticket if there are no outstanding releases available for the 
shipment, the Ship To address is not assigned, or a pick ticket already exists for these releases. An error 
will be displayed stating this. 

Note: If the order/release selected is a Forecast release and it is within the ship date specified, a warning 
will appear stating that the forecast release must be authorized to proceed. This warning will also appear 
if the ‘select all’ option is used. 

Note: If a Pick Ticket is created from a sales order the warehouse/division filter will revert to 'not 
assigned'. This is to accommodate every possible scenario. For instance if the Division/Warehouse filter 
is set to Division East but the sales order that is created is set to Division West when you create the pick 
ticket from the sales order there would be a conflict. The correct Warehouse will be associated to the 
new pick ticket per Ship To. 

Note:  If the sales order header Ship Via is null and there are no specific release ship vias then the pick 
ticket will be created with a null Ship Via. 
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Estimate BOL 
This option allows users to estimate the freight charges and calculate the BOL details for the items on 
the sales order. A freight charge can be entered manually, or if applicable users can select the 'Get 
Freight Estimate from Web Service' speed button. The button will be visible if there is a web service 
setup on the Ship Via associated to the sales order or for users licensed for Shipping Manager and the 
ship via has been setup in Carrier Maintenance. The web service information is set up in the Ship Via 
table. (Please see Ship Via for details). 

Note: From the Sales Order, the BOL calculates based off the detail line Blanket Qty for all or selected 
lines. For detail lines with multiple releases, the BOL calculation for individual releases are done through 
the Packing Slip BOL tab. 

For users licensed for Shipping Manager this button will bring up the Shop Rates screen based on the 
carrier associated to the ship via on the sales order. The rate request will look at the Rate Type selected 
in Carrier Maintenance so the estimated rate will match the processed shipped rate.  

Select from the Carrier drop down list to view rates for specific carriers. Any errors or not configured 

carriers will be highlighted in red if the Show Errors button  is enabled, and if one is selected an error 
message will be displayed. 
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When a Service is selected on the Shop Rates screen, the system will populate the Freight Quote # and 
the Total Charge on the Estimate BOL screen.  

The freight charge, whether entered manually, obtained from the web service, or from the Shop rates 
screen will populate in the freight field on the sales order and carry over to the packing slip. The system 
will recalculate the Tax and Grand Total values after the Estimate BOL freight is added to a sales order 
which has a line item with a tax code with freight included. Additionally, the BOL information will also 
roll over to the packing slip if the 'Apply BOL to PS' option is checked.  

Select this button  to access the Estimate BOL form: 

 



Sales Orders Page 106 of 150 

 

The top left section displays the sales order number. All of the items on the sales order will be listed in 
the top right section along with their blanket quantities. The lower section is the BOL information for the 
highlighted item. 

Calculate the BOL - Select the top calculator button to calculate the BOL for all items, or select the 
bottom calculator button to just calculate the BOL for the highlighted item. The information is calculated 
based on the blanket quantity. When using the 'BOL weight is based on individual component weights' 
method, the user can right click to access the BOL Weight form. 

Note: The BOL calculates just as it does on the BOL tab in Packing Slips or the BOL module. See Bill of 
Lading Overview for more information. 

Note: In order to properly calculate the BOL figures, the BOL must be calculated for all items before 
getting the Freight Estimate from a Web Service. If you calculate the BOL information before shopping 
on the Estimate BOL screen, it will match the shipping manifest if it was generated from the packing slip 
BOL data. 

Total Charge - This field can be manually populated with the total charge for freight for all items on the 
sales order, or it will be populated from the service selected in the Shop Rates screen for all items on the 
sales order, or from the information obtained from the web service associated to the ship via for all 
items. This field will populate the Freight field on the sales order and carry over to the packing slip and 
credit card charge if applicable. When voiding a packing slip the Total Freight Charge is zeroed out to 
insure that the charges will be accurate if there are changes to the packing slip. 

Freight Quote # - This field is only relevant when using a web service or the shop rates feature. It cannot 
be manually entered. 

Apply BOL to PS - If this is checked the BOL information will carry over to the packing slip when a packing 
slip is created from the sales order or converted from a pick ticket. When the freight charge is carried 
over to the packing slip, the total charge in Estimate BOL will be reset to zero.  This is reset in case there 
are multiple packing slips created.  The user can fill in the total charge again and that amount will carry 
over to the next packing slip.  This will happen with multiple releases being shipped at different times. 

Accrued Freight - An Accrued Freight can be entered in this field which can be used in the Accrued 
Freight module (see Accrued Freight for Customer Shipments). It will carry over to the Packing Slip if the 
option 'Apply BOL to PS' is enabled. Note: If a Packing Slip with an Accrued Freight amount is voided, the 
Accrued Freight amount is reinstated to the Estimate BOL screen. 

Troubleshooting - From the File menu the Troubleshooting option can be turned on. This will capture 
Request and Response data from the web service. It will be logged in the IQCheckPointList.txt file.  
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Right Click Options in Sales Orders 

Header Section 

The following options are available when the user right clicks on the header section of the sales order 
form: 

▪ Customer Documents - View internal or external documents, and Email Correspondence associated 
with the customer on the sales order. 

▪ Jump to Customer - Takes you to the Customer Maintenance screen for the customer on the sales 
order. 

▪ Jump to Sales Quotation - If the sales order was created from a CRM Quotation the user will be able 
to jump to the CRM Quote (open or archived). 

▪ Jump to Ship To and Bill To - This opens customer maintenance to the corresponding Bill to or Ship To 
address. 

▪ Jump to Drop Ship PO - For Drop Ship customers (a Drop Ship Vendor is associated to them on the 
Customer Maintenance->Miscellaneous tab) the corresponding drop ship PO will be listed in the 
sales order header, this will jump the user to that PO. 

▪ Jump to Opportunity - Jumps the user to the associated Opportunity Central record.  

▪ Jump to Campaign - Jumps the user to the associated Campaign record. 

▪ Clear CRM Opportunity and Clear Campaign - These options will clear the associated CRM record. 

▪ Scheduling Window - This feature brings up the scheduling window (a graphic view of where and 
when an item is scheduled) for items on sales orders grouped by the Customer Purchase Order 
number. Note: In order to view the Scheduling Window from this section the PO field must be 
populated. If it is not an error will display stating, "Missing Purchase Order number. Cannot group 
Sales Orders by Customer Purchase Order". Users can also access the Scheduling Window for items 
on a sales order from the right click menu on the 'Work Order Information' option in the Releases 
section. This Scheduling Window is not grouped by PO number. 

▪ Trace - Brings up the Trace form to view changes made to the sales order. 

▪ Rewind Approval Workflow - When additional items are added to the sales order after the sales order 
is approved, and the option ‘Sales Order Pending Approval are on Hold' is checked, the items will 
remain on hold until the user manually rewinds the elements and re-evaluates the workflow. This 
option provides an easier method to rewind the approval workflow for these situations. When 
selected a Confirm message will appear with Yes and No buttons stating, "This options resets the 
completion date for all elements along with all Workflow approval records so it can be evaluated 
again. Are you sure you wish to proceed?" 

Line Item Section 

The following options are available when the user right clicks on the line item (middle) section of the 
sales order form: 

▪ Generate Releases - This brings up the form to generate release dates for the highlighted item. 
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▪ Copy/Paste Releases - Copies and Pastes the releases associated with the highlighted item and then 
can be pasted to another item. A confirm box will appear asking to append or overwrite. The 
following fields will be copied over to a the new release: Release Date, Quantity, RAN number, 
Comments, Forecast, User Date, Batch Number, Comment 2, Job Sequence, Date Type, Original 
Quantity, and Acknowledged check mark. Ship To will only get copied over if the releases were 
copied from a sales order for the same customer. 

▪ Create Firm Work Order - This option will create a manual Firm work order. This option is available in 
both standard order entry or Quick Order entry. (See Create Manual Firm Work Order for more 
information). 

▪ Copy/Paste Captured EDI Segments - Copies and Pastes captured EDI segments. 

▪ Jump to Inventory - Jumps to the Inventory screen for the highlighted item. 

▪ Jump to Inventory Locations & Transaction - Jumps to the Inventory Locations screen for the 
highlighted item. 

▪ Jump to Customer - Jumps to the Customer Maintenance screen for the customer associated with the 
highlighted item. 

▪ Jump to Availability - This will display the Inventory Availability for the selected item. Right click in the 
upper section to access: Jump to Inventory, Inventory Locations, BOM Tree, CTP Diagram, Create 
Sales Order, and Sales Order Activity options. Inventory Availability can also be accessed from the 
Sales/Distribution tab on the EIQ Launcher Bar. See Inventory Availability for more information. 

▪ Jump to Forecast - Jumps to the Forecast module for the highlighted item. 

▪ Jump to Drop Ship PO - This option will open the purchase order for Drop Shipped items. 

▪ Jump to Campaign - This option will open the Campaign Management record associated to the line 
item. 

▪ Jump to Price Book - This will jump to the Price Book the item is attached to if applicable. 

▪ Form View - Changes the view from Table to Form. This view does not include every field. Not all 
Security can be placed on the form view. (Customize OE Form View secured items using the Add Item 
feature in Security Inspector). See the Form View section below for details. 

▪ Trace - Brings up the Trace form to view changes made to the sales order details. 

▪ Boiler Plates - This feature allows you to Load a Boiler Plate, View/Edit Boiler Plates, or Save As a 
Boiler Plate for the highlighted line. Boiler plates are a list of notes that can be attached to the item. 
(Please see Boiler Plates in the Setup manual for more detail). 

▪ Cost Source - A line item on a sales order can be cost sourced to either a Project Manager, JobShop, 
or PM work order, or linked to a Fixed Asset. Once cost sourced users can jump from the cost source 
pop up to the specific record. 

▪ Customer Documents - View/edit internal or external documents, and Email Correspondence 
associated with the customer on the sales order. Security can be set to only enable viewing. 

▪ SO Item Documents - Internal, External, and Email Correspondence can be associated to a line item 
on the sales order. This option will open the documents form to add or view the documents 
associated to the line item. The print with options for the documents are: None, Sales Order, Sales 
Order Acknowledgement, Packing Slip, Work Order, or All. 

▪ Shipments - Opens a form to view shipments. See Shipments below for details. 

▪ Open Pick Tickets - Select this option to view all open pick tickets associated to the line item. If more 
than one pick ticket exists for the order detail, a pick list of all pick tickets associated with the item 
will display and the user can select the pick ticket to jump to. If only one pick ticket exists, the pick 
list will not display and the user will be taken to the pick ticket. 
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▪ Commissions - Opens the Commissions form. See Commissions for details. 

▪ Total On Order - Shows the total on order from all sales orders for the highlighted item. 

▪ BOM Tree - This feature brings up the BOM Tree showing all of the required elements to produce the 
highlighted item. 

▪ Assign EPlant - If not already assigned - click on this field to assign a specific EPlant. 

▪ Allocate MakeToOrder Inventory - This option is only available for line items marked Make To Order. It 
allows the user to allocate existing inventory to the line item. Please refer to Make To Order in the 
Sales Order Line Item Details section above for more information. 

▪ Show Releases Activity - See Show Releases Activity below. 

▪ Show Releases History - See Show Releases History below. 

▪ Show Quality Issues - See Show Quality Records below. 

▪ Show Additional Info - This option displays the Config code and choices associated to the line item for 
sales configuration template line items that came from CRM Quotations. 

▪ Repair Information - See Repair Information below. 

▪ Outsource Information - This will display the Parent Item # and WO #, and Child Item # and WO # for 
Outsource Central users. 

▪ View captured EDI segments - This allows users to view EDI data that is recorded from the inbound 
EDI file. For details on adding recorded EDI segments to a Crystal report please reference the EDI 
help file. 

▪ Update Sales Price - Select the 'Update Sales Price' right click option to update pricing for items on 
sales order(s) to newer pricing if applicable. There are several options available. Refer to the  Update 
Sales Price section for details. 

▪ Tax Breakdown - This displays the tax element breakdown for the line item including the tax rate and 
amount with three decimal precision. 

▪ Reset GL Account - If the GL account was manually changed, this will reset the GL Account based on 
the hierarchy: Sales GL Account assigned to the item, Sales Acct # assigned to the inventory group, 
Default sales account assigned in System Parameters > GL Setup. 

▪ Alternate Item # - This option allows the user to substitute an alternate item for the line item on the 
sales order. If there have been no shipments against the sales order item the system will simply 
replace it. If the sales order item has been shipped against but not in full, a new line item will be 
added to the sales order for the Alternate Item selected. All of the unshipped demand (remaining 
Blanket Quantity and unshipped Releases) will be moved to the Alternate Item. If the sales order 
item has been shipped in full, a new line item will be added to the sales order for the Alternate Item 
selected. 

▪ Clear Campaign # - This option will clear the Campaign Code field. 

▪ Clear Rebate Parameter - This option will clear the link to the Rebate Parameter. 

▪ Edit Miscellaneous Item - This option will be available for miscellaneous line items only. The 
Miscellaneous Item Entry form will appear for the user to edit the fields (i.e. item # and description). 
When the 'Include edit on Miscellaneous Item record' option is checked, both the line item and the 
Miscellaneous Item record will be updated.  When this is not selected, only the line item on the sales 
order will be updated. 
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Create Manual Firm Work Order 
Highlight an item on a sales order and select this option from the right click menu to create a Manual 
Firm work order. A dialog box will appear showing the releases for the item. Highlight the releases to be 
associated to the work order using the toggle buttons and select OK.  This allows the user to decide how 
many releases the work order will cover.  

Releases must be associated to the item in order to create a Manual Firm Work Order. If there are no 
releases associated to the item the 'Create Firm Work Order' form will still appear but when selecting the 
OK button a message will pop up stating, "Please add sales order releases to create firm work order". 
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The system will create the Work Order and populate the Delivery Quantities grid on the work order 
based on the number of releases the user selected. The PO # will populate from the line item if 
applicable; if not it will use the PO # from the sales order header. If the release has a specific ship to 
associated to it, the system will carry that over to the work order, otherwise the header ship to will be 
used. 

Note: The system will consider the Ship Days on the Ship To for determining the Must Start Date when 
creating the work order. The system will use the sales orders release must ship dates for the work order 
release dates. (Manual work orders created from the work order module do not consider ship days). 

 

If the releases in the lower section are changed on the Sales Order, a pop up warning will appear 
displaying the work order(s) and the cycles required. The user must then change the work order 
manually by right clicking and jumping to the work order. 
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Form View 
The' Form View' right click option available in the Item Details section will pop up a Form to view several 
of the fields available in the middle section. This view does not include every field. The fields that are 
included are shown in the screen shot below. 
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The right click menu option is available from this form. 

Fields not available in the Form View: 

▪ Class 

▪ Ship Hold 

▪ UOM 

▪ Cost Source 

▪ Dock ID 

▪ Line Feed 

▪ Reserve Location 

▪ KB Trigger 

▪ Customer Cum. Start 

▪ Last Receipt Quantity 

▪ Last Receipt Date 

▪ Reference Code 

▪ Reference Code Description 

▪ Raw Material Quantity 

▪ Containers 

▪ AKA Revision 

▪ GL Account 

▪ Drop Ship 

▪ Make To Order 

▪ Hard Allocated Via 

▪ PO Info 

▪ ICT Ship From 

▪ Ext. Description 

▪ User Text 1 

▪ User Text 2 

▪ User Text 3 

▪ Rebate Parameter 

▪ Hide 

▪ AKA Ext Description 

▪ Ship Division 

▪ Mfg # 

▪ AKA Kind 

▪ Default Mfg # 

▪ Auto Invoice 

▪ Non-Committed 

▪ On Hand 

▪ Quality Issues 

▪ Sample 

▪ Shipped Qty Invoiced 
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▪ Config Code 

▪ Discount 

▪ BOGO Exception 

▪ Price Book 

▪ Price Book Price Type 

Security can be placed on the form view. (Customize OE Form View secured items using the Add Item 
feature in Security Inspector). 
 

Shipments 
Brings up the form showing the shipments and invoice information for the highlighted line item. 

 

The top section displays information such as, the item # and description, Ship Date, Packing Slip #, and 
the quantity shipped. For RMA Credit Memos the quantity shipped will be negative. If there are multiple 
credit memos created they will all be listed in the Invoices Against Shipment section. 
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Commissions in Sales Orders 
Shows the commission information for the highlighted item. The salesperson(s) and commission percent 
are determined based on the commission hierarchy established in the system. (See the Commissions 
Flowchart in the Assigning Sales people to a Sales Order section for more information). 

The user can add or edit the salesperson from the form that appears by clicking the ellipsis button in the 
first or last name fields to access the pick list. The Commission % can be changed which will update the 
Commission Amount. If there are multiple items on the sales order, if the Commission % is changed for a 
line item, the user will be asked, 'Do you want to modify commissions on all detail items?'. Selecting Yes 
will update the Commission % for all line items. Selecting No will only update the current line item. 

 

Note: If the Amount is changed, only the specific detail line changed is updated; the user is not prompted 
to update the entire order. 
 

Show Releases Activity 
This shows all trace information for all releases attached to this line item, including deleted releases. 
Both manual and EDI changes will be displayed. 
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Show Releases Quantity History 
This feature gives full visibility of release activity including, add, edit, and delete along with the date the 
release was added or changed.  This is useful if there are multiple releases for the same day. The 
maximum amount of time this table can look back is 365 days. 

If a time is added to Promise Date it will also appear, however the change will not be time stamped. The 
time stamp only occurs when a change is made to a release quantity. 

 

To see all trace information for releases use the Right Click > Show Releases Activities option. 
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Show Quality Issues 
This feature will bring up a form displaying the CARs/CAPAs, ECOs, MRBs, Deviation, and PPAP/Product 
PQ records associated with the highlighted item. The user can jump to the quality issue from this form by 
right clicking. 
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Repair Information 
If the Sales Order was created from the Repair work order in the RMA module the user will be able to 
view the CRM Support Issue, RMA#, and Work Order # associated with the sales order. Jumps are also 
available from the pop up form if applicable. 
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Sales Order Release Section - Right Click Options 
The following options are available when the user right clicks on the release (bottom) section of the sales 
order form: 

▪ Trace - Brings up the Trace form to view changes made to the sales order release information. 

▪ Jump to Sales Order Picking Wave - (This option is only available if licensed for 'Advanced WMS'). It 
will be available if the release is on a wave, and allow the user to jump to it. 

▪ Gantt Chart - Brings up a Gantt chart for the release information which can be viewed in calculated or 
tabular formats. 

▪ Update price based on highlighted release quantity - This function will update the sales price for the 
item based on the quantity for the highlighted release. 

▪ Work Order Information - This feature brings up a form showing the work order and scheduling 
information for the releases as well as the visual work order routing. If a work order is currently 
running in RealTime a work order progress bar will be displayed on the bottom of the blue box. For 
ASSY1/ASSY2/ASSY3 work orders the work order progress bar will always be visible. The progress % 
calculation for the ASSY manufacturing types is (OrigQty – Qty / OrigQty) * 100. 

 

From the Work Order Information form there are additional right click options in both sections: 

Top Section: 

▪ Jump To: Work Order, BOM, Inventory, and Scheduling (if the work order is scheduled), Assembly 
Track (if in Assembly Track). 

▪ Scheduling Window 

▪ Gantt Chart 
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Right click from a routing step. The options will vary based on the type of routing step. 

▪ Expand  

▪ Jump To: BOM, Inventory, and Process, and Exceptions. 

Note: If a work order is not currently running in RealTime the work order progress bar will be 
suppressed. 
 

Update Sales Price 
Select the 'Update Sales Price' right click option to update pricing for items on sales order(s) to newer 
pricing if applicable. The system will use the standard pricing hierarchy, including Price Books when 
determining the price. The rules for effective dates apply to all options.  
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Following are the available options: 

▪ Update Sales Price for Selected Item on this sales order - Use this option to update the sales price on 
the open sales order for the selected item only. 

▪ Update Sales Price for All Items on this sales order - Use this option to update the sales price for all the 
items on the sales order. 

▪ Selected item on all sales orders - This will update the price for the selected item on all sales orders. 
Users can also choose to include uninvoiced shipments by checking that option. 

▪ All items on all sales orders - This will update the price for all items on all sales orders. Users can also 
choose to include uninvoiced shipments by checking that option. 

Update Sales Price Notes:  

With a manually entered price and no other pricing in place for an item, when an update price option is 
selected the manually entered price is retained. 

The system will evaluate the first unshipped release promise date compared to which price break will be 
active at that date. 

When selecting the 'Include uninvoiced shipments' option the system will not update the shipment price 
if any posted or unposted invoices exist for the shipment record. 

Discount % - When the discount % is manually entered and item pricing exists, updating the sales price 
removes the discount %.  Without any item pricing, the value will remain along with the manual entry 
pricing. A change to the  Discount % in Customer Maintenance takes effect when a new Sales Order is 
created (not when updating sales price on an existing order). 

Lot Charge – selecting/changing Lot Charge on an item adds the lot charge for new sales orders only.  
When updating sales price or adding the item to an existing order, the Lot Charge line does not get 
added and the SO price of this item becomes zero.  

For Price Book Items - Price Book items are EPlant agnostic, however when using this feature for items 
that are associated to a Price Book, the system only updates pricing for sales orders that have the exact 
item number on it (where the Class, Item, Revision, and EPlant match). For example: Item # ABC, Class 
FG, Rev 1, belongs to EPlant 1. When the user right clicks on this item and chooses to update the item for 
all sales orders, the system will only update pricing for sales orders that have that exact item number on 
it. (The system will match based on the ARINVT_ID). 
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Web Order Import 

 This module will be visible if the system has the WebDirect or the WebDirectB2C licensed modules. 

WebDirect is a business-to-business application that leverages the power of the Internet, and 
DELMIAworks software, allowing users to collaborate more effectively with their customers and 
suppliers. (For all the information on WebDirect please reference the WebDirect Combined 
https://my.iqms.com/cfs-file.ashx/__key/Technote/Webdirect_5F00_Combined.pdf TechNote 
available on MyDELMIAworks). WebDirect allows your customers and vendors access to certain modules 
of DELMIAworks. You can set the modules the customer and vendor has access to. This can be different 
for each customer and customer contact, and vendor and vendor contact. 

The WebDirect B2C is a Business-to-Customer web portal that interfaces with DELMIAworks. Customers 
can make product purchases, monitor order history, view past orders, as well as order status when Web 
Order Imports are converted to sales orders and subsequently shipped. From the Shopping Cart Settings 
screen in WebDirect B2C there is a setting that allows the site to charge credit cards when a customer’s 
cart is submitted. When enabled, web orders will be converted to sales orders automatically (bypassing 
the Web Order Import screen) if a customer’s credit card was charged successfully when their cart was 
submitted. Reference the WebDirect B2C https://my.iqms.com/cfs-
file.ashx/__key/Technote/WebDirect-B2C.pdf TechNote available on MyDELMIAworks.  

The Web Order Import module is used to import the orders entered by your customers via WebDirect. 
From this screen users can verify orders placed by customers and then convert them to actual sales 
orders. 

To access the Web Order Import module go to the Sales/Distribution tab on the launcher bar and select 
the Web Order Import icon. This options is also available from CRM in the EnterpriseIQ Information 
section. A pick list of WebDirect orders will appear. (Note: If a user is assigned CRM Customer Access in 
security inspector, when accessing the Web Sales Orders pick list, the customer name field will be blank 
for records that have customers that are NOT assigned to the user). Select an order from the pick list and 
the following form will appear: 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Webdirect_5F00_Combined.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/WebDirect-B2C.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/WebDirect-B2C.pdf
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This form displays the general order information, items ordered, and release information. Below is a field 
list for these sections of the form. 

General Info: 

Ref # This is the reference number assigned to the order. This number is given to the customer 
when they submit a new order through WebDirect. 

Customer/Cust # This is the customer name and number associated with the WebDirect order. 

To access the Customer Maintenance record for the customer, right click and select Jump to 
Customer. (Note: For WebDirectB2C users, if a user creates a new account and never placed 
an order before, the right click 'Jump to Customer' option is disabled). 

PO # This is the purchase order number entered by the customer. 

Action Code This is the type of order. It will either be NEW or EDIT. The action is NEW if it is a new order 
and EDIT if the customer made a change to an existing order. 

Status The status of the WebDirect order will always be SUBMITTED. 

For WebDirectB2C orders, the status can be SUBMITTED or PENDING (Note: PENDING means 
a user has product in a cart but has not checked out. Also, the Order cannot be converted 
into a Sales Order). 

Order Date This is the date and time the order was submitted by the customer. To view the time put the 
cursor in the field and arrow to the right. 

Date Taken This is the date and time the order was taken. To view the time put the cursor in the field 
and arrow to the right. 
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Bill To This is the Bill To address linked to the contact. This information is entered on the Contact 
tab in the WebDirect section. If no Bill To is assigned to the WebDirect contact, the first Bill 
To address will be used when the order is converted to an actual sales order. 

Ship To This is the Ship To address linked to the contact. The default Ship To address for the user is 
entered on the Contact tab in the WebDirect section. The customer can also create a new 
ship to address from the WebDirect customer portal when entering the order. The address 
created by the customer will populate on the Ship To tab in Customer Maintenance after 
converted to a sales order. 

Contact This is the contact name for the person who entered the WebDirect order. 

Web User ID This is the WebDirect user ID for the person who entered the WebDirect order. 

Ship Via The Ship Via method the customer selected. 

Freight The freight charge from the web order. 

Payment Type This is the payment Type the customer selected from the Shopping Cart screen. This 
information can be used to determine the correct terms for the sales order.  

Note: This field is only visible from the Table view. 

 

Details Section: 

Action Code This is the type of action related to the line item. It will either be NEW or EDIT. The action is 
NEW if it is a new item and EDIT if the customer made a change to an existing item. 

Seq. The sequence number of the item on the order. 

Comment If the customer enters comments in the Comment field on the Release screen in the 
WebDirect Customer Portal they will appear here. A comment can also be entered for a line 
item from this form. Double click the field to access the comment form and type the 
information desired in the box. This comment will populate the Note field for the line item 
on the sales order when converted. 

Unit Price This is the unit price of the item. This information comes from either the selling price breaks 
on the Buy/Sell Pricing tab in Inventory or the AKA selling price breaks if it is set up as an 
AKA item for the customer. Typing a new value in the field before converting the WebDirect 
order to a sales order can change this information. This field populates the Unit Price field 
for the line item on the sales order. 

List Unit Price This value will be the same as the 'Unit Price' unless changed. Typing a new value in the field 
before converting the WebDirect order to a sales order can change this information. This 
field populates the List Unit Price field for the line item on the sales order. 

Item # This is the item number of the part ordered. This is the inventory item number not the AKA 
number. 

Rev This is the revision of the item number ordered. 
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Class This is the inventory class of the item ordered. 

Description/Ext. 
Description 

This is the description and extended description of the item ordered. 

AKA Kind This is the AKA Kind associated to the item ordered if applicable. 

 

Releases Section: 

Action Code This is the type of action related to the line item's release date. It will either be NEW or EDIT. 
The action is NEW if it is a new release date and EDIT if the customer made a change to the 
release. 

Request Date This is the date the parts are requested to be “in house” by the customer. 

Qty. This is the quantity of the release. 

 

User Fields: 

 

The User Fields tab displays five user fields. User Fields 1 - 3 will populate with information entered by 
the customer from the three comment fields on the General Info screen in “Your Shopping Cart” 
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User Fields 4 and 5 can be used internally for additional information to be viewed on the screen or 
printed on reports. 

Converting a Web Order to a Sales Order 
Once the information has been reviewed the user can convert the WebDirect order into a sales order. 

To convert the order, select the speed button or go to Options/Convert to Sales Order. A Confirmation 
screen will appear, select 'Yes' to continue. Once converted another Confirm box will appear asking “Do 
you wish to send Acknowledgment Emails?” This Option will send an email to the customer if they have 
an email address specified on the Contact tab in the Customer Maintenance module. Note: If the 
customer entered an email address on the web page it will update the email address in Security 
Inspector and the Contacts tab in Customer Maintenance. 

An example of the text of the email is: “Web Order Ref# 5 processed successfully on 2/14/2006”. Also, 
the email includes the order acknowledgment report as an pdf attachment (see the sample below): 

 



Sales Orders Page 127 of 150 

 

Once the WebDirect order is converted the sales order it was converted to will open automatically. All of 
the information on the sales order is based on the WebDirect order information. The promise date will 
fill in with the same date as the requested date the customer entered. Information such as pricing and 
salesperson will populate the sales order using the standard hierarchy. The user may edit any 
information on the sales order if required. 

Other Options in Web Sales Order Processing 
Filter 

This function allows the user to filter the displayed WebDirect orders based on selected fields. Click on 
the Filter speed button or go to Options/Filter and the following form will appear: 
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Select the field you would like to filter on, enter the field value, and select the search type. Press OK and 
the WebDirect orders displayed will only be those that meet the filtered value. For example, if the user 
filters on Cust# and enters a specific customer number in the Field Value, only the WebDirect orders for 
that customer will display on the Import form as the user scrolls through the orders with the navigator 
bar. 

Filter out orders marked by Flexibility Rules 

This feature will filter the orders and display only the orders that are marked due to the flexibility rules 
that have been established. 

The user can set up flexibility rules that will designate whether orders will be changed with new 
information. The Minimum Change Interval is used in conjunction with the Customer Flexibility 
Agreement Rules for EDI. Orders that are within the Flex Rules limits are automatically carried over to 
the Sales Order module. The orders that do not meet the Flex Rules are flagged so they can be manually 
approved or discarded. If there are no Flex Rules setup, all orders are accepted. Flex Rules are setup on 
the MFG/Inventory/FG Item /AKA selling tab. 

Override Flexibility rules 

Select this feature to convert items that have been marked due to a violation of the flex rules. This forces 
the conversion of orders regardless of the fact they have violated the flex rules. Hint: Select the filter 
button first to show only the flagged orders. 

Send Email 

The user can send Email to the customer from this form by selecting the Send Email speed button or go 
to Options/Send Email. 

Once selected, a pop up form will appear with the customer contact's Email address filled in. The subject 
and the body will fill in automatically with the Web Order reference number. Enter additional text and 
select the OK button to send the Email. 

 

Report 

A WebDirect Pending Orders (WebdirectPendingOrders.rpt) report showing pending WebDirect Orders is 
available. This report is not setup in the system by default, but may be added to the Web Order Import 
Module if desired. 
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Inventory Availability 

Customer service often needs an ability to quickly search for inventory and its availability. From the EIQ 

Launcher Bar, find the Inventory Availability icon within the Sales/Distribution tab. A pick list of inventory 
items will appear. Select the item from the list and then the following form will appear: 
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The top section will display the item information including the Item #, Description, UOM, and EPlant ID. It 
also shows the 'Last MRP Recalc' date which is the last time Update Schedule ran. 

Note: Inventory Availability can also be accessed from sales orders by clicking the speed button in the 
middle section or from the right click jump option. 

  Search Inventory - This speed button brings up the inventory pick list. The pick list includes the 
feature 'Component Where Used Search'. This allows users to create a query to display parent items that 
involve all of the listed components. For details refer to the Pick Lists section. 

 Search AKA Inventory - This speed button brings up the AKA inventory pick list. 

 Customer - Provides access to the customer maintenance form. 

 EPlant - This speed button is used to filter for a certain EPlant if applicable. This will also affect the 
Divisions that will display in the middle grid. for Example: If filtered for the PASO EPlant, all Divisions 
associated to the PASO EPlant will be displayed. If set to View All, all Divisions will be displayed. 

 Calculate Material Exceptions, Ideal vs Existing and Daily Material Requirements - This will recalculate 
material exceptions just as it does in Material Exceptions.   

The middle grid displays the current On Hand, ICT On Hand, Outsource On Hand, Ship Staging On Hand, 
Non Allocate On Hand, and Non Conform On Hand for the item and broken down based on Division(s) 
associated to the EPlant selected in the EPlant filter, or all divisions if View All is selected in the filter. 

On Hand  Total of all inventory on hand for the division. 

ICT On Hand Intercompany In Transit (type #1) 

Outsource On 
Hand 

Items in transit to Outsource vendor (In Transit type #2) 

Ship Staging On 
Hand 

On Hand quantity for items that have been shipped but are awaiting verification (In Transit 
type #3) 

Non Allocate On 
Hand 

Non Allocate on Hand 

Non Conform On 
Hand 

Non Conform On Hand 

No Ship On Hand No Ship On Hand 

Lead Days For the item summary level this is the lead days associated to the inventory item. 

For the Division summary level this is the item's divisional lead days. 

Lead Time For the item summary level this is the lead time associated to the inventory item. 

For the Division summary level this is the item's divisional lead time. 
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 Evaluate Inventory Availability– This is to be used when the Options: On Hand Less In Transit, On 
Hand Less Non-Allocate, and On Hand Less Non-Conform are enabled. Please see each option description 
below to see how the system evaluates inventory availability. 

Options Menu: 

▪ On Hand Less In Transit - With this checked the on hand used for evaluation on the Projected tab will 
not include quantities In Transit. 

▪ On Hand Less Non-Allocate -  With this checked the on hand used for evaluation on the Projected tab 
will not include Non-Allocated quantities. 

▪ On Hand Less Non-Conform - When this is checked the projected tab On Hand will not include any 
product in non-conform locations.  This can be checked in conjunction with the On Hand Less Non-
Allocate so that both non-conform and Non-allocate are excluded from the on-hand amount. 

▪ Include Non-Scheduled Work Orders - By default Inventory Availability only includes finite scheduled 
work orders. With this option checked the system will include non scheduled work orders also.The 
system will use the must start date from the work order to determine the week it displays in. Note: 
When this option is checked the system will display the source for both scheduled and unscheduled 
work orders as "Scheduled".  

These options will remain checked after a user exits Inventory Availability. 

Lower Section Tabs 

The information in the lower section will display the Current and Projected information based on the 
highlighted line in the middle section. It will display the details based on the division associated to the 
line. For example, for records where there is no division the system will only display records with no 
division. Select the 'Evaluate Inventory Available' (calculator) button to view the Available to Promise 
(ATP) details.  For the Item Summary Level, the Available to Promise calculation will use the Total On 
Hand available in the all warehouses less any VMI. It is calculated: (Total on hand for all warehouses + 
scheduled WO’s for specific warehouse) – (Backlog for specific warehouse).  

By clicking on the tabs in the lower section, you can view either the Current information or the 
Projected. Projected takes into account scheduled information, while Current only looks at actual sales 
releases. You can optionally view either Projected or Current information graphically. The tab the user 
was on last will be remembered in the registry. 

Note: The information on the projected tab is based on the last time update schedule was run. The 
system only evaluates new and edited work orders including finite schedule changes during the Update 
Schedule run. Any change to a work order can affect unlimited other work orders or materials required. 
It takes a regeneration to make sure that nothing is missed 

Note: If an outsource work order is linked to a PO it will not show up in the inventory availability grid.  
However, with the option "Include Non-Scheduled Work Orders" checked, if the PO is not linked to 
Outsource WO (in Outsource Central->Ship Orders) both the work order (Scheduled) and the PO will 
show up as 'IN's. 

Note: The Current tab will not show demand for an item marked as 'Ship Hold' on a Sales Order. 

Unit of Measure (UOM) - Users can change the UOM to one of the UOM factors that are defined for the 
inventory item.  Select a UOM from the drop down list and then select the 'Apply UOM' button. This 
drop down list will show if the factor is designated for Sales Orders or Purchase Orders. The information 
in the lower section will change based on the selected UOM. 
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Date Date an activity is scheduled to occur. In the case of sales orders, it is the date of release. In 
the case of scheduling, it is the date of production 

On Hand The current balance given that the previous event occurs. The On Hand quantity includes the 
Non-Allocated quantity. 

Note: If the item is running and a floor disposition is done, the on-hand will increase by the 
floor dispositioned amount, and the first Scheduled row will decrease by the floor disposition 
amount. 

IN If the items will be coming IN to inventory, via scheduled production, the daily projected 
amount will be shown here. This information is also visible in the Daily Parts Projection 
module (Scheduling-Requirements menu). 

This amount will be reduced by any floor dispositions that increased the associated On Hand 
value. 

OUT If the items will be going OUT of inventory via the sales release, this amount is shown here 

Balance At the end of the day, this is the projected inventory balance. Note that this value becomes 
the starting value for the next On Hand record 
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Source For manufactured items this field indicates whether the activity is based on the schedule 
(SCHEDULED), sales releases (BACKLOG), or awaiting inventory verification (STAGING). 

You can double click on a Backlog source to see the sales order information that includes the 
Order #, Ship Qty, Request and Promise date, Forecast attribute, and more as shown below:  

 

Double click on a Scheduled source row to access the work order information.  

 
From the Sales Order pop up form right click to jump to the sales order or from the Work 
Order form, right click and jump to the BOM or Work Order. 

Note: If the 'Include Non-Scheduled Work Orders' option is selected and a work order is not 
scheduled the information in the drill down pop up will be empty and the user cannot jump 
to the WO or BOM. 

Dependent Demand will display with a source of Required. 

For purchased items this field indicates whether the activity is based on the PO or REQUIRED. 

PHANTOM  - The Source will be PHANTOM if: 

▪ The item is marked Phantom and the work order the demand is coming from is scheduled. If 
the work order is not scheduled it will display as ON_HAND. 

▪ The primary material on the BOM is a blended operation and “Blended at work center” is not 
checked, and if the work order the demand is coming from is scheduled. If the work order is 
not scheduled it will display as ON_HAND.  

You can double click to quickly drill down to the purchase order or work order information. 
From the details form use the right click to jump to the purchase order or from the Work 
Order form, right click and jump to the BOM, Inventory, or Work Order.  

Note: Unshipped ICT (Intercompany Transfer) orders have the source: BACKLOG. If there are 
multiple transactions associated with the same "BACKLOG" source, you can click the 
transaction line to expand the other associated transactions, along with their Ship Order 
Numbers, Ship Order EPlants, Customer #s, Customers, Companies, Ship Order POs, Release 
Qty, Request Dates, Promise Dates, and Must Ship Dates. 

Note: You can right click an associated ICT order to jump to that order as long as you are 
logged into the order's EPlant or you are currently viewing all EPlants. 

Note: Shipped ICT orders have the source: ON HAND. You cannot currently drill down into 
orders with the 'ON HAND' source. 
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Available to 
Promise 

Available to Promise, also known as ATP, is a value that calculates by the day whether you 
have excess inventory that can be promised to your end user. 

This value is different from the daily on hand balance, as it must look into the future and 
determine if there is demand for the item that will consume the current inventory. 

For example, you may have several sales releases that demand X number of parts. If you only 
have enough on the floor and just enough in production to cover the demand, then your 
available to promise will either show zero or a negative number. 

However, if you have excess inventory and plan to make more beyond the actual demand, 
the system will indicate on what day in the future you can promise the inventory. 

The formula for ATP is: (On Hand - Non-Allocate + Scheduled WO's) - (Out in Staging + Backlog 
from Sales Orders).  

When Filtered for a Warehouse the calculation is: 

(Total on hand for all warehouses + scheduled WO’s for that warehouse) – (Backlog for that 
warehouse). 

Note: VMI is not included in on hand for the ATP calculation. (It is included in the value in the 
On Hand column described above). 

Note: The On Hand quantity can be reduced by the quantity in In-transit and/or Non 
Allocatable locations by checking the desired options on the Options menu. 

Note: When an item is planned for shipment or has already been shipped from another 
location, Inventory Availability will display the projected item's IN quantity and update the 
'Available to Promise' field with the projected receiving date. The projected receiving date 
will serve as the date when the item will be available to promise. 

EPlant The EPlant associated to the item. 

Create Sales Order 

Once you determine your availability, you can create a sales order from this screen. 

➢ From the upper grid, right click and choose Create Sales Order. 

➢ After selecting the customer, the system will generate the order and allow full editing. The 
item will be filled into the Order detail section, though you must complete the quantity, 

pricing and release information. 

Other Right Click Options 

Right click in the top grid and the following functions are available: 

▪ Jump to Inventory - This function will take you to the Inventory form for the line item you are 
highlighted on. 

▪ Jump to Transactions/Locations - Select this to jump to the Transactions module for the highlighted 
item. 

▪ BOM Tree - This function brings up the BOM Tree information. This information shows all of the 
required components that make up the item. 

▪ CTP Diagram - See Capable To Promise below for details. 

▪ Sales Order Activity - This feature brings up a form detailing the sales order activity for the 
highlighted item. This screen shows all of the release information for every sales order associated 
with the item. The lines are color coded to show the release status. 

▪ Gray - Order is Archived 
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▪ Green -Release is shipped 

▪ Purple - Release is not shipped 

▪ Yellow - Release is partially shipped 

 

 
 

Capable To Promise 
CTP Diagram - CTP stands for Capable to Promise. This function enables the user to determine whether 
parts can be promised to a customer for a certain date or not.  Highlight the item you want to determine 
promise information for and then right click and click on CTP Diagram.  The following screen will appear: 
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In the Requested Qty field type the amount the customer is requesting. This defaults to the MFG Min 
Quantity associated to the item (Inventory->Manufacturing tab) or 1000 if the MFG Min Quantity is null. 
If the item has a MFG Min Quantity and the user enters a lesser value a warning will appear stating. 
"Requested qty is below mfg min quantity". Only users with security to select OK will be able to continue. 

Put in the requested date using the drop down calendar. 

Users can change the UOM to one of the UOM factors that are defined for the inventory item.  Select a 
UOM from the drop down list. This list will show if the factor is designated for Sales Orders or Purchase 
Orders.  

Select the OK button. If the parts are available you will get a green light, if they are not available you will 
get a red light and a Capable to Promise Date. A yellow light occurs if the capable to promise date can be 
made except for the response time. The response time is set up under Options/Parameters on the above 
screen. Regardless of which color of light appears, the CTP Routing Diagram will appear. 

CTP Parameters 

Access the CTP Parameters from the Options menu on the Capable to Promise form. 

Response time is added into the overall calculation for items (purchased and manufactured). It is the 
number of days it takes to respond to the order in house. For instance, how long does it take to get PO’s 
created, orders entered, etc. The calculation for required items is system date + lead days + response 
time (weekends are included). 

Use ATP calculation for Raw Materials - With this option checked the system finds future PO availability 
and displays the CTP Date prior to item’s lead days if material will be available within that time period.  If 
the quantity requested is not available to promise within the item’s lead days, the CTP Date calculates 
according to lead days (same as with this option un-checked). (Note: The system does not consider past 
due Purchase Order requirements in Available to Promise CTP calculations, and instead considers the 
projected material availability beginning with Promise Dates for the current day). 

For Example (assuming no labor or machine capacity constraints, Material lead days - 21, production 
hours = 2 1/2, date CTP evaluated = 8/27). If PO Promise Date is 9/12 with a sufficient amount on order, 
and the response time is 0, the CTP will be 9/12. If the response time is 2 the CTP would be 9/14. If the 
PO promise date is 9/30, response time = 0, the CTP will be 9/17 (the system uses the lead days). 

Include Allocated to Auto MRP WO - By default, for Auto MRP items, when on hand inventory is below its 
MFG Order Point, when update schedule runs the system will FG Allocate the current on hand towards 
the internal stock order. This throws off the CTP Date because it expects to satisfy the internal order 
instead of notifying the user they could technically promise that item the same day to the customer. This 
parameter enables the system to ignore the FG Allocation and display the current date as long as the 
current on hand for the item does not exceed the requested quantity. If the requested quantity exceeds 
the on hand value, it will calculate the difference in demand and display the CTP Date for which the 
difference will be completed by.  

Inventory Parameter - On the Additional tab in Inventory there is a check box called 'Exclude from CTP 

Visual Material Exception’. If this is checked the system will exclude the material exception flag for the 
item in CTP. 

CTP Routing Diagram 
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Requirements 

This routing screen is a color coded screen that shows all of the requirements necessary to make the 
item. 

▪ Dark Blue - BOM and routing information such as work center type, Mfg #, Rate/Hr, and Item #. 

▪ Purple - The item # and description of the primary material. 

▪ Green - All of the purchased components associated with the item. 

▪ Yellow - All of the packaging associated with the item. 

▪ White - The purchased components used in sub operations. 

▪ Light Blue - Outsourced BOM information. 

Flags 

The Flags are used to show possible constraints: 

▪ Red Flag - Possible purchased material constraint - on hand amounts and lead days are considered. 
Note that components attached to an item that have the ‘Exclude from Backflush’ option selected 
will not ever be considered a constraint. 

▪ Gray Flag - Possible machine capacity constraint - rough cut capacity is considered. 

▪ Light Blue Flag - Possible labor capacity constraint - available labor is considered. 

▪ Dark Blue Flag - Possible Tooling Constraint based on the Conflict Evaluator. 

The flags that are waving show where the actual constraints are. Flags display for all materials with a 
constraint for proposed production, but the flag waves on the one material item with greatest 
constraint. If the work order is unscheduled, the system looks at the must start date on the work order 
to determine constraints. If the work order is scheduled, the system looks at the work center the work 
order is scheduled on to determine constraints. 

From each of the colored boxes you can right click and jump to Inventory, BOM (only on the BOM box), 
and to the Exception List. You can also click expand to see additional information. 

Following is an example of the expanded BOM/Routing box: 
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Expanded View 

Below is the field listing for the expanded view on the BOM/Routing box: 

Type Work center type associated with the BOM for the item. 

Mfg # Manufacturing number associated with the item. 

Rate/Hr The number of items per hour that can be produced. 

Item #/Desc The item number and description of the part. 

Qty The requested quantity from the CTP screen. 

On Hand The on hand inventory for the item. This data is only as good as the last time Update 
Schedule was run. 

Non Cmt The amount of non committed inventory for the item. 

Mfg Qty The quantity entered on the CTP screen less the on hand amount. 

Prod Hrs The number of hours it will take to manufacture the item. 

Setup The setup time for the Mfg # (from the BOM). 

Move Time The move time in days for the item (from Inventory on the Manufacturing tab). 
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Capable to 

Promise Date 

The capable to promise date is calculated by the system. The system first looks for non-
committed materials for the lowest level BOM required to make the item, including the 
components of a blend, and then works up. (The system will not use Non-Allocate inventory 
when calculating available inventory). Secondly, the system checks for Machine capacity for 
all of the BOM’s required. Again it starts at the lowest level and cascades up. Third, the 
system checks for labor capacity if it is set up. Labor constraint calculations are based on 
MFG type and cell.  The system also looks at the PM service out/in dates when calculating 
CTP dates. If the service back In date is after when production can have the job ran, the CTP 
date will reflect the service back in date. By right clicking on the main item and selecting 
Expand the user can view if the PM service date is in the calculation for CTP date. 

Once all of these areas are checked the system calculates a Capable to Promise Date - the 
earliest date you can have the number of requested items ready to be shipped. 

Notes: CTP uses the Machine Capacity Planning tables - not the finite schedule to determine 
work center availability. Holidays off in Shop Calendar will affect the CTP date. If the job 
under investigation cannot be run within the requested time frame because no capacity 
exists, then it looks for the first available open time, using that date. The system looks at 
machine capacity information as a running total by day and not each day individually.  The 
CTP date is based on the first day that the running total for available machine hours is larger 
than the running total of required hours. This functionality also applies without a 
manufacturing cell being used, as the system calculates machine capacity using a 
combination of manufacturing and work center types only.  

In regards to material availability, by default, the system will only look at the On Hand 
quantity listed in Inventory (custom UOMs are considered in the evaluation). If the 'Use ATP 
calculation for Raw Materials' option is checked it will take into account lead days of 
materials to see if material can be available. So, if you have no material on hand, but also no 
lead days for the acquisition of the material, then it will assume you can get the material the 
same day you need it, thus, not throwing an exception as a bottleneck. With a lead days, the 
system will evaluate whether or not you can potentially receive the material prior to the 
required manufacturing date, thus still being able to “promise” the parts. The system 
compares the daily running balance within the scope of the material’s lead time. Material is 
available without constraint only if the CTP Requested quantity would not bring the balance 
of material required below zero at any point within the lead days period, otherwise the CTP 
Date is calculated for the full number of lead time days. 

If Receiving Holidays have been created they will be used in CTP for calculating the raw 
material lead time. Holidays will postpone the CTP date to ensure the material will be 
available (erring on the side of safety time). Shipping Days are used to determine the next 
valid shipping day after production is complete. Access Shipping/Receiving Holidays from the 
File menu of the Ship Via form or from the Lists menu in System Parameters to set up 
Shipping/Receiving Holidays. 

The CTP is only as accurate as the last time Update Schedule was run. It is during this process 
that various tables used in the CTP function are updated. 

For non-manufactured items that are purchased and sold to a customer, the system will 
consider the On Hand quantity and Lead Time to determine the CTP date.  

When calculating the Capable to Promise (CTP) date on an item that is set on an ICT eKanban 
EPlant Trigger for an item moving from one EPlant to another, the calculation is CTP of the 
source EPlant item + Transit Lead Time on the trigger + Lead Days on the inventory item in 
the target EPlant.  When moving from or to a Division/Warehouse within the same EPlant, 
the formula is Lead Days on the inventory item + Transit Lead Time on the trigger. 

When calculating the CTP for an ASSY1 sales configuration template item the system will 
include the process move time hours assigned to the processes on the ASSY1 BOM. Note: 
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Move time hours does not look at the shop calendar.  Move time hours continues even after 
the shifts end.   

CTP Example For example:  Shop Calendar has 1 shift, 8 hrs/day, 5 days/wk, starting at 7:00:00AM.  The 
ASSY1 BOM has 2 processes.  Process 1 has 1hr cycle time, 1 move qty, 7 move time hrs.  
Process 2 has 1hr cycle time. There is no labor/material/machine constraint. 

When running CTP at 5/18/11 10:00:00AM for requested qty = 1 and requested date = 
5/20/11, CTP date = 5/19/2011 8:00:00 AM.   

5/18/11 10:00:00AM – 11:00:00AM to finish process 1 

5/18/11 11:00:00:AM – 6:00:00PM for the move time (move time still continues even 
though shift ends at 3:00:00PM) 

5/19/2011 7:00:00AM – 8:00:00AM to finish process 2 

Constraints Shows machine capacity constraint date - the earliest date the work center can have the 
requested number of items completed. 

Also shows potential tooling constraints with the description of the conflicting equipment 
number. 

Blocking Sub 
Constraint 

The next lower level item with a constraint against it. Shows the reason the capable to 
promise date cannot be met, such as packaging or other raw materials. The date is when you 
can have the materials in house. 

Expanded View for Raw Material 

Below is the field listing for the expanded view on a material box: 

Item #/Desc The item number and description of the part. 
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Per Item The quantity required per item. 

Required The quantity required based on the Requested Qty. 

On Hand The on hand inventory for the item. This data is only as good as the last time Update 
Schedule was run. 

Non Cmt The amount of non committed inventory for the item. 

Lead Tm The lead time for the item. 

Qty Short The quantity short (Required – Non Cmt). 

Print Visual Routing 

Select the printer speed button on the visual routing form to print a hard copy. (For more information on 
the Printer Speed button see Speed Buttons). 

New Sales Order 

From the Capable To Promise screen you can create a new sales order. Click on New Order and choose 
the customer. An order for the quantity entered in the CTP screen will be added to a new sales order 
with the capable to promise date entered as the promise date. 
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Sales Analysis via Pivot Table 

The Sales Analysis via Pivot Table option allows the user to create a pivot table (data summarization) in 
Excel of sales orders for a specific date range. The pivot table brings in sales order information into a 
Data worksheet and allows the user to display the data however preferred on the Analysis worksheet. 

Note: This option will only be available if Microsoft™ Excel is installed on the computer. 

To access this option select the Sales Analysis via Pivot Table button on the Sales/Distribution tab 
on the launcher bar. The following form will appear: 
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Enter the desired date range in the From and To fields using the drop down calendars. The From and To 
dates will default to the system date. This date corresponds to the Promise Date in the release section of 
sales orders. The information that will populate the pivot table is for any item with a Promise Date that 
falls within this range. For example, if the range is set to 03/04/12, only items with a Promise date equal 
to 03/04/12 will be on the pivot table. 

Temporary Working Area - This allows the user to select the File Name and location for the temporary file. 
This will default to the C Drive with a name of Temp.txt. If this column is changed it is remembered in the 
registry. 

Sales Analysis Query 

Default Query 

The Default Query is the Include history sales orders check box. This allows the user to include archived 
sales orders. If the box is checked the system will populate the pivot table with any items that have a 
promise date within the range that are archived. If it is not checked then only items from non-archived 
sales orders will be on the pivot table. This includes shipped orders as long as they are not archived. 

User Defined Query 

Select this option to specify a user defined query. To create a new query click on the ellipsis button in 
this field and select 'Edit User Defined Query'. Enter the Name and Description of the query in the User 
Defined Query form. 
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In the SQL section click on the Edit SQL Block button  and enter the user defined query in the Query 
Editor. Once entered select the checkbox button to validate the syntax. If it is invalid an error will appear. 
If the syntax is valid a message will appear stating, "Finished validating SQL block - no errors reported". 
Select OK to save the query. 

The default query can be loaded by selecting the Load default button . Select the Edit SQL Block 
button to make changes.  

Once user defined queries have been created click the ellipsis button in the User Defined Query field and 
choose 'Select User Defined Query' to bring up the pick list of the created queries. Select the query to 
use from the pick list. 

Example query used as the Default: 

select o.orderno, 

       o.date_taken as ord_date_taken, 

       a.itemno, 

       a.descrip, 

       a.descrip2, 

       r.quan as rel_quan, 

       r.request_date as rel_request_date, 

       r.promise_date as rel_promise_date, 

       d.unit_price, 

       c.custno, 

       c.company, 

       NVL(r.quan,0) * NVL(d.unit_price,0) * Multicurrency.IQ_GetFXRateDate( o.currency_id, o.date_taken 
) as extended_price, 

       Multicurrency.IQ_GetFXRateDate( o.currency_id, o.date_taken ) as fx_rate, 

       o.eplant_id, 

       'CURRENT' as order_type, 

       d.unit, 

       a.class, 

       c.territory, 

       c.industry, 

       p.code as prod_code, 

       IQCalendar.WeekOf( r.promise_date ) as week, 

       currency.curr_code, 

       ltrim(rtrim(first_name) || ' ' || last_name)  as salesperson, 

       r.forecast, 
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       r.ship_date, 

       (select min(period) from glperiods where  r.promise_date between start_date and end_date and 
GL.CheckGLYearEplant(id) = 1) as period 

from  

      orders o, 

      ord_detail d, 

      arinvt a, 

      releases r, 

      arcusto c, 

      prod_code p, 

      currency, 

      salespeople s, 

      ORD_DETAIL_COMMISSIONS e 

where o.id = d.orders_id 

  and d.arinvt_id = a.id 

  and r.ord_detail_id = d.id 

  and o.arcusto_id = c.id 

  and a.prod_code_id = p.id(+) 

  and c.currency_id = currency.id(+) 

  and e.salespeople_id = s.id(+) 

  and e.ord_detail_id(+) = d.id 

  and r.promise_date between :date1 and :date2 

order by r.promise_date 

Create the Pivot table 

Once the selections have been made, click the OK button. Excel will open with the information populated 
on the Data sheet and a simple analysis of the data on the Analysis sheet.  

Note: Semi-colons should not be used in any of the fields that are exported using this tool.  

Below is an example: 
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The screen shot above is a sample of the Data sheet. This sheet includes the following data: Order 
Number, Order Date Taken, Item #, Description, Extended Description, Release Quantity, Request Date, 
Promise Date, Unit Price, Customer #, Customer name, extended price, order type (current or archived), 
EPlant ID, FX Rate, Unit, Class, Territory, Industry, Product Code, Week number of year, Currency Code, 
Salesperson, Forecast, Ship Date, and Period. 

 

The screen shot above is an example of the default Analysis sheet. It basically displays a row for each 
customer with a total of the orders for that customer, and a grand total for the table. The user can drag 
other items from the Pivot Table Field List to be included in the analysis.  
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